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PC - PERSONAL COMPUTER 

 

A personal computer (PC) is a small, relatively inexpensive 

computer designed for an individual user. In price  personal 

computers range anywhere from a few hundred dollars to 

thousands of dollars. All are based on the microprocessor 

technology that enables manufacturers to put an entire CPU on 

one chip. 

At home, the most popular use for personal computers is for 

playing games. Businesses use personal computers for word 

processing, accounting, desktop publishing, and for running 

spreadsheet and database management applications. 

 

Component of computer :-- 

Case 

 

The computer case is a plastic or metal enclosure that houses most 

of the components. Those found on desktop computers are usually 

small enough to fit under a desk, however in recent years more 

compact designs have become more common place, such as the 

all-in-one style designs from Apple, namely the iMac. Laptops are 

computers that usually come in a clamshell form factor, again 
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however in more recent years deviations from this form factor have 

started to emerge such as laptops that have a detachable screen that 

become tablet computers in their own right. 

Power supply 

A power supply unit (PSU) converts alternating current (AC) 

electric power to low-voltage DC power for the internal 

components of the computer. Laptops are capable of running from 

a built-in battery, normally for a period of hours.[6] 

Motherboard 

The motherboard is the main component of computer. It is a large 

rectangular board with integrated circuitry that connects the other 

parts of the computer including the CPU, the RAM, the disk 

drives(CD, DVD, hard disk, or any others) as well as any 

peripherals connected via the ports or the expansion slots. 

Components directly attached to or part of the motherboard 

include: 

• The CPU (Central Processing Unit) performs most of the 

calculations which enable a computer to function, and is 

sometimes referred to as the "brain" of the computer. It is 

usually cooled by a heat sink and fan. Most newer CPUs 

include an on-die Graphics Processing Unit (GPU). 

• The Chipset, which includes the north bridge, mediates 

communication between the CPU and the other components of 

the system, including main memory. 

• The Random-Access Memory (RAM) stores the code and data 

that are being actively accessed by the CPU. 

• The Read-Only Memory (ROM) stores the BIOS that runs 

when the computer is powered on or otherwise begins 

execution, a process known as Bootstrapping, or "booting" or 

"booting up". The BIOS (Basic Input Output System) includes 

boot firmware and power management firmware. Newer 
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motherboards use Unified Extensible Firmware 

Interface (UEFI) instead of BIOS. 

• Buses connect the CPU to various internal components and to 

expansion cards for graphics and sound. 

• The CMOS battery is also attached to the motherboard. This 

battery is the same as a watch battery or a battery for a remote 

to a car's central locking system. Most batteries are CR2032, 

which powers the memory for date and time in the BIOS chip. 

Expansion cards 

The [expansion card] in computing is a printed circuit board that 

can be inserted into an expansion slot of a computer motherboard 

or backplane to add functionality to a computer system via the 

expansion bus. 

Storage devices 

 

Computer data storage, often called storage or memory, refers to 

computer components and recording media that retain digital data. 

Data storage is a core function and fundamental component of 

computers. 

Fixed media 

Data is stored by a computer using a variety of media. Hard disk 

drives are found in virtually all older computers, due to their high 

capacity and low cost, but solid-state drives are faster and more 

power efficient, although currently more expensive than hard 

drives, so are often found in more expensive computers. Some 

systems may use a disk array controller for greater performance or 

reliability. 

Removable media 

To transfer data between computers, a USB flash drive or Optical 

disc may be used. Their usefulness depends on being readable by 

other systems; the majority of machines have an optical disk drive, 

and virtually all have a USB port. 
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Input and output peripherals 

Input and output devices are typically housed externally to the 

main computer chassis. The following are either standard or very 

common to many computer systems. 

Input 

Input devices allow the user to enter information into the system, 

or control its operation. Most personal computers have 

amouse and keyboard, but laptop systems typically use 

a touchpad instead of a mouse. Other input devices 

includewebcams, microphones, joysticks, and image scanners. 

Output device 

Output devices display information in a human readable form. 

Such devices could include printers, speakers, monitors or aBraille 

embosser. 

 

 

Parts of computer :-- 
 

1. hardware 

2. software 

 

 

hardware: 
 

'Computer hardware' is the collection of physical elements that 

constitutes acomputer system. Computer hardware refers to the 

physical parts or components of a computer such as 

the monitor, mouse, keyboard, computer data storage, hard 

drive disk (HDD), system unit (graphic cards, sound cards, 

memory, motherboard and chips), etc. all of which are physical 

objects that can be touched (known as tangible) 

http://en.wikipedia.org/wiki/Input_device
http://en.wikipedia.org/wiki/Output_device
http://en.wikipedia.org/wiki/Input_devices
http://en.wikipedia.org/wiki/Mouse_(computing)
http://en.wikipedia.org/wiki/Keyboard_(computing)
http://en.wikipedia.org/wiki/Touchpad
http://en.wikipedia.org/wiki/Webcam
http://en.wikipedia.org/wiki/Microphone
http://en.wikipedia.org/wiki/Joystick
http://en.wikipedia.org/wiki/Image_scanner
http://en.wikipedia.org/wiki/Output_device
http://en.wikipedia.org/wiki/Printer_(computing)
http://en.wikipedia.org/wiki/Computer_speaker
http://en.wikipedia.org/wiki/Computer_monitor
http://en.wikipedia.org/wiki/Braille_embosser
http://en.wikipedia.org/wiki/Braille_embosser
http://en.wikipedia.org/wiki/Computer
http://en.wikipedia.org/wiki/Computer_monitor
http://en.wikipedia.org/wiki/Mouse_(computing)
http://en.wikipedia.org/wiki/Computer_keyboard
http://en.wikipedia.org/wiki/Computer_data_storage
http://en.wikipedia.org/wiki/Hard_drive
http://en.wikipedia.org/wiki/Hard_drive


 

There are different types of hardware: 

1. input device 

2. output device 

3. storage device(memory) 

 

input device:  

An input device for a computer allows you to enter information. 

Any machine that feeds data into a computer 

 

Following are few of the important input devices which are used 

in a computer: 

• Keyboard 

• Mouse 

• Joy Stick 

• Light pen 

• Track Ball 

• Scanner 

• Graphic Tablet 

• Microphone 

• Magnetic Ink Card Reader(MICR) 

• Optical Character Reader(OCR) 

• Bar Code Reader 

• Optical Mark Reader(OMR) 

Keyboard 

Keyboard is the most common and very popular input device 

which helps in inputting data to the computer. The layout of the 

keyboard is like that of traditional typewriter, although there are 

some additional keys provided for performing additional 

functions. 
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Keyboards are of two sizes 84 keys or 101/102 keys, but now 

keyboards with 104 keys or 108 keys are also available for 

Windows and Internet. 

The keys on the keyboard are as follows: 

Sr.No Keys Description 

1 Typing Keys These keys include the 

letter keys (A-Z) and 

digit keys (0-9) which 

generally give same 

layout as that of 

typewriters. 

2 Numeric Keypad It is used to enter 

numeric data or cursor 

movement. Generally, it 

consists of a set of 17 

keys that are laid out in 

the same configuration 

used by most adding 

machines and 

calculators. 

3 Function Keys The twelve function 

keys are present on the 

keyboard which are 

arranged in a row at the 

top of the keyboard. 

Each function key has 

unique meaning and is 

used for some specific 



purpose. 

4 Control keys These keys provide 

cursor and screen 

control. It includes four 

directional arrow keys. 

Control keys also 

include Home, End, 

Insert, Delete, Page Up, 

Page Down, 

Control(Ctrl), 

Alternate(Alt), 

Escape(Esc). 

5 Special Purpose Keys Keyboard also contains 

some special purpose 

keys such as Enter, 

Shift, Caps Lock, Num 

Lock, Space bar, Tab, 

and Print Screen. 

 



Mouse 

Mouse is most popular pointing device. It is a very famous cursor-

control device having a small palm size box with a round ball at 

its base which senses the movement of mouse and sends 

corresponding signals to CPU when the mouse buttons are 

pressed. 

Generally it has two buttons called left and right button and a 

wheel is present between the buttons. Mouse can be used to 

control the position of cursor on screen, but it cannot be used to 

enter text into the computer. 

Advantages 

• Easy to use 

• Not very expensive 

• Moves the cursor faster than the arrow keys of keyboard. 

 
Joystick 

Joystick is also a pointing device which is used to move cursor 

position on a monitor screen. It is a stick having a spherical ball at 

its both lower and upper ends. The lower spherical ball moves in a 

socket. The joystick can be moved in all four directions. 

The function of joystick is similar to that of a mouse. It is mainly 

used in Computer Aided Designing(CAD) and playing computer 

games. 



 
Light Pen 

Light pen is a pointing device which is similar to a pen. It is used 

to select a displayed menu item or draw pictures on the monitor 

screen. It consists of a photocell and an optical system placed in a 

small tube. When the tip of a light pen is moved over the monitor 

screen and pen button is pressed, its photocell sensing element 

detects the screen location and sends the corresponding signal to 

the CPU. 

 
Track Ball 

Track ball is an input device that is mostly used in notebook or 

laptop computer, instead of a mouse. This is a ball which is half 

inserted and by moving fingers on ball, pointer can be moved. 

Since the whole device is not moved, a track ball requires less 

space than a mouse. A track ball comes in various shapes like a 

ball, a button and a square. 



 
Scanner 

Scanner is an input device which works more like a photocopy 

machine. It is used when some information is available on a paper 

and it is to be transferred to the hard disc of the computer for 

further manipulation. Scanner captures images from the source 

which are then converted into the digital form that can be stored 

on the disc. These images can be edited before they are printed. 

 
Digitizer 

Digitizer is an input device which converts analog information 

into digital form. Digitizer can convert a signal from the television 



or camera into a series of numbers that could be stored in a 

computer. They can be used by the computer to create a picture of 

whatever the camera had been pointed at. Digitizer is also known 

as Tablet or Graphics Tablet because it converts graphics and 

pictorial data into binary inputs. A graphic tablet as digitizer is 

used for doing fine works of drawing and image manipulation 

applications. 

 
Microphone 

Microphone is an input device to input sound that is then stored in 

digital form. The microphone is used for various applications like 

adding sound to a multimedia presentation or for mixing music. 

 



Magnetic Ink Card Reader(MICR) 

MICR input device is generally used in banks because of a large 

number of cheques to be processed every day. The bank's code 

number and cheque number are printed on the cheques with a 

special type of ink that contains particles of magnetic material that 

are machine readable. This reading process is called Magnetic Ink 

Character Recognition (MICR). The main advantages of MICR is 

that it is fast and less error prone. 

 
Optical Character Reader(OCR) 

OCR is an input device used to read a printed text. OCR scans text 

optically character by character, converts them into a machine 

readable code and stores the text on the system memory. 



 
Bar Code Readers 

Bar Code Reader is a device used for reading bar coded data (data 

in form of light and dark lines). Bar coded data is generally used 

in labelling goods, numbering the books etc. It may be a hand held 

scanner or may be embedded in a stationary scanner. Bar Code 

Reader scans a bar code image, converts it into an alphanumeric 

value which is then fed to the computer to which bar code reader 

is connected. 

 

Optical Mark Reader(OMR) 

OMR is a special type of optical scanner used to recognize the 

type of mark made by pen or pencil. It is used where one out of a 

few alternatives is to be selected and marked. It is specially used 

for checking the answer sheets of examinations having multiple 

choice questions. 



 
 

 

Output device:-- 

 

 

 

An output device is any piece of computer hardware equipment 

used to communicate the results of data processingcarried out by 

an information processing system (such as a computer) which 

converts the electronically generated information into human-

readable form. 

 

Following are few of the important output devices which are used 

in a computer. 

• Monitors 

• Graphic Plotter 

• Printer 

• Projector 

• Speaker 

 

 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the 

main output device of a computer. It forms images from tiny dots, 
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called pixels that are arranged in a rectangular form. The 

sharpness of the image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

• Cathode-Ray Tube (CRT) 

• Flat- Panel Display 

Cathode-Ray Tube (CRT) Monitor 

The CRT display is made up of small picture elements called 

pixels. The smaller the pixels, the better the image clarity, or 

resolution. It takes more than one illuminated pixel to form whole 

character, such as the letter ‘e’ in the word help. 

A finite number of characters can be displayed on a screen at 

once. The screen can be divided into a series of character boxes - 

fixed location on the screen where a standard character can be 

placed. Most screens are capable of displaying 80 characters of 

data horizontally and 25 lines vertically. There are some 

disadvantages of CRT: 

• Large in Size 

• High power consumption 

 



Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have 

reduced volume, weight and power requirement in comparison to 

the CRT. You can hang them on walls or wear them on your 

wrists. Current uses of flat-panel displays include calculators, 

video games, monitors, laptop computer, graphics display. 

The flat-panel display is divided into two categories: 

• Emissive Displays - The emissive displays are devices that 

convert electrical energy into light. Example are plasma 

panel and LED(Light-Emitting Diodes). 

• Non-Emissive Displays - The Non-emissive displays use 

optical effects to convert sunlight or light from some other 

source into graphics patterns. Example is LCD(Liquid-

Crystal Device) 

 



Printers 

Printer is an output device, which is used to print information on 

paper. 

There are two types of printers: 

• Impact Printers 

• Non-Impact Printers 

Impact Printers 

The impact printers print the characters by striking them on the 

ribbon which is then pressed on the paper. 

Characteristics of Impact Printers are the following: 

• Very low consumable costs 

• Very noisy 

• Useful for bulk printing due to low cost 

• There is physical contact with the paper to produce an image 

These printers are of two types 

• Character printers 

• Line printers 

Character Printers 

Character printers are the printers which print one character at a 

time. 

These are further divided into two types: 

• Dot Matrix Printer(DMP) 

• Daisy Wheel 

DOT MATRIX PRINTER 

In the market one of the most popular printers is Dot Matrix 

Printer. These printers are popular because of their ease of 

printing and economical price. Each character printed is in form of 



pattern of dots and head consists of a Matrix of Pins of size (5*7, 

7*9, 9*7 or 9*9) which come out to form a character that is why it 

is called Dot Matrix Printer. 

Advantages 

• Inexpensive 

• Widely Used 

• Other language characters can be printed 

Disadvantages 

• Slow Speed 

• Poor Quality 

 
DAISY WHEEL 

Head is lying on a wheel and pins corresponding to characters are 

like petals of Daisy (flower name) that is why it is called Daisy 

Wheel Printer. These printers are generally used for word-

processing in offices which require a few letters to be sent here 

and there with very nice quality. 

Advantages 

• More reliable than DMP 



Better quality 

• The fonts of character can be easily changed 

Disadvantages 

• Slower than DMP 

• Noisy 

• More expensive than DMP 

 
Line Printers 

Line printers are the printers which print one line at a time. 

 
These are of further two types 

• Drum Printer 

• Chain Printer 



DRUM PRINTER 

This printer is like a drum in shape so it is called drum printer. 

The surface of drum is divided into number of tracks. Total tracks 

are equal to size of paper i.e. for a paper width of 132 characters, 

drum will have 132 tracks. A character set is embossed on track. 

The different character sets available in the market are 48 

character set, 64 and 96 characters set. One rotation of drum prints 

one line. Drum printers are fast in speed and can print 300 to 2000 

lines per minute. 

Advantages 

• Very high speed 

Disadvantages 

• Very expensive 

• Characters fonts cannot be changed 

CHAIN PRINTER 

In this printer, chain of character sets are used so it is called Chain 

Printer. A standard character set may have 48, 64, or 96 

characters. 

Advantages 

• Character fonts can easily be changed. 

• Different languages can be used with the same printer. 

Disadvantages 

• Noisy 

Non-impact Printers 

Non-impact printers print the characters without using ribbon. 

These printers print a complete page at a time so they are also 

called as Page Printers. 

These printers are of two types 



• Laser Printers 

• Inkjet Printers 

Characteristics of Non-impact Printers 

• Faster than impact printers. 

• They are not noisy. 

• High quality. 

• Support many fonts and different character size. 

Laser Printers 

These are non-impact page printers. They use laser lights to 

produce the dots needed to form the characters to be printed on a 

page. 

ADVANTAGES 

• Very high speed 

• Very high quality output 

• Give good graphics quality 

• Support many fonts and different character size 

DISADVANTAGES 

• Expensive. 

• Cannot be used to produce multiple copies of a document in 

a single printing. 



 
Inkjet Printers 

Inkjet printers are non-impact character printers based on a 

relatively new technology. They print characters by spraying 

small drops of ink onto paper. Inkjet printers produce high quality 

output with presentable features. 

They make less noise because no hammering is done and these 

have many styles of printing modes available. Colour printing is 

also possible. Some models of Inkjet printers can produce 

multiple copies of printing also. 

ADVANTAGES 

• High quality printing 

• More reliable 

DISADVANTAGES 

• Expensive as cost per page is high 

• Slow as compared to laser printer 



 
 

 

 

 

Plotter : 

 

A plotter is a computer printing device for printingvector graphics. 

In the past, plotters were widely used in applications such 

as computer-aided design, though they have generally been 

replaced with wide-format conventional printers, and it is now 

commonplace to refer to such wide-format printers as "plotters," 

even though they technically aren't. 

 

 

 

 

 

 

 

Storage device (memory) :-- 

A memory is just like a human brain. It is used to store data and 

instructions. Computer memory is the storage space in computer 
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where data is to be processed and instructions required for 

processing are stored. The memory is divided into large number of 

small parts called cells. Each location or cell has a unique address 

which varies from zero to memory size minus one. For example if 

computer has 64k words, then this memory unit has 64 * 

1024=65536 memory locations. The address of these locations 

varies from 0 to 65535. 

Memory is primarily of three types 

• Cache Memory 

• Primary Memory/Main Memory 

• Secondary Memory 

 

 

Cache Memory 

Cache memory is a very high speed semiconductor memory which 

can speed up CPU. It acts as a buffer between the CPU and main 

memory. It is used to hold those parts of data and program which 

are most frequently used by CPU. The parts of data and programs 

are transferred from disk to cache memory by operating system, 

from where CPU can access them. 

Advantages 

The advantages of cache memory are as follows: 

• Cache memory is faster than main memory. 

• It consumes less access time as compared to main memory. 

• It stores the program that can be executed within a short 

period of time. 

• It stores data for temporary use. 



Disadvantages 

The disadvantages of cache memory are as follows: 

• Cache memory has limited capacity. 

• It is very expensive. 

 

Primary Memory (Main Memory) 

 

Primary memory holds only those data and instructions on which 

computer is currently working. It has limited capacity and data is 

lost when power is switched off. It is generally made up of 

semiconductor device. These memories are not as fast as registers. 

The data and instruction required to be processed reside in main 

memory. It is divided into two subcategories RAM and ROM. 

RAM(Random Access Memory) is the internal memory of the 

CPU for storing data, program and program result. It is read/write 

memory which stores data until the machine is working. As soon 

as the machine is switched off, data is erased. 

Access time in RAM is independent of the address that is, each 

storage location inside the memory is as easy to reach as other 

locations and takes the same amount of time. Data in the RAM 

can be accessed randomly but it is very expensive. 

RAM is volatile, i.e. data stored in it is lost when we switch off 

the computer or if there is a power failure. Hence a backup 

uninterruptible power system(UPS) is often used with computers. 

RAM is small, both in terms of its physical size and in the amount 

of data it can hold. 

RAM is of two types 

• Static RAM (SRAM) 

• Dynamic RAM (DRAM) 



 
Static RAM (SRAM) 

The word static indicates that the memory retains its contents as 

long as power is being supplied. However, data is lost when the 

power gets down due to volatile nature. SRAM chips use a matrix 

of 6-transistors and no capacitors. Transistors do not require 

power to prevent leakage, so SRAM need not have to be refreshed 

on a regular basis. 

Because of the extra space in the matrix, SRAM uses more chips 

than DRAM for the same amount of storage space, thus making 

the manufacturing costs higher. So SRAM is used as cache 

memory and has very fast access. 

Characteristic of the Static RAM 

• It has long life 

• There is no need to refresh 

• Faster 

• Used as cache memory 

• Large size 

• Expensive 

• High power consumption 



Dynamic RAM (DRAM) 

DRAM, unlike SRAM, must be continually refreshed in order to 

maintain the data. This is done by placing the memory on a 

refresh circuit that rewrites the data several hundred times per 

second. DRAM is used for most system memory because it is 

cheap and small. All DRAMs are made up of memory cells which 

are composed of one capacitor and one transistor. 

Characteristics of the Dynamic RAM 

• It has short data lifetime 

• Need to be refreshed continuously 

• Slower as compared to SRAM 

• Used as RAM 

• Lesser in size 

• Less expensive 

• Less power consumption 

 

ROM stands for Read Only Memory. The memory from which we 

can only read but cannot write on it. This type of memory is non-

volatile. The information is stored permanently in such memories 

during manufacture. A ROM, stores such instructions that are 

required to start a computer. This operation is referred to as 

bootstrap. ROM chips are not only used in the computer but also 

in other electronic items like washing machine and microwave 

oven. 



 

 

PROM (Programmable Read only Memory) 

PROM is read-only memory that can be modified only once by a 

user. The user buys a blank PROM and enters the desired contents 

using a PROM program. Inside the PROM chip there are small 

fuses which are burnt open during programming. It can be 

programmed only once and is not erasable. 

EPROM(Erasable and Programmable Read Only Memory) 

The EPROM can be erased by exposing it to ultra-violet light for 

a duration of up to 40 minutes. Usually, an EPROM eraser 

achieves this function. During programming, an electrical charge 

is trapped in an insulated gate region. The charge is retained for 

more than ten years because the charge has no leakage path. For 

erasing this charge, ultra-violet light is passed through a quartz 

crystal window(lid). This exposure to ultra-violet light dissipates 

the charge. During normal use the quartz lid is sealed with a 

sticker. 

EEPROM(Electrically Erasable and Programmable Read Only Memory) 

The EEPROM is programmed and erased electrically. It can be 

erased and reprogrammed about ten thousand times. Both erasing 



and programming take about 4 to 10 ms (milli second). In 

EEPROM, any location can be selectively erased and 

programmed. EEPROMs can be erased one byte at a time, rather 

than erasing the entire chip. Hence, the process of re-

programming is flexible but slow. 

Advantages of ROM 

The advantages of ROM are as follows: 

• Non-volatile in nature 

• These cannot be accidentally changed 

• Cheaper than RAMs 

• Easy to test 

• More reliable than RAMs 

• These are static and do not require refreshing 

• Its contents are always known and can be verified 

 

 

Secondary Memory 

This type of memory is also known as external memory or non-

volatile. It is slower than main memory. These are used for storing 

data/Information permanently. CPU directly does not access these 

memories instead they are accessed via input-output routines. 

Contents of secondary memories are first transferred to main 

memory, and then CPU can access it. For example : disk, CD-

ROM, DVD etc. 

 

Characteristic of Secondary Memory 

• These are magnetic and optical memories 

• It is known as backup memory. 



• It is non-volatile memory. 

• Data is permanently stored even if power is switched off. 

• It is used for storage of data in a computer. 

• Computer may run without secondary memory. 

• Slower than primary memories. 

•  

 

 

 

Relationship between Hardware and Software 

• Hardware and software are mutually dependent on each 

other. Both of them must work together 

to make a computer produce a useful output. 

• Software cannot be utilized without supporting hardware. 

• Hardware without set of programs to operate upon cannot be 

utilized and is useless. 

• To get a particular job done on the computer, relevant 

software should be loaded into the hardware 

• Hardware is a one-time expense. 

• Software development is very expensive and is a continuing 

expense. 

• Different software applications can be loaded on a hardware 

to run different jobs. 

• A software acts as an interface between the user and the 

hardware. 

• If hardware is the 'heart' of a computer system, then software 

is its 'soul'. Both are complimentary to each other. 



 

 

 

 

 

 

 

Software : 

 

Software is a set of programs, which is designed to perform a 

well-defined function. A program is a sequence of instructions 

written to solve a particular problem. 

There are two types of software 

• System Software 

• Application Software 

System Software 

The system software is collection of programs designed to 

operate, control, and extend the processing capabilities of the 

computer itself. System software are generally prepared by 

computer manufactures. These software products comprise of 

programs written in low-level languages which interact with the 

hardware at a very basic level. System software serves as the 

interface between hardware and the end users. 

Some examples of system software are Operating System, 

translator, utility software 

 

 



Operating system :-- 

An operating system (OS) is software that manages computer 

hardware andsoftware resources and provides 

common services for computer programs. The operating 

system is an essential component of the system software in a 

computer system. Application programs usually require an 

operating system to function. 

Utility software :-- 

Utility software is system software designed to help analyze, 

configure, optimize or maintain a computer 

Example : antivirus software, device driver, backup tools, 

diskcleanup tool, disk defragmentation tools etc. 

 

Application Software 

Application software products are designed to satisfy a particular 

need of a particular environment. All software applications 

prepared in the computer lab can come under the category of 

Application software. 

Application software may consist of a single program, such as a 

Microsoft's notepad for writing and editing simple text. It may 

also consist of a collection of programs, often called a software 

package, which work together to accomplish a task, such as a 

spreadsheet package. 

Examples of Application software are following: 

• Payroll Software 

• Student Record Software 

• Inventory Management Software 

• Income Tax Software 

http://en.wikipedia.org/wiki/Computer_hardware
http://en.wikipedia.org/wiki/Computer_hardware
http://en.wikipedia.org/wiki/Computer_software
http://en.wikipedia.org/wiki/Operating_system_services
http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/System_software
http://en.wikipedia.org/wiki/System_software


• Railways Reservation Software 

• Microsoft Office Suite Software 

• Microsoft Word 

• Microsoft Excel 

• Microsoft Powerpoint 

 
Features of application software are as follows: 

• Close to user 

• Easy to design 

• More interactive 

• Slow in speed 

• Generally written in high-level language 

• Easy to understand 

• Easy to manipulate and use 

 

 

 

What is firmware : 
 

Software (programs or data) that has been written onto read-only 

memory (ROM). Firmware is a combination of software 

andhardware. ROMs, PROMs and EPROMs that have data or 

programs recorded on them are firmware. 

 

Firmware is a software program permanently etched into a 

hardware device such as a keyboards, hard drive, BIOS, or video 

cards. It is programmed to give permanent instructions to 

http://www.webopedia.com/TERM/S/software.html
http://www.webopedia.com/TERM/P/program.html
http://www.webopedia.com/TERM/D/data.html
http://www.webopedia.com/TERM/R/ROM.html
http://www.webopedia.com/TERM/R/ROM.html
http://www.webopedia.com/TERM/H/hardware.html


communicate with other devices and perform functions like basic 

input/output tasks. Firmware is typically stored in the flash ROM 

(read only memory) of a hardware device. It can be erased and 

rewritten. 

 

Firmware was originally designed for high level software and 

could be changed without having to exchange the hardware for a 

newer device. Firmware also retains the basic instructions for 

hardware devices that make them operative. Without firmware, a 

hardware device would be non-functional. 

 

 

 

 

  

 

 

1.4 : Program Versus Software— 
 

many people equate the term software with computer program. 

Program are developed by individuals for their personal use. They 

are generally , small in size and have limited functionality. Also 

since the author of a program himself uses and maintains his 

programs, these usually do not have good user interface and  

lack of proper documentation . 

 

where as , software product have multiple users and therefore 

should have good user interface , proper operating procedure  and 

good documentation support 

since a software product has a large number of users , it must be 

properly designed , carefully implemented and properly tested. 
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Unit: 2 

BASIC OPERATING SYSTEM CONCEPT: 

 

An operating system is a collection of program used to control a 

computer system. 

An operating System (OS) is an intermediary between users and 

computer hardware. It provides users an environment in which a 

user can execute programs conveniently and efficiently. 

In technical terms, It is software which manages hardware. An 

operating System controls the allocation of resources and services 

such as memory, processors, devices and information. 

Definition 

An operating system is a program that acts as an interface between 

the user and the computer hardware and controls the execution of 

all kinds of programs. 

 



Following are some of important functions of an operating System. 

• Memory Management 

• Processor Management 

• Device Management 

• File Management 

• Security 

• Control over system performance 

• Job accounting 

• Coordination between other software and users 

 

Memory Management 

Memory management refers to management of Primary Memory 

or Main Memory. Main memory is a large array of words or bytes 

where each word or byte has its own address. 

Main memory provides a fast storage that can be access directly by 

the CPU. So for a program to be executed, it must in the main 

memory. Operating System does the following activities for 

memory management. 

• Keeps tracks of primary memory i.e. what part of it are in use 

by whom, what part are not in use. 

• In multiprogramming, OS decides which process will get 

memory when and how much. 

• Allocates the memory when the process requests it to do so. 



• De-allocates the memory when the process no longer needs it or 

has been terminated. 

 

Processor Management 

In multiprogramming environment, OS decides which process gets 

the processor when and how much time. This function is called 

process scheduling. Operating System does the following activities 

for processor management. 

• Keeps tracks of processor and status of process. Program 

responsible for this task is known as traffic controller. 

• Allocates the processor (CPU) to a process. 

• De-allocates processor when processor is no longer required. 

 

Device Management 

OS manages device communication via their respective drivers. 

Operating System does the following activities for device 

management. 

• Keeps tracks of all devices. Program responsible for this task is 

known as the I/O controller. 

• Decides which process gets the device when and for how much 

time. 

• Allocates the device in the efficient way. 

• De-allocates devices. 



File Management 

A file system is normally organized into directories for easy 

navigation and usage. These directories may contain files and other 

directions. Operating System does the following activities for file 

management. 

• Keeps track of information, location, uses, status etc. The 

collective facilities are often known as file system. 

• Decides who gets the resources. 

• Allocates the resources. 

• De-allocates the resources. 

 

Other Important Activities 

 

Following are some of the important activities that Operating 

System does. 

• Security -- By means of password and similar other 

techniques, preventing unauthorized access to programs and 

data. 

• Control over system performance -- Recording delays 

between request for a service and response from the system. 

• Job accounting -- Keeping track of time and resources used 

by various jobs and users. 

• Coordination between other software’s and users -- 

Coordination and assignment of compilers, interpreters, 

assemblers and other software to the various users of the 

computer systems. 

 

 



 

 

MS-DOS INTRODUCTION:-- 

MS-DOS (Microsoft-disk operating system) is the operating 

system recommended for PCs.  

The programs in the operating system allow us to communicate 

with the computer and it’s peripheral. Devices and lets us take 

advantage of these resources.  

Once ms-dos has been loaded into the computer memory, It will 

allow us to use application software such as spreadsheet, word 

processor, etc.  

DOS is a single user single task operating system. 

DOS is a type of system software. 

It is CUI based (character user interface) 

For loading the operating system three files must be present. 

• MS-DOS.SYS 

• IO.SYS 

• COMMAND.COM 

THE FIRST TWO FILES ARE NORMALLY HIDDEN.  THE 

THIRD FILE IS NOT HIDDEN. 

 

DOS IS A CUI BASED OS— 

 

• Every task in dos perform by a specific command with 

proper syntax means proper syntax required to remember to 

execute any command for any job. 

• CUI are based on text. 

• anything where you are allowed to work only with keyboard. 



• A command-line interface (CLI), also known as command-

line user interface, console user interface, and character user 

interface (CUI), is a means of interacting with a computer 

program where the user (or client) issues commands to the 

program in the form of successive lines of text (command 

lines). 

 

CONCEPT OF FILES AND DIRECTORIES: 

What are files? 

 

File is a collection of related information. 

All the data and information is stored in the computer as files. 

Every file is identified by a name. we can recall a file using its file 

name. 

A file name can be anything but it makes sense to have a 

meaningful filename. 

 

Rules for filenames: 

The filename in dos have to be written according to the rules. 

These rules are: 

1. A filename is made up of 2 parts, primary name and 

extension name. 

2. The name of primary file can be anything between 1 to 8 

characters. 

3. The extension name can be between 1 to 3 characters. 

4. There are some special word and characters which are not 

allowed in a filename. for example : “/  \ [ ]  :  +  < > = ;  ,   |   

“   

http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/Computer_program
http://en.wikipedia.org/wiki/User_(computing)
http://en.wikipedia.org/wiki/Client_(computing)
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5. The primary filename and extension have to be separated by 

a period (.). No spaces are allowed in a filename. 

6. The extension in a filename is optional. 

 

Directories: 

 

In an office, we can organize files that belong to different people 

or we can organize them according to the subjects. For examples, 

we can keep all the files relating to raw material under a file name 

invest or all expenditure files under accounts. Here invest and 

account is directories. 

A directory is nothing but a special file which stores the files of a 

particular category. 

Directories let us group files into convenient category. These 

categories in turn may contain other directory. (Referred as 

subdirectory). 

The main directory from which directories and subdirectories 

branch out called as ROOT directory. 

 

Booting of the system: 

 

1. POST 

2. MBR 

3. IO.SYS 

4. MSDOS.SYS 

5. CONFIG.SYS 

6. COMMAND.COM 

7. AUTOEXEC.BAT 

8. Command prompt 

 



POST 

The very first thing that happens in the boot sequence is the 

POST (Power 

On Self Test). This is run from the BIOS, and allows the computer 

to check for 

memory (you see it clicking through the available memory on your 

screen), check 

for a keyboard, and check for disk drives. If it does not find these 

things, 

it gives an error, sometimes on the screen, but more often by 

emitting a series 

of beeps through the pc built-in speaker. There are different 

varieties of BIOS, 

and each has its own BEEP codes, which are used to diagnose 

problems during 

the boot process. On the screen you may see errors like “keyboard 

failure”, 

“Failure accessing floppy disk”, etc. 

MBR 

Assuming that the keyboard is working, the memory is there, and 

it can find the proper disk drive, the BIOS then looks to the 

appropriate disk 

for further instructions. Whether a floppy or a hard disk drive, the 

very first 

sector of a bootable disk ( the boot sector) contains the Master 

Boot Record (MBR). The Master Boot Record contains 

information on where 

to go next in the boot process. If the Master Boot Record is found, 

the boot 

process goes forward. If it is not found, or is damaged in some 

way, you may 

receive an error that says that the disk is not bootable, or is “not a 

system disk”. 

http://webopedia.internet.com/TERM/p/power_on_self_test.html
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Everything said up to this point is generically true of the boot 

process for all Intel-based PCs, regardless of the operating system. 

From this 

point on, the details will be given for DOS. Some of these steps 

you may find 

are retained in Windows, but that is not our concern here. 

THE DOS BOOT PROCESS 

When DOS was first used by IBM for its personal computers, the 

OS was called PC-DOS, and IBM gave certain names to the files 

that made them 

sound like IBM-specific files. But as soon as clone-makers (e.g. 

Compaq, Dell) 

starting making IBM-compatible clone computers, Microsoft 

released a clone version 

called MS-DOS, and renamed some of those files. Now MS-DOS 

is much more widely 

used than PC-DOS, and MS-DOS names are more common. 

For DOS systems, the MBR will point the computer to two hidden 

start-up files. The first of these files is IO.SYS (or for IBM 

computers, IBMBIO.COM). 

This must be the very first file (physically) on your boot disk or 

your disk 

will not boot. The second file is called MSDOS.SYS (or 

IBMDOS.COM for IBM computers). 

This must be the second file (physically) on the boot disk or it will 

not boot. 

This is why you cannot create a boot disk by simply copying these 

files to blank 

floppy disk. They would be on the disk, but they would not be in 

the proper 

position for the boot process to find them. To create a “system 

disk”, 



you need to use a particular command that tells the computer to 

place these 

files in the precise position needed for booting to occur. 

THE DOS BOOT SEQUENCE 

IO.SYS (or IBMBIO.COM) contains the interface between MS-

DOS and the I/O subsystem. This allows the OS to communicate 

with the basic peripherals and perform input and output tasks. 

MSDOS.SYS (or IBMDOS.COM) is the Kernel of the OS. It 

interacts with the hardware and helps process the various DOS 

functions. Both IO.SYS and MSDOS.SYS are hidden files, which 

mean that ordinarily you would not be aware of them, and they 

would not appear in a directory listing. 

This is to protect the OS from someone mistakenly deleting these 

key files and 

rendering the computer unable to boot. 

The third file to be loaded is CONFIG.SYS. As the name implies, 

this file contains information that helps to configure your system. 

This is where you would install devices and drivers, for instance. 

In DOS it is common to have your mouse, sound card, and CD-

ROM drive installed here, as well as 

certain memory management and other functions. If there is no 

CONFIG.SYS file 

present, a default version contained within MSDOS.SYS is loaded. 

The fourth file to be loaded, which is automatically added to the 

disk when you make a system disk, is COMMAND.COM. This 

file does not need to be in any particular physical location on the 

disk, but does need to be in the root directory. This file is 

a command interpreter, which means that 

it can interpret the commands you issue. Every OS has some type 

of command interpreter, 

http://webopedia.internet.com/TERM/k/kernel.html


though they may use a different name. In Unix (and Linux), for 

instance, the command interpreter is generally called a shell. 

 

COMMAND.COM interprets all of the Internal Commands. 

We’ll discuss these later, but for the moment think of them as the 

most common commands that DOS uses. 

The fifth, and last file to be loaded is AUTOEXEC.BAT. This is 

a batch file, which means that it contains a series of commands 

that are executed whenever the file is run. This file is 

“automatically executed” when you boot, hence the name. If there 

is no AUTOEXEC.BAT file present, a default version is run. You 

can usually tell because if the default version is run you will 

be asked to enter the date and the time. After all of this, if it all 

works correctly, you will finally 

see the prompt, which will most likely look like one of these: 

A:\> 

C:\> 

 

  

 

 

 

 

 

DOS COMMAND: 

Dos command are basically divided into two groups. The two 

groups are: 

• Internal command 

http://webopedia.internet.com/TERM/s/shell.html
http://webopedia.internet.com/TERM/i/internal_command.html
http://webopedia.internet.com/TERM/b/batch_file.html


• External command 

Internal command: 

Internal command are part of the command processor i.e. 

COMMAND.COM which is loaded in the memory. These DOS 

command can be given at any time. The required instructions are 

already loaded in memory. These commands do not require a 

special file on disk to run them. 

External command : 

External commands are those command which are not included in 

the command processor but have their own .COM files.   

The external commands are files that do reside on disk and have an 

extension of .COM, .EXE, or .BAT. 

 

 

Most Commonly Used Internal DOS Commands 

1. DATE 

This command is used to display the system current date 

setting and prompt you to enter a new date. The syntax 

is: DATE  [/T | date] 

 

 
 

If you type DATE without parameters then it displays current 

date and prompts to enter new date. We should give new date 

in mm-dd-yy format. If you want to keep the same date just 

Press ENTER. DATE command with /T switch tells the 

command to just output the current system date, without 

prompting for a new date. 

2. TIME 

http://2.bp.blogspot.com/-OnXO1INlteQ/TZGTJmAU2GI/AAAAAAAAD8c/K1kdyUlLVe0/s1600/dos-date-command.PNG


This command is used to displays or set the system time.  

The syntax is: TIME   [/T | time] 

 

 
3. COPY CON 

It is used to create a file in the existing directory. Here CON 

is a DOS reserved word which stands for console.  

Syntax is: COPY  CON filename after that press Enter and 

start typing your text and after you're done typing your text, 

to save and exit hit F6 key. 

4. TYPE 

This command is used to display the contents of a text file or 

files. The syntax is: TYPE   [drive:][path]filename 

Now, lets try to display the contents of the file named 

filename we've created earlier using COPY CON command.  

 
 

 

5. CLS 

It is used to clear the screen. Syntax is CLS 

 
6. REN 
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This command is used to change/modify the name of a file or 

files.  

Syntax is: REN   [drive:] [path] filename1   filename2. 

 

Here, filename1 is source file for which you wanted to 

change the name, and filename2 will obviously becomes your 

new file name. Also note that you cannot specify a new drive 

or path for your destination file. 

7. DIR 

This command displays a list of files and subdirectories in a 

directory. Syntax is: DIR   [drive:]  

8. VER 

This command displays the version of the Microsoft 

Windows running on your computer. 

9. VOL 

It displays the disk volume label and serial number, if they 

exist for the drive specified. If no drive is specified it 

displays for the active drive. 

Syntax is VOL  [drive:] 

 
10. DEL/ERASE 

Used to delete one or more files.  

Syntax: del file name 

11. COPY 

This command is useful in copying one or more files to 

another file or location. Syntax is       COPY     source 

filename  destination filename  

12. MD, CD and RD 

 

• MD (or MKDIR) command stand for make directory and it 

is used to create a directory. Syntax is MD   [drive:]path 
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• CD (or CHDIR) stands for create or change directory and it 

allows displaying the name of or changing the current directory or 

rather we can say come out of a directory. Syntax is CD   [/D]   

[drive:][path] 

 

13. RD (or RMDIR) command removes or deletes a 

directory. There are two conditions to remove any directory - 

(1) Directory to be removed should be empty. and (2) We 

should be outside the directory we are commanding to 

delete.  

Syntax is RD   [/S]   [/Q]   [drive:]path  

 

Most Commonly Used External DOS Commands 

1. EDIT 

This command is used to modify or change the data of a file. 

Syntax is     EDIT   filename 

2. XCOPY 

This command is used to copy files and directory trees from 

one disk to another disk.  

Syntax is XCOPY   source   [destination]  

3. LABEL 

It is used to create, change, or delete the volume label of a 

disk. 

Syntax is LABEL    [drive:]  [label] 

 

 

4. DISKCOPY 

This command copies the contents of one floppy from the 

source drive to a formatted or un-formatted floppy disk in the 

destination drive. This command copies the data from 

particular position on the source disk to exactly the same 

position on the destination disk. 

 Syntax Diskcopy  A:  B: 

 



5. CHKDSK 

This command is used to check a disk and display a status 

report with properties of disk like serial number, volume 

label, memory and other properties along with errors on the 

disk if any.  

 

Syntax is     CHKDSK   [volume path]    

6. TREE 

This command is very useful to view the list of directories 

and subdirectories present on the disk in graphical form.  

TREE   [drive:path]   

7. DELTREE 

This command is used to remove a directory along with its 

contents.  

Syntax is deltree [drive:path]  

8. DOSKEY 

This command is generally used to edits command lines and 

recalls commands.  

Syntax is DOSKEY  [/REINSTALL]  [/HISTORY] [text] 

 

Here, /REINSTALL installs new copy of doskey, /HISTORY 

is used to display all previously given commands stored 

in memory.  

 

 

 

9. SORT 

This command is used to arrange the data of a file in alphabetical 

order (A-Z, 0-9) or reverse alphabetical order.  

 

Syntax is SORT   [/R]   [[drive1:][path1]filename1]   

10. BACKUP 

The Backup command backs up one or more files from one disk to 

another. You can backup files onto either a hard disk or on a 



floppy disk. Syntax is  

BACKUP   Source   Destination 

 

11. RESTORE 

The RESTORE command restores files that were backed up by 

using BACKUP command. 

Syntax: RESTORE   drive1  drive2:path 

12. FORMAT 

 

 this command prepares a disk by arranging random magnetic 

impulses in to a series of track and sectors so that it is addressable 

by a DOS version. 

 Syntax : C:\> format A: 

 

PARTITION OF DISK: 

 

About diskpart 

The diskpart command is a recovery console command that 

enables a user to delete and create partitions on their computer. 

Availability 

The diskpart command is a recovery console and external 

command that is available in the below Microsoft operating 

systems. 

 

Microsoft DiskPart syntax: 

 

diskpart [/s <script>] [/?] 

 

/s <script> Use a DiskPart script. 

http://www.computerhope.com/jargon/p/partitio.htm
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/? Show this help screen. 

Typing diskpart from an elevated command prompt will enter the 

"DISKPART>" prompt. From this prompt, the below commands 

are available. These commands are also available from a DiskPart 

script. 

 

Recovery Console diskpart command syntax 

Creates and deletes partitions on a hard drive. The below diskpart 

command information is only available when you are using the 

Recovery Console. 

diskpart [/add | /delete] [device name | drive name | partition name] 

[size] 

 

/add Creates a new partition. 

/delete Deletes an existing partition. 

device_name The device you want to create or delete a partition. The 

name can be obtained from the output of the map 

command. 

drive_name The partition you want to delete, by drive letter. Used 

only with /delete. 

partition_name The partition you want to delete, by partition name. Can 

be used in place of the drive_name. Used only with 

/delete. 

Size The size, in megabytes (MB), of the partition you want 

to create. Used only with /add. 

http://www.computerhope.com/jargon/e/elevated.htm
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Examples 

Diskpart 

Typing diskpart without any additional switches or options opens a 

new DISKPART> prompt and allow all the above commands to be 

entered. For example, while at the DISKPART> prompt you can 

type: LIST DISK and get an output similar to the example below. 

Disk ### 

-------------- 

Disk 0 

Disk 1 

Disk 2 

Disk 3 

Disk 4 

Disk 5 

Status 

-------------- 

Online 

Online 

No Media 

No Media 

No Media 

No Media 

Size 

-------------- 

119 GB 

2047 GB 

0 B 

0 B 

0 B 

0 B 

Free 

-------------- 

0 B 

0 B 

0 B 

0 B 

0 B 

0 B 

Dyn 

-------------- 

Note: When entering the diskpart command in some versions of 

Windows you may receive a UAC warning. You must accept this 

warning before diskpart can open. 

Tip: To exit the DISKPART> prompt type exit and press enter. 

diskpart /delete D: 

In the above example, the D: partition would be deleted. 

diskpart /add \Device\HardDisk0 20 

In the above example, a 20MB would be created on the HardDisk0 

device. This name is obtained from the map command. 

 

http://www.computerhope.com/jargon/u/uac.htm
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LIMITATION OF DOS: 

 

DOS has direct access to only 640 kilobytes of primary storage, 

although new microcomputers have much more primary storage. 

This restriction is an inherent limitation of DOS.  

Today's new software for word processing, graphics, spreadsheets, 

and database management requires more primary storage. 

 In addition, DOS is a single tasking operating system. It can 

support only one user and one program at a time. 

 

Another disadvantage is that DOS has a character-based interface. 

A graphical user interface is easier to the users than the character-

based interface. 

Proper syntax required to perform any task in dos. 

 

 

 

 

 

 

 

 

 

  

 

 

 

Multi programming: 

 

 Multiprogramming is the technique of running several programs at 

a time using timesharing.  

It allows a computer to do several things at the same time. 



Multiprogramming creates logical parallelism.  

The concept of multiprogramming is that the operating system 

keeps several jobs in memory simultaneously. The operating 

system selects a job from the job pool and starts executing a job, 

when that job needs to wait for any i/o operations the CPU is 

switched to another job. So the main idea here is that the CPU is 

never idle.  

Multi tasking: Multitasking is the logical extension of 

multiprogramming .The concept of multitasking is quite similar to 

multiprogramming but difference is that the switching  

between jobs occurs so frequently that the users can interact with 

each program while it is running. This concept is also known as 

time-sharing systems. A time-shared operating system uses CPU 

scheduling and multiprogramming to provide each user with a 

small portion of time-shared system. 

 

GUI CONCEPT : 

 

An operating system (os) is a system software that  control the 

internal activities of the computer hardware  and provide user 

interface . 

Window operating system support a single user at a time.  

It is a graphical user interface (gui) based which has been designed 

to make more easy. 

There are no more need to remembering the exact syntax of 

command to get your work done. 

The program and files are generally accessed with the help of 

mouse. 

 

A window is a (usually) rectangular portion of the display on a 

computer monitor that presents its contents (e.g., the contents of a 

directory, a text file or an image) seemingly independently of the 



rest of the screen. Windows are one of the elements that comprise 

a graphical user interface (GUI). 

A GUI is a type of human-computer interface (i.e., a system for 

people to interact with a computer) that uses windows, icons, pull-

down menus and a pointer and that can be manipulated by a mouse 

(and usually to some extent by a keyboard as well). An icon is a 

small picture or symbol that represents a program (orcommand), 

file, directory (also called a folder) or device (such as a hard disk 

or floppy disk). 

The GUI represents a major advance over the command line 

interface (CLI) of the console, which displays only text (i.e., no 

images) and is accessed solely by a keyboard. It has made 

computers much easier to learn and work with, and it has also led 

to the development of major new applications for them, including 

desktop publishing and CAD (computer-aided design). 

The words window and windows are generic terms and should not 

be confused with Microsoft Windows (although they sometimes 

are). The latter is the trade name that Microsoft selected for its 

series of operating systems that employ a GUI. (The originally 

intended name was Interface Manager, but Microsoft's marketing 

expert Rowland Hanson convinced co-founder Bill Gates 

that Microsoft Windows was preferable). 

 

 CONCEPT OF LOGIN AND LOGOUT: 

In computer security, a login or logon refers to the credentials 

required to obtain access to a computer system or other restricted 

area. Logging in or on and signing in or on is the process by which 

individual access to a computer system is controlled by identifying 

 and  authenticating the user through the credentials presented by 

the user.  
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Once a user has logged in, they can then log out or log off when 

access is no longer needed. To log out is to close off one's access 

to a computer system after having previously logged in. 

 

 

  

 

A login, logging in or logging on is the entering of identifier 

information into a system by a user in order to access that system 

(e.g., a computer or a website). It is an integral part of computer 

security procedures. 

A login generally requires the user to enter two pieces of 

information, first a user name and then a password. This 

information is entered into a login window on aGUI (graphical 

user interface)  

A user name, also referred to as an account name, is a string (i.e., 

sequence of characters) that uniquely identifies a user. User names 

can be the same as or related to the real names of users. 

A password is likewise a string, but it differs from a user name in 

that it is intended to be kept a secret that is known only to its user 

and, perhaps, to the system administrator(s). 

 

 

 

 

 

 

http://www.linfo.org/window.html
http://www.linfo.org/gui.html
http://www.linfo.org/string.html
http://www.linfo.org/character.html


MY DOCUMENT : 

 

My Documents is the commonly recognized name of a special 

folder in Microsoft Windows, allocated to help users store their 

personal data files. The actual name of the folder might be 

different, depending on the version or language of the installed 

copy of Windows. In Windows XP, it contained other subfolders 

such as "My Pictures", "My Music" and "My Videos". Starting 

with Windows Vista, these subfolders were moved out of My 

Documents and were made its siblings. 

 

Microsoft first introduced the "My Documents" folder in Windows 

95 OEM Service Release 2, as a standard location for storing user-

created files. The folder, located under the root directory of 

the boot volume, is displayed (but not stored) directly on the 

user's desktop. 
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MY COMPUTER: 

 

My Computer shows you the contents of your floppy disk, hard 

disk, CD-ROM drive, and network drives. You can also search for 

and open files and folders, and gain access to options in Control 

Panel to modify your computer's settings. 

 

A section of Microsoft Windows that was introduced with the 

release of Windows 95 and included with all subsequent 

versions, My Computer allows the user to explore the contents of 

their computer drives as well as manage their files. The picture 

shows examples of the My Computer icon in MicrosoftWindows 

XP, Vista and Windows 7, as well as the "This PC" icon 

introduced in Windows 8. Although the name has changed, this 

icon still has the same function as the original. 

 

How to open My Computer 

1. Get to the Windows Desktop and open Start Menu or 

navigate to the Start Screen if you're using Windows 8. 

 

2. On earlier versions of windows after clicking 

Start, double-click the My Computer icon. In newer 

versions selectComputer from the menu that appears. The 

following images show examples of the My Computer 

folder in both new and old versions of windows. 
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Windows XP 

 

MY NETWORK PLACES: 

 

My Network Places is a feature of Windows XP and older versions 

of Microsoft Windows used to browse network resources.  

 

Microsoft Windows My Network Places is a network browser that 

displays network connections a computer has to other computers 

and servers and is what replaces Network Neighborhood found in 

Windows 95, 98, and NT. In a home network setting, My Network 

Places can display the other computers, network printers, and other 

network resources. In an office setting, it can display computers, 

servers, and network printers in the users local workgroup. With 

the release of Microsoft Windows Vista and Windows 7, My 

Network Places has been renamed to Network. 
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RECYCLE BIN: 

 

The Recycle Bin is a location where deleted files are temporarily 

stored onMicrosoft Windows 95, 98, ME, NT, 2000, XP, Vista, 

and all later versions of Microsoft Windows.  

 

The Recycling Bin allows users to recover files that have been 

deleted in Windows. In the image to the right, is an example of 

what the empty Recycle Bin may look like in your version of 

Windows and can be found on the Desktop. 

 

It is a wastebasket icon on your computer desktop that works as a 

Location or Directory for deleted files or folders on your computer. 

Deleted files remain in it until you restore recycle rin or empty it. It 

allows you to recover deleted files or undelete the accidentally 

deleted files or folders from your hard disk.  

 

Keep in mind that if you have deleted files through an MS-

DOSprompt or shell that the files will not go to the Recycle Bin. 

 

START BUTTON: 

 

The Start menu is the main gateway to your computer's programs, 

folders, and settings. It's called a menu because it provides a list of 

choices, just as a restaurant menu does. And as "start" implies, it's 

often the place that you'll go to start or open things. 

Use the Start menu to do these common activities: 
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• Start programs 

• Open commonly used folders 

• Search for files, folders, and programs 

• Adjust computer settings 

• Get help with the Windows operating system 

• Turn off the computer 

• Log off from Windows or switch to a different user account 

Getting started with the Start menu 

To open the Start menu, click the Start button  in the lower-left 

corner of your screen. Or, press the Windows logo key  on your 

keyboard. 

The Start menu has three basic parts: 

• The large left pane shows a short list of programs on your 

computer. Your computer manufacturer can customize this list, 

so its exact appearance will vary. Clicking All 

Programs displays a complete list of programs (more on this 

later). 

• At the bottom of the left pane is the search box, which allows 

you to look for programs and files on your computer by typing 

in search terms. 

• The right pane provides access to commonly used folders, files, 

settings, and features. It's also where you go to log off from 

Windows or turn off your computer. 

 

Opening programs from the Start menu 

One of the most common uses of the Start menu is opening 

programs installed on your computer. To open a program shown in 

the left pane of the Start menu, click it. The program opens and the 

Start menu closes. 



If you don't see the program you want, click All Programs at the 

bottom of the left pane. The left pane displays a long list of 

programs in alphabetical order, followed by a list of folders. 

Clicking one of the program icons starts the program, and the Start 

menu closes. So what's inside the folders? More programs. 

Click Accessories, for example, and a list of programs that are 

stored in that folder appears. Click any program to open it. To get 

back to the programs you saw when you first opened the Start 

menu, click Back near the bottom of the menu. 

If you're ever unsure what a program does, move the pointer over 

its icon or name. A box appears that often contains a description of 

the program. For example, pointing to Calculator displays this 

message: "Performs basic arithmetic tasks with an on-screen 

calculator." This trick works for items in the right pane of the Start 

menu, too. 

You might notice that over time, the lists of programs in your Start 

menu change. This happens for two reasons. First, when you install 

new programs, they get added to the All Programs list. Second, the 

Start menu detects which programs you use the most, and places 

them in the left pane for quick access. 

 

 

TASK BAR: 

 

In computing, a taskbar or dock is a bar displayed on an edge of 

a GUI desktop that is used to launch and monitor running 

applications. Microsoft introduced the taskbar inWindows 95 in 

1995 and the feature has been a defining aspect of Microsoft 

Windows's graphical user interface and many other operating 

systems and desktop environmentssince. 
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It is located at the bottom of the windows xp . it contains a start 

button  on the left side on the extreme right side of the task bar 

show the current date and time. That area where we can see the  

date and time called notification area. 

 

DATE AND TIME SETTING: 

 

1. Right-click on the time in your System tray or notification 

area. This is commonly in the bottom right-hand of your 

screen. 

2. Click the Adjust Date/Time menu item. 

3. This opens the Date/Time Properties window. In this 

window, you can adjust thetime, date, and time zone. If 

you want to change how the computer handles daylight 

savings, click the Time Zone tab and check or uncheck 

the 'Automatically adjust clock for daylight saving 

changes' option. 

4. Once the proper date and time has been set, click Apply, 

and then Ok. 

Tip: You may also double-click the time to open the Date/Time 

Properties window. 

 

CALCULATOR: 

 

How to Use the Calculator in Windows XP 

You can use the calculator in Windows XP to calculate 

anything you would on a regular calculator. You can add, 

subtract, divide, multiply, and even perform more complicated 

calculations using the calculator in Windows XP. Just follow 

these steps to quickly access, open, and use the Windows 

calculator. 
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 Choose Start--→All Programs--→Accessories--→Calculator. 

 

You can enter numbers and symbols in a few different ways in the 

calculator. Type numbers and symbols on your keyboard, and they 

appear in the entry box of the calculator. Press Enter to perform the 

calculation. Click numbers or symbols on the 

calculator display and click the = button to perform the calculation. 

 

WORDPAD: 

 

 

WordPad is a text-editing program you can use to create and edit 

documents. Unlike Notepad, WordPad documents can include rich 

formatting and graphics, and you can link to or embed objects, 

such as pictures or other documents. 

 

To open WordPad, click Start, point to All Programs, point 

to Accessories, and then click WordPad.  

 

SYSTEM TOOLS: 

This tool is in charge of reorganizing the information that 

is stored in the disk, although it can also fix errors on the units. 

Windows incorporates this tool because the disk becomes 
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slow as we save new data and delete old data. This is why we 

need to reorganize the information so that the free spaces 

between the information disappear and the performance of our 

disk improves. By doing this we will also be able to access 

information quicker. 

The free spaces 

that are generated 

when information 

from the disk is 

deleted influence 

the size that files 

and programs 

use. This is the 

reason why when 

we see the 

properties of a file 

two sizes appear, 

the real size of the 

file and the space 

that the file is using 

in the disk. If we 

defragment the disk 

we will notice that 

the difference between the two sizes decreases. 

  

To use this tool follow the steps shown on the previous topic 

until this screen is reached. 

Click on Defragment Now... and the disk defragmenter 

window will appear, similar to the one shown below. 

First select the volume from the list clicking on it, and then 

you can choose to run the defragmenter directly by 

clicking Defragment, or check the state of the disk first by 



clicking Analyze. 

Depending on the results, you can choose to defragment the 

disk or not. When many deletions have been done on the disk a 

defragmentation in needed because there are many files that are 

fragmented instead of using a contigous space on the disk. 

 

  

Once the Defragment button has been pressed a window will 

appear and report the process and it will allow you to pause or 

finalize it. Remember that this process will take quite a while. 

 

 

System Information  



This tool, as its name indicates, is in charge of showing 

information regarding the system, such as the installed 

applications, the drivers, the processor, etc. 

Here you can find usefull information, such as the models, 

versions, and manufacturers of your computer´s programs and 

hardware. 

 

 

Scheduled Tasks (I) 

 

The Scheduled Tasks is used to schedule any program to 

run at specific times. 

We can, for example, schedule the use of the Disk 

Cleanup for once a week; this way we make automatic the 

tasks that we usually do periodically. We can also have the 

computer do this task at times when it will not slow our work 

down. 

 

Schedules tasks   

To use this tool 

follow these 

steps: 

Click on Start. 

Display the 

menu All 

programs. 

Select the 

menu Accessorie

s. 

 



Open the 

menu System 

Tools. 

Lastly select 

the 

option Schedule

d Tasks. 

When it is running, a window like the one below will appear. 

In this window, the tasks that have been scheduled until this 

time will appear, together with the assistant to schedule new 

tasks. 

 

 

How to generate a scheduled task 
 

In the Scheduled Task Wizard window select Add 

scheduled task, and the wizard will begin. 

The assistant will ask you to select the program that you wish 

to run, showing a dialog box like this one. 
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Next 

click Next 

and you 

will be 

asked to 

select 

the freque

ncy at 

which you 

want the 

task to be 

performed. 

Next 

click on Next and it will allow you to select some parameters 

related with the frequency selected. If you, for example, choose 

weekly, it will ask which day of the week you want the task 

done. 

Once all the parameters have been indicated, click Finish so 

that this task is added to the programmed task list. 

 

 

DISK CLEANUP: 

 

Disk Cleanup helps free up space on your hard drive Disk 

Cleanup searches your drive, and then shows you temporary files, 

Internet cache files, and unnecessary program files that you can 

safely delete. You can direct Disk Cleanup to delete some or all of 

those files. 

Open Disk Cleanup 

Note 

• To open Disk Cleanup, click Start, point to All Programs, 



point to Accessories, point to System Tools, and then 

click Disk Cleanup.  
 

 

 

 

 

 

 

Starting Word 

Microsoft Word is an efficient and full-featured word processor 

that provides you with all the tools you need to produce a wide 

variety of document types—everything from simple documents, 

such as memos and outlines, to complex documents, such as 

newsletters and Internet-ready HTML pages. You create your 

Word documents in the Word window, which provides easy access 

to all the tools you need to create all your documents. 

Before you can take advantage of Word's proficient document 

processing features, you must open the Word application window. 

To start the Word program, follow these steps: 

1. From the Windows XP desktop, click Start, All Programs (on 

Windows 2000, click Start, then Programs). The Programs 

menu appears (see Figure 1.1). 
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To start Word, point at the Microsoft Office icon and then click the 

Word icon. The Word application window appears 

 

Pin a Program to the Windows XP Start Menu For quick access to 

an application such as Word, right-click on the program icon when 

accessing the Programs menu. On the shortcut menu that appears, 

select Pin to Start menu. The application icon will now be 

available on the main Start menu, when you click Start. 

 

Understanding the Word Environment 

When you start Word, the Word application window opens (see 

Figure 1.2). You create your documents in the Word window. The 
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Word window also provides items that help you navigate and 

operate the application itself. 

Figure 1.2. Create your documents and access Word's features 

and commands in the Word window. 

 

 

 

Control the View If your view differs from the view shown in 

Figure 1.2 (the Normal view), or if you don't see all the Word 

window elements shown in the figure (particularly the ruler), you 

can easily change your view. Select View, and then choose the 

menu selection (such as Normal or Ruler) that matches your view 

to the figure. 

 

Notice that the largest area of the window is blank; this is where 

you create your new document. All the other areas—the menu bar, 

the toolbar, and the status bar—either provide a fast way to access 
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the various commands and features that you use in Word, or they 

supply you with information concerning your document, such as 

what page you are on and where the insertion point is currently 

located in your document. 

 

 

Table 1.1. Elements of the Word Window 

 

 

Element Description 

Title bar Includes the name of the application and the 

current document, as well as the Minimize, 

Maximize, and Close buttons. 

Control Menu 

button 

Opens the Control menu, which provides such 

commands as Restore, Minimize, and Close. 

Minimize button Reduces the Word window to a button on the 

taskbar; to restore the window to its original 

size, click the button on the taskbar. 

Maximize/Restore 

button 

Enlarges the Word window to cover the 

Windows desktop. When the window is 

maximized, the Maximize button changes to a 

Restore button that you can click to return the 

window to its previous size. 

Close (X) button Closes the Word program. "X" is the icon for 

closing any window. 

Menu bar Contains menus of commands you can use to 



Element Description 

perform tasks in the program, such as Edit, 

Format, and Tools. 

Toolbar Includes icons that serve as shortcuts for 

common commands, such as Save, Print, and 

Spelling. 

Status bar Displays information about the current 

document, including page number, the section 

in which you are located, and the current 

location of the insertion point (inches, line, 

and column). The status bar also shows you 

other information, such as whether you have 

turned on the Typeover (OVR) mode or 

turned on Word's track changes (TRK) 

feature. 

Document window This window is where you type and format 

your documents. 

Scrollbars The horizontal scrollbar is used to scroll your 

view of the current document in a left-to-right 

motion. The vertical scrollbar is used to scroll 

up and down through the current document. 

Task pane The column of information on the right side of 

the document is the task pane. This is where 

you can access features such as the Clipboard, 

styles, and formatting; you can also open 

another document or mail merge. 

 

Using Menus and Toolbars 

Word provides several ways to access the commands and features 

you use as you create your documents. You can access these 
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commands by using the menus on the menu bar and the buttons on 

the various toolbars. 

You can also access many Word commands using shortcut menus. 

Right-clicking a particular document element (a word or a 

paragraph, for example) opens these menus, which contain a list of 

commands related to the item on which you are currently working. 

 

The Word Menu Bar 

The Word menu bar gives you access to all the commands and 

features that Word provides. As in all Windows applications, 

Word's menus reside below the title bar and are activated by 

clicking a particular menu name. The menu then drops open, 

providing you with a set of command options. 

Word (and the other Office applications) uses a menu system 

called personalized menus that enables you to quickly access the 

commands you use most often (while hiding those that you use less 

frequently). When you first choose a particular menu, you find 

only a short list of Word's most commonly used menu commands. 

When you've spent some time using Word, this list of commands 

will actually be the ones that you have used most recently on that 

particular menu. 

If a menu has a small double arrow at the bottom of its command 

list, you can click that to gain access to other, less commonly 

needed, commands. As you use hidden commands, Word adds 

them to the normal menu list. This means that you are basically 

building the list of commands available on the menu as you use 

Word. 

This personalized strategy is also employed by the toolbar system. 

As you use commands, they are added to the toolbar (this 



personalized toolbar feature is available only when you have the 

Standard toolbar and the Formatting toolbar on the same line in an 

application window). This provides you with customized menus 

and toolbars that are, in effect, personalized for you. 

To access a particular menu, follow these steps: 

1. Select the menu by clicking its title (such as View), as shown 

in Figure 1.3. The most recently used commands appear; wait 

just a moment for all the commands on a particular menu to 

appear (if the commands do not appear, click the down arrow 

at the bottom of the menu). 

 

2. Figure 1.3. Select a particular menu to view, and then point 

to a Word command. 
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1. Select the command on the menu that invokes a particular 

feature (such as Header and Footer). 

You will find that many of the commands found on Word's menus 

are followed by an ellipsis (…). These commands, when selected, 

open a dialog box that requires you to provide Word with 

additional information before the particular feature or command 

can be used. More information about understanding dialog boxes is 

included later in this lesson. 

Some of the menus also contain a submenu or cascading menu 

from which you make choices. The menu commands that produce 

a submenu are indicated by an arrow to the right of the menu 

choice. When a submenu is present, you point at the command 

(marked with the arrow) on the main menu to open the submenu. 

The menu system itself provides a logical grouping of the Word 

commands and features. For example, commands related to files, 

such as Open, Save, and Print, are all found on the File menu. 

Activating Menus with the Keyboard You can activate a 

particular menu by holding down the Alt key and then 

pressing the keyboard key that matches the underscored 

letter in the menu's name. This underscored letter is called 

the hotkey. For example, to activate the File menu in Word, 

press Alt+F. 

 

If you find that you would rather have access to all the menu 

commands (rather than accessing only those you've used recently), 

you can turn off the personalized menu system. To do this, follow 

these steps: 

1. Click the Tools menu, and then click Customize. 

2. In the Customize dialog box, click the Options tab. 



3. To show all the commands on the menus, click the Always 

Show Full Menus check box. 

4. Click OK to close the dialog box. 

 

Shortcut Menus 

A fast way to access commands related to a particular document 

element is to select that document object and then right-click. This 

opens a shortcut menu that contains commands related to the 

particular object with which you are working. 

Object Any element found in a document, such as text, a graphic, a 

hyperlink, or other inserted item. 

For example, if you select a line of text in a document, right-

clicking the selected text (see Figure 1.4) opens a shortcut menu 

with commands such as Cut, Copy, and Paste, or it provides you 

with quick access to formatting commands, such as Font and 

Paragraph. 

Figure 1.4. By right-clicking areas in Word, you can use shortcut 

menus to quickly access Word commands related to the item that 

was clicked. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch37lev1sec3.html#ch37fig04#ch37fig04


. 

Chapter 2. Working with Documents 

In this lesson, you learn how to start a new document and enter 

text. You also learn how to take advantage of Word document 

templates and Word document wizards. 

 

 

Starting a New Document 

When you choose to start a new document in Word, you can take 

three routes. You can 

• Create a blank new document using Word's default template. 

• Create a document using one of Word's many other templates 

or a custom one you created yourself. 

• Create a document using one of the Word wizards, such as 

the Fax or Envelope Wizard. 



• Create a document based on an existing document; using this 

method you are essentially opening a copy of an existing 

document, and you can then save it using a new filename. 

Templates and wizards allow you to create more complex 

documents such as newsletters or Web sites. When you want to 

create a simple document, your best bet is to open a new blank 

document. 

 

Template A blueprint for a document that may already contain 

certain formatting options and text. 

Wizard A feature that guides you step by step through a particular 

process in Word, such as creating a new document 

When you create a new document from scratch, you are actually 

using a template—the Blank Document template. Documents 

based on the Blank Document template do not contain any 

premade text (as some of the other templates do), and the 

formatting contained in the document reflects Word's default 

settings for margins, fonts, and other document attributes 

(including any you customized specifically to your needs or 

preferences). To find more information on default Word settings 

involving font and document attributes, see Lesson 5, "Changing 

How Text Looks," and Lesson 9, "Working with Margins, Pages, 

and Line Spacing," respectively). 

As covered in Lesson 1, Word automatically opens a new blank 

document for you when you open the Word application window. 

You can also open a new document when you are already working 

in Word. 

To open a new document, follow these steps: 
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1. Select File, New. The New Document task pane opens on the 

right side of your screen. The task pane makes it easy for you 

to quickly create a new blank document, XML document (a 

document in the eXtensible Markup Language), Web page, 

or Email. For our purposes, let's look at available templates: 

under Other templates, select On My Computer. Word opens 

the Templates dialog box with a range of templates from 

which to choose (see Figure 2.1). 

Figure 2.1. When you choose New on the File menu, the 

task pane opens and you can choose to open templates on 

your computer. 

 

 

1. Make sure that the General tab is selected in the Templates 

dialog box, and then double-click the Word Blank Document 

icon. A new document appears in the Word application 

window. 
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Although the steps shown here are designed for you to create a 

new blank document, you could have chosen any of the templates 

available in the Templates dialog box to create a new document. 

The fastest way to create a new blank document is to click the New 

Blank Document icon on the Word Standard toolbar. 

 

What Happened to My Previous Document? If you were already 

working on a document, the new document will, in effect, open on 

top of the document you were previously working on. You can get 

back to the previous document by clicking the appropriately named 

document icon on the Windows taskbar (if you haven't yet named 

the first document, it might appear as Document1 on the taskbar). 

You can also select the Windows menu to see a list of currently 

opened documents. Click any document in the list to switch to it. 

Multiple Document Icons Are Grouped When you open a number 

of Word documents that exceed the number of single buttons that 

can be shown on the Windows Taskbar (which depends on your 

screen resolution), the document buttons are grouped under one 

Microsoft Word icon on the Taskbar. Click the single Word icon 

and a list of the currently open documents appears. As you close 

documents, the open documents remain grouped under the one 

icon until you close all but one of the documents (or all the 

documents by right-clicking on the Word icon and then selecting 

Close Group). 

Using Document Templates 

You don't have to base your new documents on a blank template. 

Instead, you can take advantage of one of the special document 

templates that Word provides. These templates make it easy for 

you to create everything from memos to newsletters. 



Templates contain special text and document attributes; therefore, 

the look and layout of the document you create using a template 

are predetermined by the options contained in the template. This 

can include margins, fonts, graphics, and other document layout 

attributes. 

To base a new document on a Word template, follow these steps: 

1. Select the File menu, and then click New. The task pane 

opens in your current document window. 

2. Several templates such as the Blank Document, Web Page, 

and XML Document templates, appear at the top of the New 

Document task pane. You can select any of these templates. 

Or you can use the Search box under Templates on 

Microsoft.com to search for online templates that Microsoft 

stores on the Office Web site. You can also select templates 

on your computer or templates held on other Web sites. To 

create a new memo from a template stored on your computer, 

click the On My Computer link under the Other Templates 

heading. 

3. In the Templates dialog box that appears, choose the Memos 

tab (see Figure 2.2). Select your favorite style of memo and 

click OK (or double-click the icon of choice). 

4. Figure 2.2. The document category tabs in the Templates 

dialog box contain templates for different document types. 
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1. The new document based on the template appears as shown 

in Figure 2.3. 

Figure 2.3. The new document contains predetermined text 

and formatting attributes derived from the template. 
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Most new documents based on templates already contain text, such 

as headings, and a variety of document layouts and text attributes, 

such as a particular font. For example, the document based on the 

Contemporary Memo template already contains the layout for a 

memo, and it automatically enters the current date in the memo for 

you. 

You can easily enter text into the document using the Click Here 

and Type boxes that are placed in the document. Just click 

anywhere on the bracketed boxes provided and type the text you 

want to enter. 

Many templates (the Contemporary Memo template, for example) 

contain text that gives you advice on how to use the template. Any 

of this explanatory text can be selected and removed or replaced 

with your own text (for more about selecting and editing text, see 

Lesson 3, "Editing Documents"). 
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Using Word Wizards 

If you find that you would like even more help as you create a new 

document, you can use any of a number of Word document 

wizards. These wizards actually walk you through the document 

creation process, and in many cases, they make sure that you enter 

the appropriate text in the proper place in the new document. 

The wizards are found on the same tabs that housed the templates 

located in the Templates dialog box (reached through the task 

pane). The wizards can be differentiated from standard templates 

by a small wizard's wand that appears over the top right-hand 

corner of a template's icon. 

To create a new document using one of the wizards, follow these 

steps: 

1. Select the File menu, and then click New to open the New 

Document task pane. 

2. Under the Other Templates heading, select the On My 

Computer link. In the Templates dialog box that appears, 

choose the new document tab of your choice (only the Legal 

Pleadings, Letterhead & Faxes, Memos, and other 

Documents tabs provide wizards). 

3. To start the document creation process using the wizard, 

double-click the appropriate wizard icon (for example, the 

Memo Wizard on the Memos tab). 

When you double-click the wizard icon, the wizard dialog box 

opens with an introductory screen and outlines the document 

creation process for the type of document you want to create. For 

example, the Memo Wizard shown in Figure 2.4 details the memo 

creation process on the left side of the wizard dialog box. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch38lev1sec1.html#ch38fig04#ch38fig04


Figure 2.4. The various document wizards, such as the Memo 

Wizard, outline the new creation process and then walk you 

through the steps of creating the document 

 

 

If you find that you need help as you work with a wizard, you can 

click the Office Assistant button on the wizard dialog box. The 

Office Assistant, which appears as an animated paper clip by 

default, appears with context-sensitive help related to the wizard 

screen on which you are currently working. If the button is not 

available, cancel the wizard, select the Help menu, and then Show 

the Office Assistant; then repeat the steps necessary to open the 

particular document wizard. 

To move to the next step in the document creation process, click 

the Next button at the bottom of the wizard screen. 



The various document wizards walk you through the entire 

document creation process. After completing the steps for 

document creation, click the Finish button to close the wizard. A 

new document appears in the Word window based on the choices 

you made as you worked with the wizard. Figure 2.5 shows a new 

document created using the Memo Wizard. 

Figure 2.5. The Memo Wizard prompts you to input the 

appropriate information for a memo and provides the formatting 

for the new document. 

 

The wizards you use vary in look and feel, depending on the type 

of document you are trying to create. For example, the Resume 

Wizard produces a decidedly different product than the Envelope 

Wizard does. A good rule to follow is to read each wizard screen 

carefully. Remember that you can always back up a step by 

clicking the Back button if you find that you've made an 
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inappropriate choice (or you can close the unwanted document and 

start over). 

Creating a New Document From an Existing Document 

A new option that Word provides is the ability to quickly create a 

copy of an existing document. This allows you to open the existing 

document but have Word treat it as a new document without a 

filename. You can then edit the text and other items in the 

document as needed. 

To create a new document from an existing document, click File, 

then New. The New Document task pane opens. Select the From 

Existing Document link under the New heading. The New from 

Existing Document dialog box opens (see Figure 2.6). 

 

Figure 2.6. The New from Existing Document dialog box allows 

you to create a new document from an existing one. 
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Use the Look In drop-down box to specify the drive where the file 

is located. Then double-click to open the appropriate folder. Select 

the file and then click Create New in the bottom right of the dialog 

box. A new document will open, which is a copy of the document 

you specified in the New from Existing Document dialog box. 

After making changes to the new document, you will want to save 

it under a new document name. The next section discusses saving a 

new document. 

 

Saving a Document 

Whether you create your new document using the Blank Document 

template, a Word template, a document wizard, or from an existing 

document, at some point you will want to save the new document. 

Saving your work is one of the most important aspects of working 

with any software application. If you don't save your Word 

documents, you could lose them 

Save and Save Often You don't want to lose your valuable 

documents as you create them in Word. Power failures, an 

accidentally kicked-out power cord, or your computer locking up 

as you work can all lead to lost work. If you are really absent-

minded about periodically saving your work, use the AutoSave 

feature. Select the Tools menu, then Options. Click the Save tab on 

the dialog box. Make sure the Save AutoRecover Info Every check 

box is selected. Use the minutes box to set the time interval 

between autosaves. This feature doesn't replace periodically saving 

your document using the Save command, but it will help you 

recover more of your document if there is a problem such as a 

power failure. I suggest setting AutoRecover to 10 or 15 minutes 

 

To save a document, follow these steps 



1. Click the Save button on the Word toolbar, or select the File 

menu and then Save. The first time you save your new 

document, the Save As dialog box appears. 

2. Type a filename into the File Name box. If you want to save 

the file in a format other than a Word document (.doc), such 

as a text file (.txt), click the Save As Type drop-down arrow 

and select a different file type. 

3. To save the file to a different location (the default location is 

My Documents), click the Save In drop-down arrow. After 

you select a particular drive, all the folders on that drive 

appear. 

4. Double-click the desired folder in the Save In box to open 

that folder. 

5. After you have specified a name and a location for your new 

document, select the Save button to save the file. Word then 

returns you to the document window. 

As you edit and enhance your new document, you should make a 

habit of frequently saving any changes that you make. To save 

changes to a document that has already been saved under a 

filename, just click the Save button. 

If you would like to keep a backup of a document (the version as it 

appeared the last time you saved it) each time you save changes to 

it, you need to set the backup option. 

1. Click the Tools command on the toolbar, and then select 

Options. 

2. In the Options dialog box, click the Save tab and then the 

Always Create Backup Copy check box. Click OK to return 

to the document. 

3. Name your file and save it for the first time to an appropriate 

location such as My Documents or another folder on your 

computer or your network. 



Now, when you use the Save command to save changes you've 

made to the document, a backup copy of the file (with the 

extension .wbk) is also saved. This backup copy is the previous 

version of the document before you made the changes. Each 

subsequent saving of the document replaces the backup file with 

the previous version of the document. 

Occasionally, rather than using the backup option, you might want 

to save the current document under a new filename or drive 

location. You can do this using the Save As command. To save 

your document with a new filename, follow these steps: 

1. Select File, Save As. 

2. In the Save As dialog box, type the new filename into the 

File Name box (make sure that you are saving the document 

in the desired path). 

3. Click Save. The file is saved under the new name 

Closing a Document 

When you have finished working with a document, you need to 

save your changes and then close the document. To close a 

document, select the File menu and then select Close. You can also 

close a document by clicking the Close (X) button on the right side 

of the document window. If you are working with multiple 

documents, closing one of the documents does not close the Word 

application. If you want to completely end your Word session, 

select the File menu, and then select Exit. Before closing a 

document, Word checks to see whether it has changed since it was 

last saved. If it has, Word asks whether you want to save these 

changes before closing. If you don't want to lose any recent 

changes, click Yes to save the document. 



Opening a Document 

Opening an existing document is a straightforward process. You 

will find that the Open dialog box shares many of the attributes 

that you saw in the Save As dialog box. 

To open an existing Word file, follow these steps 

1. Select the File menu, and then Open (or click the Open 

button on the Standard toolbar). The Open dialog box 

appears. 

2. By default, Word begins showing the files and folders in your 

My Documents folder. If the document you need is located 

elsewhere on your computer, click the Look In drop-down 

arrow to select the drive on which the file is located, and 

navigate to the folder containing the document you need. 

3. To open the file, click the file, and then click the Open button 

(you can also double-click the file). The file appears in a 

Word document window. 

If you are working with text files or documents that have been 

saved in a format other than the Word document format (.doc), you 

must select the file type in the Files of Type drop-down box to see 

them. 
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Copying, Cutting, and Pasting Text 

Copying or cutting text and then pasting the copied or cut item to a 

new location is very straightforward. All you have to do is select 

the text as we discussed earlier in this lesson and then invoke the 

appropriate commands. Use the following steps to copy and paste 

text in your document: 

1. Using the mouse or the keyboard, select the text that you 

want to copy. 

2. Select the Edit menu, and then select Copy, or press Ctrl+C 

to copy the text. 

3. Place the insertion point in the document where you want to 

place a copy of the copied text. 



4. Select the Edit menu and then select Paste, or press Ctrl+V. 

A copy of the text is inserted at the insertion point. 

After you paste your selected text, the Paste Smart Tag icon 

appears just below the text that you have pasted. When you click 

this icon, it provides a shortcut menu that allows you to keep the 

formatting that was applied to the source text that you copied, 

match the formatting supplied by the destination for the text (the 

paragraph you are placing the text in), or just paste the text into the 

new location with no formatting at all (which means it will assume 

the formatting that is provided at the current location). Figure 3.3 

shows the Paste Smart Tag provided for pasted text. 

Figure 3.3. The Paste Smart Tag allows you to choose how the 

text is pasted into the new location. 

 

 

What Are Smart Tags? Smart Tags are shortcuts that are 
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assigned to particular types of information in a Word 

document. For example, you will see that people's names 

are labeled with a smart tag (a purple dotted line below the 

text) that makes it easy to add a person to your Outlook 

Contact folder. Text that has been pasted to a new location 

is also flagged with a smart tag that makes it easy to format 

the pasted text. 

 

Cutting text from the document and then pasting it to a new 

location is every bit as straightforward as using copy and paste. 

Select the text, and then press Ctrl+X or click the Cut button on the 

Standard toolbar. Click the I-beam to place the insertion point on 

the document, and then you can use Ctrl+V or the Paste button on 

the Standard toolbar to place the text in a new location. A Paste 

Smart Tag will appear below the pasted text as shown in Figure 

3.3. 

Using the Office Clipboard to Copy and Move Multiple Items 

The Office Clipboard feature now resides in the task pane of your 

Office application windows as discussed in Lesson 3, "Using the 

Office Task Pane," which is found in Part I of this book. If you 

want to copy or cut more than one item and then be able to paste 

them into different places in the document, you must use the Office 

Clipboard. Follow these steps: 

1. To open the Clipboard task pane, select the Edit menu and 

select Office Clipboard. The Clipboard appears in the task 

pane. 

2. As shown in Figure 3.4, select and copy each item to the 

Clipboard. 

3. Figure 3.4. The Clipboard can hold up to 24 separate items. 
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1. After you have copied your items onto the Clipboard, place 

the insertion point where you want the first item to be pasted. 

Then, return to the Clipboard and with the mouse, point to 

your first item and click; Word automatically inserts the item 

into the document. 

2. Repeat step 3 as needed to paste other items from the 

Clipboard into your Repeat step 3 as needed to paste other 

items from the Clipboard into your document. 

 

 

 

 

 



 

 

Table 5.1. Font Attribute Shortcut Keys 

Attribute Shortcut Keys 

Bold Ctrl+B 

Italic Ctrl+I 

Underline Ctrl+U 

Double underline Ctrl+Shift+D 

Subscript Ctrl+equal sign (=) 

Superscript Ctrl+Shift+plus sign (+) 

Working in the Font Dialog Box 

Although the Formatting toolbar certainly provides the quickest 

avenue for controlling various font attributes, such as the font and 

the font size, you can access several more font attributes in the 

Font dialog box. The Font dialog box gives you control over 

common attributes, such as font, font size, bold, and so on, and it 

also provides you with control over special font attributes, such as 

superscript, subscript, and strikethrough. 

To open the Font dialog box, click the Format menu, and then 

select Font. The Font dialog box appears, 

Figure 5.2. The Font dialog box provides you with control over 

several font attributes not found on the Formatting toolbar. 



 

 

 

As you can see, the Font dialog box enables you to choose from 

several font attributes. You can control the font, the font style, and 

other character attributes such as strikethrough, superscript, and 

shadow. 

• To change the font, click the Font drop-down box and select 

the new font by name. 

• To change the font style to italic, bold, or bold italic, make 

the appropriate selection in the Font Style box. 

• To change the size of the font, select the appropriate size in 

the Size scroll box. 



• For underlining, click the Underline Style drop-down box 

and select an underlining style. 

• To change the color of the font, click the Font Color drop-

down box and select a new color. 

• To select any special effects, such as strikethrough, 

superscript, or shadow, select the appropriate check box in 

the lower half of the dialog box. 

As you make the various selections in the Font dialog box, a 

sample of what the text will look like appears in the Preview box at 

the bottom of the dialog box. After you have made all your 

selections in the Font dialog box, click OK. 

Aligning Text 

Another important basic attribute of the text in your documents is 

how that text is oriented on the page. When you first start typing in 

a new document, all the text begins at the left margin and moves to 

the right as you type; this means the text is left-justified using the 

default align left feature. Left-justified text is characterized by text 

that is straight or unvarying on the left margin but has a ragged 

right-edged margin. 

Text that serves a special function in a document, such as a 

heading, would probably stand out better in the document if it is 

placed differently than the rest of the text. Word makes it easy for 

you to change the alignment of any text paragraph. Several 

alignment possibilities are available: 

• Align Left— The default margin placement for normal 

text, aligned on the left. 

• Align Right— Text is aligned at the right margin and text 

lines show a ragged left edge. 

• Center— The text is centered between the left and right 

margins of the page (with both margins having irregular 

edges). 



• Justify— The text is spaced irregularly across each line so 

that both the left and the right margins are straight edged and 

uniform (often used in printed publications such as the daily 

newspapers). 

You can align the text in your document to suit your particular 

needs on a document page 

 

 

The easiest way to change the alignment of text in the document is 

to use the alignment buttons on the Formatting toolbar. Also, a 

button exists in the Paragraph dialog box for each of the alignment 

possibilities. 

These justification buttons can be used to align new text or 

selected text. Again, if you are typing new text with a particular 

justification, your selected justification will still be in force even 

after you press Enter. You must change the justification as needed. 



 

 

Examining Your Documents in Different Views 

In this lesson, you learn how to examine your document using the 

different document displays offered in Word. 

Changing the Document Display 

Word provides you with several viewing possibilities as you work 

on your documents in the Word application window. Each of these 

display modes provides a different look at your document. For 

example, the Normal view provides you with a look at all the font 

and paragraph formatting in the document, but does not give you a 

view of the document as it would appear on the printed page. 

Instead, the Print Layout view supplies this viewpoint. 

Using the different document views to your advantage can help 

you visualize and create great-looking documents in Word. Special 

views are even supplied for creating outlines and creating Web 

pages in Word. You take advantage of these different views using 

the View menu. Table 8.1 shows the various views available to 

you and describes, in general terms, for what they are best used. 

Table 8.1. The Word Views 

View Typical Use 

Normal Use for general word processing tasks. 

Web 

Layout 

Use for designing HTML documents and viewing Web 

pages. 

Print 

Layout 

Use for document layout and documents containing 

graphics and embedded or linked objects. 
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Table 8.1. The Word Views 

View Typical Use 

Outline Use to view document as an outline. 

Reading 

Layout 

Allows you to view the document in a side-by-side 

screen view. This is a view mode only, so you cannot 

edit the text when in this view. 

Full 

Screen 

Use when you want to use the entire screen to view the 

document and avoid seeing the toolbars and other 

marginal information. 

The Normal View 

The Normal view provides you with a view that is perfect for most 

word processing tasks. It is the default view for Word; to change to 

the Normal view (from any of the other views), select View, and 

then Normal. 

Switch to Normal with a Click You can also change from 

view to view in Word using the View toolbar in the lower-

left corner of the Word window. To go to the Normal view, 

click the Normal icon. 

 

This view displays character and paragraph formatting that you 

place in the document (see Figure 8.1). Normal view, however, 

does not display the document headers and footers or show 

graphics in the document as they will print. Also, items created 

using the Drawing toolbar are not displayed in the Normal view. 

Figure 8.1. The Normal view shows all the formatting in the 

document but does not show graphics, margins, and other special 

elements as they will appear on the printed page. 
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In the Normal view, you see the following: 

• Page breaks appear as dashed lines. 

• Headers and footers are displayed in the header/footer-editing 

area and you are temporarily switched to the print Layout 

(when Header and Footer is selected on the View menu). 

Only the header or footer can be edited at this point. When 

you close the Header and Footer toolbar you are returned to 

the Normal view. 

• Footnotes and endnotes are displayed in a footnote or 

endnote editing area (when Footnotes is selected on the View 

menu). Only the footnote or endnote can be edited at this 

point. 

• Margins and column borders are not displayed in this view. 

Web Layout View 

The Web Layout view is perfect for designing HTML documents 

that you want to use as Web pages. The Web Layout view displays 



your document as it would appear in your Web browser window. 

To switch to the Web Layout view, select View, and then Web 

Layout. 

HTML Hypertext Markup Language—This document format is 

used for the creation of Web pages for the World Wide Web. The 

special document format is read using a Web browser or some 

other application (such as Word) that can display HTML 

documents. 

In the Web Layout view, text is wrapped to fit in the window 

and graphics are placed as they will appear onlinePrint Layout 

View 

The Print Layout view shows your document exactly as it will 

appear on the printed page. Working in this view allows you to 

fine-tune your document and work with graphic placement and text 

formatting as you prepare your document for printing. 

To switch to the Print Layout view, select View, Print Layout. This 

view enables you to view headers, footers, footnotes, endnotes, and 

the margins in your document. Graphics are also positioned and 

sized as they will appear on the printed page. Figure 8.3 shows the 

same document that appeared earlier in Figure 8.1. Notice that in 

the Page Layout view, the margins of the document and (more 

importantly) a graphic in the document appear. 

Print Layout View 

The Print Layout view shows your document exactly as it will 

appear on the printed page. Working in this view allows you to 

fine-tune your document and work with graphic placement and text 

formatting as you prepare your document for printing. 

To switch to the Print Layout view, select View, Print Layout. This 

view enables you to view headers, footers, footnotes, endnotes, and 
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the margins in your document. Graphics are also positioned and 

sized as they will appear on the printed page. Figure 8.3 shows the 

same document that appeared earlier in Figure 8.1. Notice that in 

the Page Layout view, the margins of the document and (more 

importantly) a graphic in the document appear. 

Outline View 

The Outline view allows you to create and edit your document in 

an outline format. Using the Word built-in heading styles is the key 

to creating the document in this view (for more about styles, see 

Lesson 10, "Working with Styles"). Each heading (Heading 1, 2, 3, 

and so on) is treated as a different level in the outline. For 

example, a heading assigned the Heading 1 style would be a Level 

1 heading in the outline. You can promote and demote headings 

using the appropriate buttons on the Outline toolbar (a special 

toolbar that appears when you are in Outline view). 

The Outline toolbar also provides an Outline Levels drop-down 

box that allows you to quickly change the level of the text where 

the insertion point currently resides. These levels coincide with 

different styles used by the outline feature. For example, Level 1 is 

equivalent to the Heading 1 style. 

You can also collapse and expand the outline to better organize 

your document. Collapsing the document to all Level 1 Headings 

allows you to ignore the body text in the document and concentrate 

on the overall organization of the document. 

Move a Heading and Associated Text You can drag a heading to a 

new position, and the subheading and body text associated with the 

heading move to the new position as well. This makes it very easy 

for you to reorganize the text in your document. 
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Reading Layout 

A new view that has been added to Word is the Reading Layout 

view. This view splits the window into two side-by-side panes. 

Each pane shows one document screen (it does not show an entire 

page 

You can advance through the document screen by screen using the 

Page Down button on the vertical scrollbar. You can view 

thumbnails of each document screen by clicking the Thumbnails 

button provided on the Reading Layout toolbar. To quickly read 

one of the thumbnails provided, click the thumbnail and it and the 

preceding screen will appear in the Reading window. 

Although you cannot edit the text in the Reading Layout view, it 

does allow you to read the text in a document and quickly advance 

from screen to screen. When you have completed reading the text 

in the document, click the Stop Reading button on the toolbar to 

return to the previously selected view (such as Normal or Print 

Layout). 

Using the Full Screen View 

In situations where you want to concentrate on the text and other 

items in your document, it is great to be able to clear all the visual 

clutter from the screen (toolbars, scrollbars, and other Word tools) 

and view only your document. For example, you might be 

proofreading a particular page and want to place as much of the 

page's text on the screen as you can. You can switch to a view 

where your document occupies all the space available on the 

screen. Select View, Full Screen. 

You can still add or edit the text in your document when you are in 

the Full Screen view. You can also quickly return to the previous 

view you were using (such as Normal view or Print Layout view) 

before you switched to the Full Screen view. Click the Close Full 



Screen box that appears in the document window and you return to 

the previous view 

Zooming In and Out on Your Document 

You can use the Zoom command to zoom in and out on your 

documents. This allows you to increase the magnification of items 

on the page, such as small fonts, or to step back (zoom out) from 

the document to view its general layout. 

You can use Zoom in any of the Word views (except the Reading 

Layout view). In Normal, Print Layout, Web Layout, and Outline 

views, the effect of zooming in or out just changes the 

magnification of the onscreen elements. When you use Zoom on 

the Print Layout view, you get a very good look at how the 

document is laid out on the printed page. 

To zoom in or out on your current document, select View, 

Zoom. The Zoom dialog box appears  

Figure 8.6. The Zoom dialog box can be used to change the 

current zoom level of your document. 



 

A series of option buttons is used to change the zoom setting for 

the current document. When you click a particular option button 

(such as the 200% option button), you see a preview of this 

magnification in the Preview box. 

You can also set a custom zoom level in the Percent box. Use the 

click arrows in the box to increase or decrease the current zoom 

percentage. When you have selected the zoom level for the current 

document, click OK. 

View Multiple Pages on Your Screen When you are in the Print 

Layout view, you can use the Zoom dialog box to view two or 

more pages at the same time. Click the Many Pages option button 

(when in Zoom option), and then click the Computer icon below 

the option button. Drag over the page boxes to select the number of 

pages you want to display, and then click OK. 



Working with the Document Map 

The Document Map view is somewhat similar to the Outline view 

in that it gives you a quick reference to the overall structure of 

your document. A special pane appears in the document window 

(on the left) that shows the headings in your document. You can 

use the Document Map to quickly move from one area of a 

document to another by clicking the appropriate heading. 

To open the Document Map, select View, Document Map; the 

map pane appears in the document window (see Figure 8.7). 

You can change the width of the document map pane by placing 

the mouse on the border between the pane and your document. 

The mouse arrow changes to a sizing tool—a double-headed 

arrow. Drag the sizing tool to create a custom document map 

width. 

Splitting the Document Window 

Another useful way to view your documents is to split the current 

document window into two panes. This allows you to view the 

same document in both panes, which is particularly useful when 

you want to view two different parts of the same document. 

You can use the two panes to drag and drop information from one 

part of a document into another. Remember that changes you make 

in either of the split panes will affect the document. 

To split the document screen into two panes, select Window, Split. 

A horizontal split appears across the document window. Notice 

that as you move the mouse in the document window, the split bar 

moves with it. Place the mouse where you want to split the 

document window, and then click the left mouse button. 
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A set of vertical and horizontal scrollbars appears for each pane 

in the split window (see Figure 8.8). Use the scrollbars in each 

pane as needed 

Figure 8.8. You can split the document screen to view different 

areas of a long document. 

 

 

When you have finished working in the split document window, 

select Window, and then Remove Split. The splitter bar is 

removed from the document 
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Working with Margins, Pages, and Line Spacing 

In this lesson, you learn how to set margins, insert page breaks into 

your documents, and control line spacing and line breaks in your 

documents 

Setting Margins 

Margins control the amount of white space between your text and 

the edge of a printed page. Four margins—Left, Right, Top, and 

Bottom—can be set for your pages. The default margin settings for 

documents based on the Word Normal template are shown in Table 

9.1. 

 

Table 9.1. Default Margin Settings for the Normal Template 

Margin Setting (in Inches) 

Left 1.25 

Right 1.25 

Top 1 

Bottom 1 

You can change any of the margin settings for your document or a 

portion of your document at any time. The Page Setup dialog box 

provides you with access to all these margin settings. You also 

have control over how your margins affect the layout of multiple 

pages in a document. For example, you can set up your pages to be 

laid out in book folio fashion (two pages arranged horizontally on 

each piece of paper) or two pages per sheet arranged vertically. 

To change the margin settings for your document, follow these 

steps: 
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1. Select File, Page Setup. The Page Setup dialog box appears 

as shown in Figure 9.1. 

Figure 9.1. Use the Margins tab of the Page Setup dialog 

box to set your document margins and arrange them on 

multiple pages if necessary. 

 

 

 

1.  

Margins Can Be Different for Different Parts of the 

Document You can set different margin settings for 
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different portions of your document. The easiest way to do 

this is to divide your document into sections. Each section 

can then have a different set of margins. For information on 

creating sections in your documents, see Lesson 20, 

"Working with Larger Documents." 

2.  
 

3. Click the Margins tab if necessary. Use the click arrows in 

the Top, Bottom, Left, or Right margin boxes to increase or 

decrease the current setting. Or double-click in any of the 

boxes and type in a new value. 

Maximum and Minimum Margins Be advised that your printer 

defines the minimum margins for a page. For example, most inkjet 

printers limit you to a minimum top and bottom margins of .25" 

and .5", respectively, and left and right margins of .25". If you set 

margins less than the minimum, a dialog box appears when you 

close the Page Setup dialog box, letting you know that your 

margins are outside the printable area of the page. Click the Fix 

button on this dialog box to set the margins to the minimum for 

your printer. For maximum margins, Word notifies you by a dialog 

box if you select margins that overlap or negate any usable space 

on the page. 

1. After you have selected the new margin settings, you can 

apply the margins to the entire document, to a section of the 

document (this option is available only if you have more than 

one section in the document), or to the document from the 

current page forward in the document. Using the last choice 

allows you to have different margin settings in the same 

document without requiring you to divide the document into 

sections (for more about sections, see Lesson 20). Click the 

Apply To drop-down box and select Whole Document (the 
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default setting), This Point Forward, or This Section (if 

available). 

2. After you have finished selecting your new margin settings 

and the amount of the document that they will affect, click 

OK. 

The new margins take effect in your document. The best way to 

view how these margins will look when you print the document is 

to switch to the Print Layout view (if you are not already in this 

view). Select View, Print Layout. The margins you've selected 

appear on the top, left, right, and bottom of your document in the 

Word document window. 

When you are in the Print Layout view, you can also adjust the 

margins in your document using the Ruler. To view the Ruler, 

select View, Ruler. The vertical ruler is visible in the Print Layout 

View only. 

In the Print Layout view, horizontal and vertical rulers appear in 

the document window. The margins appear as shaded areas on the 

edge of the respective ruler. For example, the left margin is a gray-

shaded area on the left side of the horizontal ruler (see Figure 9.2). 

Figure 9.2. Drag the respective margin-sizing arrow to increase 

or decrease a margin. 
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To adjust a margin, place the mouse pointer between the gray 

margin and the white document area on the ruler. A margin-sizing 

arrow appears. Drag the gray margin to increase or decrease the 

respective margin. Figure 9.2 shows the margin-sizing arrow on 

the top margin on the vertical ruler. 

Controlling Paper Types and Orientation 

Other page attributes that you need to control in your documents 

are the paper size and the page orientation. Word's default settings 

assume that you will print to paper that is a standard 8.5 by 11 

inches. The default page orientation is portrait, meaning that the 

maximum distance from the left edge to the right edge of the page 

is 8.5 inches. 

You can select different paper sizes, which is particularly 

important if you want to print to envelopes or a different paper 

size, such as legal-size paper. You can also change the orientation 

of your text and images as they appear on a page from portrait to 
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landscape, where the page contents are rotated so that the distance 

between the left and right edges on a standard sheet of paper would 

be 11 inches. 

Paper size and page orientation are both set in the Page Setup 

dialog box. Follow these steps to edit the settings for these page 

attributes: 

1. Select File, Page Setup. The Page Setup dialog box opens. 

2. Click the Paper tab on the dialog box (see Figure 9.3). 

3. Figure 9.3. The Paper tab of the Page Setup dialog box 

enables you to set your paper size and source. 
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1. To select a new paper size, click the Paper Size drop-down 

box and select the paper type. For nonstandard paper sizes, 

select Custom Size in the Page Size box, and then type the 

paper's width into the Width box and its height into the 

Height box. 

2. To change the orientation of the page to portrait or landscape, 

select the Margins tab and click the Portrait or the Landscape 

option button as needed (refer to Figure 9.1). 

3. Finally, in the Apply To drop-down box, select Whole 

Document to apply the new settings to the new document or 

This Point Forward to apply the settings to the document 

from the current page forward. 

4. When you complete editing the settings, click OK. 

 

 

Inserting Page Breaks 

As you create your document, Word automatically starts a new 

page when you fill the current page with text or other document 

items (such as graphics, tables, and so on). However, you can 

insert your own page breaks in the document as needed. These 

types of page breaks are often referred to as hard, or manual, page 

breaks. 

To insert a page break into your document, follow these steps: 

1. Place the insertion point in the document where you want to 

force a page break. 

2. Select Insert, Break. The Break dialog box appears. 

3. Make sure the Page Break option button is selected, and then 

click OK. 
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A page break is placed in your document. In the Normal view, the 

page break appears as a dashed line across the page, with "Page 

Break" denoted at the center of the line. In the Print Layout view, 

you can move to the new page by clicking the Next Page button on 

the bottom of the vertical scrollbar. 

To remove a page break, switch to the Normal view (select View, 

Normal). The page break appears as a dotted line in the document 

and is denoted as a "page break." Select the page break with a 

mouse and press Delete to remove it. 

Changing Line Spacing 

Another setting that greatly influences the amount of whitespace 

on the page is line spacing. When you consider whether you want 

your text single-spaced or double-spaced, those text attributes are 

controlled by changing the line spacing. 

Line spacing can be set for each paragraph in the document or for 

selected text. Setting line spacing for a blank document allows you 

to set a default line spacing for all text paragraphs that will be 

placed in the document. 

To set the line spacing for a new document, a paragraph, or 

selected text, follow these steps: 

1. Select the Line Spacing drop-down arrow on the Formatting 

toolbar. A list of line spacing possibilities such as 1.0, 1.5, 

2.0, and so on will appear. Select the line spacing you want to 

use. 

2. (optional) If you want to set a custom line spacing, select 

More from the Line Spacing button's drop-down list. The 

Paragraph dialog box appears (see Figure 9.4) with the 

Indents and Spacing tab selected. 

3. Figure 9.4. The Indents and Spacing tab allows you to fine-

tune the line spacing for your text. 
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1. (optional) To change the line spacing on the Indents and 

Spacing tab, click the Line Spacing drop-down box and 

select one of the following choices: 

o Single— Spacing accommodates the largest font size 

found on the lines and adds a small amount of 

whitespace (depending on the font used) between lines. 

o 1.5— The line spacing is 1 and 1/2 times greater than 

single spacing. 

o Double— Twice the size of single line spacing. 

o At Least— (The default setting) line spacing adjusts to 

accommodate the largest font on the line and special 

items, such as graphics. 



o Exactly— All lines are equally spaced, and special font 

sizes or items such as graphics are not accommodated. 

These items, if larger than the setting used here, appear 

cut off in the text. You can still accommodate these 

items by using the Multiple box (described next) to 

shift all the text lines to a higher spacing percentage 

that accommodates special items. 

o Multiple— You specify the line spacing by a particular 

percentage. This feature is used in conjunction with the 

Exactly option to set a line spacing percentage that 

accommodates special font sizes or graphics found in 

the document. For example, if you want to decrease the 

line spacing by 20%, you enter the number 0.8. To 

increase the line spacing by 50%, you enter 1.5. 

2. The Line Spacing option selected in step 3 is influenced by 

the point size entered in the At box (this applies only when 

you have selected At Least, Exactly, or Multiple). Use the 

click arrows to increase or decrease the point size of the line 

spacing, if needed. 

When you complete setting the line spacing parameters, click 

OK. 

 

Using AutoFormatting to Change Text Attributes 

In this lesson, you learn how to quickly change the look of your 

text with AutoFormat and apply text attributes automatically as 

you type. 

Understanding AutoFormatting 

AutoFormat is a great feature that helps you create professional-

looking documents. AutoFormatting actually examines the text 

elements that you have placed in your document (such as headings, 



tables, lists, regular body text, and other items) and then 

automatically formats these elements using an appropriate Word 

style. Even though this formatting is automatic, you can accept or 

reject the changes AutoFormatting makes. You can also make 

additional changes to the document as you see fit by using other 

styles or font and paragraph formatting attributes (for more about 

styles, see Lesson 10, "Working with Styles"). 

You will also find that AutoFormat does more than just apply 

styles to your document elements. It can remove extra paragraph 

breaks between paragraphs and apply the hyperlink styles to e-mail 

addresses or Web addresses that you place in your documents. 

You can use AutoFormat in two ways. You can turn on 

AutoFormatting so that items are formatted as you type, or you can 

create a new document and then use AutoFormat to format the 

entire document at once. 

Formatting As You Type 

You can have your document elements formatted as you type. 

However, this feature requires that you supply Word with certain 

cues so that the correct formatting is applied to the text. For 

example, if you turn on AutoFormat As You Type and want to 

create a bulleted list that is automatically formatted by the 

AutoFormat feature, you must begin the bulleted line with a dash, 

an asterisk, or a lowercase "o" so that Word knows to apply the 

bulleted list formatting. 

Many AutoFormat As You Type features are enabled by default, 

although others are not. To customize the AutoFormat As You 

Type feature, follow these steps: 

1. Select Tools, then AutoCorrect Options. The AutoCorrect 

dialog box appears. 
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2. Select the AutoFormat As You Type tab on the dialog box 

(see Figure 11.1). 

Figure 11.1. Use the AutoFormat As You Type tab to select the 

automatic formatting options. 

 

 

1. A series of check boxes on the AutoFormat As You Type tab 

allows you to select which document elements will be 

formatted as you type. Again, you need to type certain 

characters for a particular element so that the AutoFormat 

feature recognizes and then formats the text. Some of the 

most often used AutoFormat possibilities are as follows: 
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o Automatic Bulleted Lists— Select this check box to 

create bulleted lists automatically. Start each line in the 

list with an asterisk (*), a dash (-), or a lowercase "o." 

o Automatic Numbered Lists— Select this check box to 

create numbered lists. When you start a line with a 

letter or number, it is turned into a numbered list item. 

If the Format Beginning of List Item Like the One 

Before It check box is selected, paragraphs following 

the first numbered line are numbered sequentially. 

o Built-In Heading Styles— Select this check box to have 

all headings that you apply to an outline or a legal 

document be automatically assigned the appropriate 

built-in heading style (using Headings 1–9). 

o Border Lines— Select this check box to have borders 

automatically placed between paragraphs. You must 

type three dashes (-) for a thin border, three underscores 

(_) for a bold line, or three equal signs (=) for a double-

line border. 

o Tables— Select this check box to automatically create 

tables. You must type a series of plus symbols (+) and 

dashes (-) to signify the number of columns (+) and the 

distance between the columns (-). 

Other AutoFormatting check boxes include features that 

format your quotation marks, ordinals (1st), and fractions 

(1/2). Select (or deselect) the various AutoFormat As You 

Type options and then click OK to close the dialog box. 

Although formatting as you type might seem like a real timesaver, 

you must remember which special characters to use to 

automatically begin a particular formatting type. 

Applying AutoFormat to a Document 

The alternative to AutoFormatting as you type is to create the 

document and then format it after the fact with AutoFormat. 



Waiting to format a document until after its completion allows you 

to concentrate on the document content as you type. You then can 

concentrate on the look and feel of the document by selecting from 

the various AutoFormatting options. Heads, numbered or bulleted 

lists, and other items you have designated throughout the text are 

identified and formatted. 

To AutoFormat a document, follow these steps: 

1. Make sure that you are in the Print Layout view (select View, 

then Print Layout; this allows you to see the various 

formatting tags applied to the document when you review the 

autoformat changes; see Lesson 8, "Examining Your 

Documents in Different Views,"for more information). Select 

Format, then AutoFormat. The AutoFormat dialog box 

appears 

Figure 11.2. The AutoFormat dialog box allows you to 

immediately format the document or review each of the 

suggested formatting changes 

 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch44.html#ch44


1. You can increase the accuracy of the formatting process by 

choosing a particular document type. Click the General 

Document Type drop-down arrow and select from the 

document types listed on the drop-down list (the default 

setting is General Document; you can also select Letter or 

Email as the document type from the list). 

2. Now you can AutoFormat the document. If you want to 

AutoFormat the current document without reviewing the 

formatting changes, click the AutoFormat Now radio button 

and then click OK. The document is automatically formatted. 

3. If you want to review the AutoFormatting process after the 

changes are made, click the AutoFormat and Review Each 

Change radio button. Then click OK. 

 

 

Adding Document Text with AutoText and Using Special 

Characters 

In this lesson, you learn how to quickly add repeating text elements 

to your documents using the AutoText feature. You also learn how 

to add special characters to your document, such as the copyright 

symbol 

Understanding AutoText 

AutoText provides you with a way to build a library of words and 

text phrases that you use often in your documents. AutoText makes 

it easy for you to quickly insert items from your AutoText list into 

any document. Creating AutoText entries is also very 

straightforward. An AutoText entry can consist of a company 

name, your name, or an entire paragraph that you commonly place 

in your documents. 



Creating AutoText Entries 

You can create an AutoText entry using text from an existing 

document, or you can type the text that you want to add to the 

AutoText list in a blank document. Then it's just a matter of 

copying the text to your AutoText list. 

To create an AutoText entry, follow these steps: 

1. Type the text you want to use for the AutoText entry or open 

the document containing the text that will serve as the 

AutoText entry. 

2. Select the text. 

3. Select the Insert menu, point at AutoText, and then select 

New from the cascading menu. The Create AutoText dialog 

box appears as shown in Figure 12.1. 

Figure 12.1. Creating the Wally's AutoText saves you from 

typing Wally's Friendly Fish Market. 

 

1. Type the name that you want to use to retrieve this AutoText 

entry in the text box provided (for one-word text entries, the 

selected text can also serve as the entry name). 

2. After providing the name for the AutoText entry, click OK. 

Your selected text is added to the AutoText list. You can repeat 

this procedure and add as many text items to the AutoText list as 

you want. 
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Inserting AutoText Entries 

After you add an AutoText entry or entries to the list, you can 

insert them into any Word document. One method of inserting an 

AutoText entry into the current document is to pull the entry 

directly from the AutoText list. 

To insert an AutoText entry into a document, follow these steps: 

1. Place the insertion point in the document where you want to 

insert the AutoText entry. 

2. Select the Insert menu, point at AutoText, and then select 

AutoText. The AutoCorrect dialog box appears as shown in 

Figure 12.2 (with the AutoText tab selected). 

Figure 12.2. Insert your AutoText entries from the 

AutoCorrect dialog box. 
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1. The AutoText tab of the AutoCorrect dialog box displays an 

alphabetical list (as well as various default entries that Word 

provides) of the AutoText entries that you have added to the 

AutoText list. Select the entry you want to insert and click 

Insert. Or double-click any entry on the list to insert it into 

the document. 

Deleting AutoText Entries 

You can easily delete items on the AutoText list when you no 

longer need them. This is done on the AutoText tab of the 

AutoCorrect dialog box. 



To delete an AutoText entry, follow these steps: 

1. Select the Insert menu, point at AutoText, and then select 

AutoText from the cascading menu. The AutoCorrect dialog 

box appears. 

2. Select any of the entries in the AutoText list. 

3. Click Delete to remove the entry from the list. 

After you have completed your deletion of AutoText entries, click 

OK to close the AutoText dialog box. 

Using Special Characters and Symbols 

Special characters and symbols are characters that can't be found 

on your keyboard and that are not part of what is considered to be 

the standard character set. Characters such as the German "u" with 

an umlaut (ü) are special characters, and an item such as the 

trademark is an example of a symbol. 

Many special characters and symbols exist. Table 12.1 lists some 

of the commonly used special characters and symbols. 

Table 12.1. Common Special Characters and Symbols 

Special 

Character or 

Symbol 

Use 

Copyright 

symbol © 

Used in a copyright notice in a document. 

Trademark 

symbol ™ 

Placed to the right of official trademarks placed 

in a document. 

Em dash — Used to bracket asides or sudden changes in 

emphasis in a sentence—rather than using a 

comma. It appears as a long dash. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch48lev1sec2.html#ch48table01#ch48table01


Table 12.1. Common Special Characters and Symbols 

Special 

Character or 

Symbol 

Use 

En dash – Slightly shorter than an em dash, this dash is 

commonly used to separate numbers from 

capital letters, such as Figure B–1. 

Wingdings A group of special icons that can be used in 

your documents for emphasis or as bullets. 

Foreign language 

font (á) 

Characters that include special accents. 

The basic special characters and symbols are held in three groups: 

• Symbol— This group contains mathematical symbols, 

arrows, trademark and copyright symbols, and letters from 

the Greek alphabet. 

• Normal Text— This group provides you with special 

characters containing accents and other special marks. 

• Wingdings— Special icons and symbols for many purposes. 

Additional special character sets might be available to you, 

depending on which fonts have been installed on your computer 

(you can purchase software with unique fonts and symbols, as 

well). 

Adding Headers, Footers, and Page Numbers 

In this lesson, you learn how to add headers, footers, and page 

numbers to your documents. 



Understanding Headers and Footers 

Another aspect of creating a document is using headers and footers 

to insert information that you want repeated on every page of the 

document or in the pages of a particular document section. 

Header The header resides inside the top margin on the page; it 

holds information such as the date or draft number that appears at 

the top of every page of the document. Every section of a 

document could potentially have a separate header. 

Footer The footer resides inside the bottom margin of the page; it 

holds information such as the page number or other information 

that appears at the bottom of every page of the document. Every 

section of a document could potentially have a separate footer. 

Headers and footers provide you with a way to include a document 

title, the current date, or the current page number on the top or 

bottom of each page in the document. Headers can include text, 

graphics, or other items. 

Adding Headers and Footers 

You can add a header or footer to a document in any view. To add 

a header or footer, follow these steps: 

1. Select View, Header and Footer. You are temporarily 

switched to the Print Layout mode and placed in the header 

area of the document (see Figure 13.1). The regular text area 

is dimmed and unavailable while you work in the header or 

footer box. 

Figure 13.1. The header area of the page is where you type your 

header text. The Header and Footer toolbar provides you with 

tools to insert page numbers, the date, and to switch between 

your headers and footers. 
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1. Type your text into the header area. If you want to create a 

footer, click the Switch Between Header and Footer button 

on the Header and Footer toolbar, which is also available in 

the document window. 

2. You can add a page number, the current date, the current 

time, and other elements using the appropriate buttons on the 

Header and Footer toolbar (see Table 13.1). 

3. When you need to align or format the text, use the 

appropriate buttons on the Word Formatting toolbar (while in 

the header/footer areas) as you would for text on the 

document page. 

4. When you have finished entering your header and footer text, 

click the Close button on the Header and Footer toolbar. 

You are returned to your document text. In the Normal view, you 

are not able to see your header or footer. In the Print Layout view, 

however, header and footer text appears dimmed. 
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You can edit your headers and footers by selecting View, Header 

and Footer. Move to the appropriate header or footer using the 

navigation buttons on the Header and Footer toolbar shown in 

Table 13.1. To quickly enter a header or footer box, in the Print 

Layout view double-click the header or footer text. 

Table 13.1. The Header and Footer Toolbar Buttons 

Button Purpose 

 Inserts the page number 

 Inserts the page count or number of total pages 

 Edits the format of the page number 

 Inserts the current date 

 Inserts the current time 

 Opens the Page Setup dialog box to the Layout tab, where 

you can change the header and footer settings 

 Hides the document text while you work on your header 

and footer 

 Sets up the next header the same as the current header (or 

footer) 

 Switches between your header and footer 

 Moves to the previous header or footer in the document 

 Moves to the next header or footer in the document 

Several toolbar choices, such as Same As Previous and Move to 

Previous or Next (header or footer) relate to documents that have 

several sections and so have different headers or footers within the 

same document. You can also have more than one header or footer 

in the document if you choose to have different headers or footers 

for odd- and even-numbered pages. 
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Adding Page Numbering to a Document 

Headers and footers enable you to place repeating information in 

your documents, including the date, other important text, and most 

important—page numbers. When you want to place only page 

numbers on your document pages, you can skip the Header and 

Footer command and quickly add page numbers using the Insert 

menu. 

To place page numbers in your document, follow these steps: 

1. Select Insert, Page Numbers. The Page Numbers dialog box 

appears (see Figure 13.3). 

Figure 13.3. Use the Page Numbers dialog box to select the 

position and alignment of page numbers in your document 

 

1. To select the position for your page numbers, select the 

Position drop-down arrow and select Top of Page (Header) or 

Bottom of Page (Footer). 

2. You can select the alignment for the page numbers using the 

Alignment drop-down box. Select Center, Left, or Right to 

position the page numbers. When you are using mirror 

margins on a document that will be printed on both sides of 

the paper, select Inside or Outside (relative to a central 

binding, like that of a book) to position your page numbers. 
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3. To select the format for your page numbers, click the Format 

button. The Format dialog box appears. 

4. Use the Page Number Format drop-down box (shown in 

Figure 13.4) to choose the format for your page numbers 

(Arabic numerals—1, 2, 3—is the default). When you have 

selected your number format, click OK to return to the 

Format dialog box. 

Figure 13.4. Use the Page Number Format drop-down box 

to choose the format for your page numbers 

1. To have the page numbering start on a specific page in the 

document, click the Start At option button and then use the 

spinner box to specify the page number. 

2. Click OK to close the Page Number Format dialog box. 

The page numbers are placed in the header or footer of your 

document according to your positioning and formatting choices. 

You can edit the page numbers and add text if you want by 

selecting View, Header and Footer. 

Printing Documents 

In this lesson, you learn how to preview your documents and then 

print them. 

Sending Your Document to the Printer 

When you have finished a particular document and are ready to 

generate a hard copy, Word makes it easy for you to get your 

document to the printer. In fact, you have three choices: 

• You can send the document directly to the printer (no 

questions asked) by clicking the Print button on the Standard 

toolbar. 
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• You can open the Print dialog box (select File, Print) and set 

any print options that you want, such as printing a particular 

range of pages or printing multiple copies of the same 

document. 

• You also have the option of previewing your hard copy 

before printing. This enables you to view your document 

exactly as it will appear on the printed page. 

To preview your document before printing, click the Print 

Preview button on the Word Standard toolbar. The Print 

Preview window opens for the current document (see Figure 

14.1). 

• Figure 14.1. The Print Preview mode enables you to view 

your document the way it will print. 

 

You will find that the Print Preview window provides several 

viewing tools that you can use to examine your document before 

printing. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch50lev1sec1.html#ch50fig01#ch50fig01
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch50lev1sec1.html#ch50fig01#ch50fig01


• Zoom In or Out— In the Print Preview window, the 

mouse pointer appears as a magnifying glass. Click once on 

your document to zoom in, and then click a second time to 

zoom out. To turn this feature off (or on again), click the 

Magnifier button. 

• Zoom by Percentage— You can change to different 

zoom levels on the current document by using the Zoom 

drop-down arrow. 

• View Multiple Pages— You can also zoom out and view 

several pages at once in the Preview window. Click Multiple 

Pages, and then drag to select the number of pages to be 

shown at once. 

• Shrink to Fit— If you have a two-page document and only 

a small amount of text appears on the second page, you can 

condense all the text to fit on the first page only; click the 

Shrink to Fit button. 

When you have completed viewing your document in the Print 

Preview mode, you can click the Print button to print the 

document, or if you want to edit the document before printing, 

click the Close button on the toolbar. 

Changing Print Settings 

In some situations, you might want to print only the current page 

or a certain range of pages. These options are controlled in the 

Print dialog box. The Print dialog box supplies you with several 

options, including the printer to which you send the print job, the 

number of copies, and the page range to be printed. 

To open the Print dialog box, select File, then Print. The Print 

dialog box is shown in Figure 14.2. 

Figure 14.2. The Print dialog box gives you control over the 

options for your document. 
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Depending on your home or office situation, you might have your 

computer connected to more than one printer (especially if you are 

on a network). The Print dialog box has a drop-down box that lists 

all the printers to which you have access. To select a printer other 

than the current printer, click the drop-down arrow in the Name 

box and choose your printer from the list. 

The Print dialog box also enables you to select the range to be 

printed. This range can consist of a page, a group of specific pages 

in a sequence, or all the pages in the document. 

• All Pages— To print all the pages in the document, make 

sure the All option button is selected. 

• Current Page— To print a single page, click the Current Page 

option button (this prints the page that the insertion point is 

parked on). 



• Page Range— To designate a range of pages, click the Pages 

option button and type the page numbers into the Pages box. 

 

Specifying Page Ranges To print a continuous range 

of pages, use the 1–5 format (where 1 is the start and 

5 is the end of the range). For pages not in a 

continuous range, use the 5,9,13 format (where each 

distinct page number to be printed is separated by a 

comma). You can also mix the two formats. For 

example, you could specify 1–5,9,13. 

•  

• Number of Copies— In the Copies area of the Print dialog 

box, use the increment buttons in the Number of Copies box 

to select the number of copies you want to print. You can 

also double-click inside the Number of Copies box and type 

in a particular value for the number of copies you want. 

• Collate— In addition to specifying the number of copies, you 

can select whether to collate your document by checking the 

Collate box in the copies area. Collate means that the 

document is printed in the proper order for stapling or 

binding. 

For example, a 10-page document would be printed from 

page 1 through 10 and then the subsequent copies would also 

print in this "collated" arrangement. If you do not choose to 

collate, all the copies of page 1 will be printed, then page 2, 

and so on. 

You can also choose to print all the pages in a chosen range or 

print only the odd or even pages. Click the Print drop-down box 

(near the bottom left of the dialog box) and select All Pages in 

Range, Odd Pages, or Even Pages, as required. 

Another print option worth mentioning is the Zoom print option in 

the Print dialog box. This feature enables you to place several 



document pages on one sheet of paper. To use Zoom print, click 

the Pages per Sheet drop-down box in the Zoom area of the Print 

dialog box and select the number of document pages you want to 

place on a sheet of paper. To select a scale for the print job (the 

scale is the relative size of the mini-pages on the printout page, 

such as 8.5 by 11 inches or legal size), click the Scale to Paper Size 

drop-down box. 

After you select these two options, proceed with your print job. Be 

advised, however, that the more pages you place on a single sheet, 

the smaller the text appears. 

Finally, you can print special items that you have placed in your 

document, such as comments, styles, and AutoText entries. When 

you choose to print one of these items, you are supplied with a 

page or pages separate from the main document that lists the 

comments, styles, or other items you've selected. 

Select the Print What drop-down arrow and select from the list of 

items as follows: 

• Document— Prints the document. 

• Document Properties— Prints a summary of the information 

found in the document properties dialog (click File, 

Properties). 

• Document Showing Markup— Shows the document with 

markup from tracking changes by multiple authors. 

• List of Markup— Prints a list of changes added to a 

document involving multiple authors. 

• Styles— Lists the styles in the document. 

• AutoText Entries— Provides a list of the AutoText entries in 

the document. 

• Key Assignments— Shows the shortcut key assignments for 

the document. 



If you want to print more than one of these optional items with the 

document printout, you must select them in the Print options dialog 

box 

 

 

Creating Numbered and Bulleted Lists 

In this lesson, you learn how to create and edit numbered and 

bulleted lists. 

Understanding Numbered and Bulleted Lists 

You can add emphasis to a list of points or delineate a list of items 

in a document by adding numbers or bullets to the items in the list. 

Numbered lists are great for steps or points that should be read in 

order. Bulleted lists work best when you want to separate and 

highlight different items or points in a list, but the items do not 

have to appear in any particular order. 

The style and look of the numbers or bullets that you apply to a 

list can easily be edited, and you can even change the starting 

number for a numbered list. The list then renumbers itself 

automatically. Also, as you add new lines to numbered or 

bulleted lists, the items are automatically set up with the same 

numbering style (with the proper number in the list sequence) or 

bullet style. 

Creating a Numbered or a Bulleted List 

You can create numbered or bulleted lists from scratch or add 

numbers or bullets to an existing list. 

To create a new numbered list, follow these steps: 



1. Place the insertion point where you want to begin the 

numbered list in your document. 

2. Select Format, Bullets and Numbering. The Bullets and 

Numbering dialog box appears. 

3. For a numbered list, select the Numbered tab (see Figure 

15.1). 

Figure 15.1. Use the Numbered tab on the Bullets and 

Numbering dialog box to select a number style for your 

numbered list. 

 

1. On the Numbered tab, click the style box for the particular 

style that you want to use for the numbers in the list. If you 

want to customize any of the default styles offered, select the 

style box and then click the Customize button. The 

Customize Numbered List dialog box appears (see Figure 

15.2). 
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Figure 15.2. The Customize Numbered List dialog box 

enables you to set the number style, format, and start 

number for the list 

 

 

1. Use this dialog box to change the number style, the format, 

the start number, the font for the numbers, or the number 

position. A preview of your changes appears at the bottom of 

the dialog box. 

2. When you have selected your options for the number style 

for your list, click OK. You are returned to the Bullets and 

Numbering dialog box. Click OK to return to the document. 

You can also easily create a bulleted list using the Bullets and 

Numbering dialog box; follow these steps: 



1. To start a bulleted list, open the Bullets and Numbering 

dialog box, as previously discussed (select Format, Bullets 

and Numbering). Click the Bulleted tab. 

2. Select the bullet style you want to use by clicking the 

appropriate box. If you need to customize your bullet style, 

click the Customize button. The Customize Bulleted List 

dialog box will open  

Using Word Tables 

In this lesson, you learn how to create and format tables in your 

Word document. You also learn how to place math formulas in a 

table. 

Understanding Tables and Cells 

A Word table is made up of vertical columns and horizontal 

rows—a tabular format. A tabular format gives you flexibility to 

arrange text and graphics in an organized fashion using columns 

and rows. Tables enable you to enter and work with information in 

a self-contained grid. Information is entered into a table cell. 

Cell A table cell is the intersection of a column and row. 

 

Word makes it easy for you to create a table of any size with any 

number of columns and rows in your document and then edit it. In 

addition to editing text or graphics in a table, you have access to 

several formatting options related to the table itself, such as row 

and column attributes and the capability to easily add or delete 

rows and columns from the table. 

Creating Tables 

Word offers you several approaches for actually placing the table 

into the document. You can insert the table into the document or 

draw the table using the Draw Table command. 
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Let's take a look at inserting a table, which allows you to quickly 

specify the number of rows and columns to be used. We can then 

look at drawing a table into a document. 

Inserting a Table 

One option for placing a table into your document is inserting the 

table. Inserting a table enables you to select the number of rows 

and columns in the table. The height and the width of the rows and 

columns are set to the default (one line space [based on the current 

font height] for the row height and 1.23 inches for the column 

width). Using the Insert command for a new table is the simplest 

way to select the number of rows and columns for the table. Also, 

to place the table, you need only place the insertion point at the 

position where the new table is to be inserted. The insertion point 

marks the top-left starting point of the table. 

Inserted tables are static; you can move them to a new location in a 

document only by selecting the entire table and then using cut and 

paste. If you want to have better control over the placement of the 

table, you might want to draw a table (as described in the next 

section). This type of table can be dragged to any location in the 

document because it is created inside a portable frame. 

To insert a table into your document, follow these steps: 

1. Place the insertion point in the document where you want to 

place the table; select Table, and then point to Insert. Select 

Table from the cascading menu. The Insert Table dialog box 

appears (see Figure 16.1). 

Figure 16.1. The Insert Table dialog box enables you to specify 

the number of columns and rows for your new table. 
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1. Use the spin arrows in the Number of Columns text box to 

set the number of columns. Use the click arrows in the 

Number of Rows text box to set the number of rows. 

2. If you want to set the number of columns and rows as the 

default for subsequent tables, click the Remember 

Dimensions for New Tables check box. 

3. To set the table so that it automatically adjusts the column 

widths to accommodate the text that you type in the column, 

select the AutoFit to Contents option button. If you are going 

to save the Word document containing the table as a Web 

document (and use it on a Web site), select the AutoFit to 

Window option button. This allows the table to automatically 

adjust within a Web browser window so that it can be viewed 

when the browser window is sized. 

4. When you have completed your settings for the table, click 

OK. 

The table is inserted into your document. 



Drawing a Table 

An alternative to inserting a table into your document is to draw 

the table. This method creates a table that resides inside a table 

frame. The frame can then be dragged to any position in the 

document. You actually draw the table with a drawing tool and use 

the tool to add rows and columns to the table. 

When you draw the table, you will find that it is created without 

any rows or columns. You then must manually insert the rows and 

columns using the Table Drawing tool. Although you can build a 

highly customized table using this method, it is not as fast as 

inserting a table with a prescribed number of rows and columns, as 

described in the previous section. 

To draw a table in your document, follow these steps: 

1. Select Table, Draw Table. The mouse pointer becomes a 

"pencil" drawing tool. The Tables and Borders toolbar also 

appears in the document window. 

2. Click and drag to create the table's outside borders (its box 

shape). Release the mouse when you have the outside 

perimeter of the table completed. 

3. To add rows and columns to the table, use the pencil to draw 

the row and column lines (hold down the left mouse button 

and drag the mouse; see Figure  

Figure 16.2. With the table drawing tool, you can draw a table 

in your document, and then draw in the row and column lines. 

The borders all snap to right-angled lines on an unseen grid so 

that your table will always have straight lines. 
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1. When you have completed your table, click the Draw Table 

button on the Tables and Borders toolbar to deactivate the 

Draw Table feature (this button is a toggle and can also turn 

the drawing tool back on when clicked). 

The Tables and Borders toolbar provides you with buttons that 

enable you to edit the attributes of the table. Several of the buttons 

on the Tables and Borders toolbar are useful for customizing your 

table: 

• Distribute Rows Evenly— This button makes the row 

heights in the table all the same. 

• Distribute Columns Evenly— This button makes all the 

column widths consistent. 

• Eraser— This button enables you to turn on the eraser; 

drag it across any row or column line in the table to erase it. 

• Line Style— This drop-down box enables you to change the 

weight and style of the row or column lines you create. 



You can also move the table anywhere on the document page (it's 

not anchored in one place like tables that are placed on the page 

using the Insert Table command). Place the mouse on the upper-

left edge of the table and a Move icon (a four-headed arrow) 

appears. Drag the icon to a new location on the page. When you 

release the mouse, the table is placed in the new location. 

Entering Text and Navigating in a Table 

Entering text into the table is very straightforward. Click in the 

first cell of the table (the open box where the first column and first 

row of the table meet) and enter the appropriate text. To move to 

the next cell (horizontally, then vertically), press the Tab key. You 

can continue to move through the cells in the tables by pressing 

Tab and entering your text. If you want to back up a cell, press 

Shift+Tab. This moves you to the cell to the left of the current cell 

and selects any text entered in that cell. 

Several other keyboard combinations are useful as you work in 

your table: 

• Alt+Home— Takes you to the first cell in the current row 

• Alt+Page Up— Takes you to the top cell in the current 

column 

• Alt+End— Takes you to the last cell in the current row 

• Alt+Page Down— Takes you to the last cell in the current 

column 

Of course, you can use the mouse to click any cell of the table at 

any time. 

Inserting and Deleting Rows and Columns 

Even after creating your table, you still have complete control over 

the number of rows and columns in it. You can delete empty or 

filled rows and columns depending on your particular need. 



To insert a row or column into the table, place the insertion point 

in a cell that is in the row or column next to where you want to 

place a new row or column. Select the Table menu and then point 

to Insert to see the available options. Options can be selected from 

a cascading menu: 

• Rows Above— Insert a new row above the selected row. 

• Rows Below— Insert a new row below the selected row. 

• Columns to the Left— Insert a new column to the left of the 

selected column. 

• Columns to the Right— Insert a new column to the right of 

the selected column. 

You can also easily delete columns or rows from your table. Select 

the rows or columns, and then select the Table menu. Point at 

Delete, and then select Columns or Rows from the cascading 

menu, as appropriate. The columns or rows selected are removed 

from the table. 

Formatting a Table 

Formatting a table can involve several things: You can change the 

width of a column or the height of a row, and you can also format 

the various table borders with different line weights or colors. 

Some of the table attributes can be modified directly on the table, 

but other attributes are best handled by modifying settings in the 

Table Properties dialog box or by using the AutoFormat dialog 

box. 

Modifying Cell Size 

An important aspect of working with your rows and columns is 

adjusting column widths and row heights to fit the needs of the 

information that you place inside the table cells. Both of these 

formatting tasks are mouse work. However, when you want to 



enter an actual value for all the column widths or row heights, you 

can use the Table Properties dialog box discussed in this section. 

Place the mouse pointer on the border between any columns in 

your table. A sizing tool appears (see Figure 16.3). Drag the sizing 

tool to adjust the width of the column. 

You can also adjust the column widths and the row heights in the 

table using the Table Properties dialog box. If you want to adjust 

the row or column attributes for just one row or column, make sure 

the insertion point is in that row or column. If you want to adjust 

the values for the entire table, click anywhere in the table, choose 

the Table menu, point at Select, and then choose Table. This 

selects the entire table. 

Follow these steps to open the dialog box and adjust the various 

properties associated with the current table: 

1. Select Table, Table Properties. The Table Properties dialog 

box appears. 

2. To adjust column widths using the dialog box, select the 

Column tab. 

3. Make sure the Specify Width check box is selected, and then 

use the width click arrows to adjust the width (see Figure 

16.4). 

Figure 16.4. Adjust your column widths using the Column 

tab of the Table Properties dialog box. 

1. If you want to change the width of the next column, click the 

Next Column button. The Previous Column button enables 

you to adjust the width of the previous column. 

2. When you have completed adjusting column widths, click the 

OK button. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch52lev1sec5.html#ch52fig03#ch52fig03
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch52lev1sec5.html#ch52fig04#ch52fig04
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch52lev1sec5.html#ch52fig04#ch52fig04


You can adjust row heights in a like manner. Use the Row tab of 

the Table Properties dialog box. You can use the Specify Height 

box to specify the row height and the Previous Row and Next Row 

buttons to specify the row for which you want to adjust the height. 

Formatting Table Borders 

Formatting your table borders is a matter of selecting the cells (or 

the entire table) and then selecting the formatting parameters. After 

you've selected the appropriate cells, select the Format menu, and 

then select Borders and Shading. 

Figure 16.5. Use the Borders and Shading dialog box to select the 

border options for your table. 

 

 

To select the border style, choose from one of the following: 



• Box— This places a box around the outside of the table. 

• All— This places a box around the table, gridlines inside the 

table, and also applies any shadow and color parameters that 

have been set in Word. 

• Grid— This places a border around the table and places a 

border (grid) on the row and column lines. 

• Custom— When you select Custom, you must then specify 

on the Preview table the border lines you want to format. To 

change the style, color, and width of your border lines, use 

the Style, Color, and Width drop-down boxes to select the 

options for your border lines. When you have completed your 

selections, click OK to return to the table. 

The border options that you selected are used to format the cells 

that you selected in the table. 

 

Automatically Formatting the Table 

You can also format your table in a more automatic fashion using 

the Table AutoFormat feature. This feature enables you to select 

from a list of predetermined table formats that configure the 

borders and provide text and background colors in the cells; you 

can even select a particular font for the text contained in the cells. 

To AutoFormat your table, click any cell of the table and then 

follow these steps: 

1. Select Table, Table AutoFormat. The Table AutoFormat 

dialog box appears. 

2. To preview the various formats provided, click a format in 

the Formats scroll box. A preview of the format is shown. 

3. When you have found the format that you want to use (you 

can choose from about 50), select the format and then click 

Apply. 



Placing a Formula in a Table 

You can also place formulas in your tables that can do a variety of 

calculations. You can add cells to show a total, calculate an 

average, and do statistical calculations such as max and min, which 

return the maximum or minimum (respectively) from a list of 

numbers. 

Before working with formulas, however, you should become 

familiar with how cell addresses are determined. Each column in 

the table is given a letter designation starting with A. So, the first 

column is A, the second is B and so on. The first row in the table is 

1. The second row would be 2 and so on. The first cell in a table, 

which is in column A and row 1 would be cell A1. Each cell's 

address is the column letter followed by the row number. 

To specify a group of cells to be acted on by a formula, you have 

to specify the first cell in the group and then the last cell in the 

group. So if you were adding cells B2, B3, B4, and B5, you would 

designate the cell group as B2:B5. This tells Word where the cells 

to act on begin and end. 

Another thing you should know is that table formulas have to be 

created in a very specific way. Each formula must start with an 

equal sign (=) followed by the name of the formula (such as SUM 

for adding or AVERAGE for average). The cells to be acted on are 

then entered in parentheses following the name of the formula. A 

formula that provides you the average of cells B2:B5 would look 

like this: 

=AVERAGE(B2:B5) 

To place a formula in a table, follow these steps: 

1. Click in the table cell where you will place the formula. 



2. Select Table, Formula. The Formula dialog box appears as 

shown in Figure 16.6. 

3. Figure 16.6. The Formula dialog box allows you to insert a 

formula into a Word table. 

 

1. In many cases, the Formula dialog box will use cell position 

to interpret the best formula to insert into the table. For 

example, in Figure 16.6, Word "sees" that you have a column 

of numbers above the formula cell and so will probably want 

to add (SUM) cells above. If this is the appropriate formula, 

click OK and the formula (and its result) will be inserted into 

the table. 

2. If you want to paste a different formula into the table cell, 

select and Delete the formula provided. 

3. In the Formula box, type an equal sign (=) and then click the 

Paste Function drop-down list to insert a new formula. 

4. To specify the cells to be acted on by the formula, place the 

starting and ending addresses of the cell grouping (separated 

by a colon). 

5. Click OK to place the formula in the table. 
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Adding Graphics to Documents 

In this lesson, you learn how to insert graphics, such as clip art, 

into your document and how to use the Word drawing tools to 

create your own graphics. 

Inserting a Graphic 

Adding a graphic to your document is really just a matter of 

identifying the place in the document where you want to place the 

picture and then selecting a specific graphic file. Word provides 

you with a large clip-art gallery of ready-made graphics (in the 

Windows metafile format, .wmf), and you can also place images 

into your document that you find on the World Wide Web, that 

you receive attached to e-mail messages, that are imported from a 

scanner or digital camera, and more. 

Word also embraces several graphic file formats, including the 

following file types: 

• CompuServe GIF (.gif) 

• Encapsulated PostScript (.eps) 

• Various paint programs (.pcx) 

• Tagged Image File format (.tif) 

• Windows bitmap (.bmp) 

• JPEG file interchange format (.jpg) 

• WordPerfect graphics (.wpg) 

To add a graphic file to your document, you insert the image using 

the Insert menu. 

Follow these steps to add a graphic to your document: 

1. Place the insertion point where you want to place the graphic 

in the document. 

2. Select Insert, Picture, and then select From File on the 

cascading menu. The Insert Picture dialog box appears. 



3. Use the Look In box to locate the drive and folder that 

contains the picture file. After you locate the picture, click 

the file to view a preview (see Figure 18.1). 

 

 

1. After you select the picture you want to insert into the 

document, click Insert in the lower-right corner of the Insert 

Picture dialog box. 

The picture is placed in your document, and the Picture toolbar 

appears in the document window. The Picture toolbar provides 

several tools you can use to modify and edit the graphics in your 

document. See the "Modifying Graphics" section in this lesson for 

more information on this toolbar. 

Probably the first thing you will want to do to any graphic or 

picture that you insert into a document is to size the image so that 

it fits better on the page in relation to your text. Most inserted 

graphics, even those from the Office clip-art library, tend to be 

inserted into a document in a fairly large size. 
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To size a graphic, click it to select it. Sizing handles (small boxes) 

appear on the border of the graphic. Place the mouse on any of 

these sizing handles. The mouse pointer becomes a sizing tool with 

arrows pointing in the directions in which you can change the size; 

drag to size the graphic. To maintain the height/width ratio of the 

image (so you don't stretch or distort the image), use the sizing 

handles on the corners of the image and drag diagonally. 

Using the Word Clip Art 

If you don't have a collection of your own pictures and graphics to 

place in your document, don't worry; Word provides a large 

collection of clip-art images you can use to liven up your 

documents. The clip-art library is organized by theme. For 

example, if you want to peruse the animal clip art that Word 

provides, you can select the Animal theme. 

To insert Word clip art into your document, follow these steps: 

1. Place the insertion point where you want to place the graphic 

in the document. 

2. Select Insert, Picture, and then select Clip Art on the 

cascading menu. The Clip Art task pane appears (see Figure 

18.2). 

Figure 18.2. The Clip Art task pane gives you access to the 

Word clip art gallery. 
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1. Type the name of a clip-art theme, such as Animals, into the 

Search For box. 

2. (Optional) By default, the search will be conducted on all 

your media collections, including the Office and Web 

Collections. If you want to exclude certain collections from 

the search (to speed up the search process), click the Search 

In drop-down arrow and clear the check mark from any of the 

locations listed. 

3. (Optional) If you want to exclude certain file types from the 

search (to speed up the search process), select the All Media 

File Types drop-down box and deselect any of the file types 

(ClipArt, Photographs, and so on) as required. 



 

Sound and Action Imagery Available, Too You can 

insert sound or movie clips into your document from 

the Clip Art task pane. By default they are included 

in the results for any search you conduct. 

4.  
 

5. Click the Go button, and various clip-art images that fit your 

search criteria appear. 

6. When you have located the clip art you want to place in the 

document, click the image. An image drop-down box 

appears. Select Insert to place the image in your document 

(see Figure 18.3). 

Figure 18.3. Click a particular clip-art category to view the 

clip-art images. 

 

If used appropriately, pictures and clip art can definitely improve 

the look and feel of your documents, particularly special 

documents such as flyers, newsletters, and brochures. If you find 

that the clip-art library provided doesn't have what you need, click 
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the Clip Art on Microsoft.com link near the bottom of the task 

pane. Your Web browser opens and takes you to Microsoft's online 

clip-art library, which offers additional clip-art images for your 

use. 

Using the Word Drawing Toolbar 

You can also create your own graphics in your documents using 

the drawing tools provided on the Word Drawing toolbar. This 

toolbar provides several tools, including line, arrow, rectangle, 

oval, and text box tools. You can also use the appropriate tools to 

change the fill color on a box or circle, change the line color on 

your drawing object, or change the arrow style on arrows you have 

placed on the page. 

To display the Drawing toolbar, select View, point at Toolbar, and 

then select Drawing from the toolbar list. 

 

Quickly Access Toolbars You can also right-click 

any toolbar in the Word window to access the toolbar 

list; then select Drawing 

  

 

The Drawing toolbar appears at the bottom of the document 

window just above the Word status bar. Figure 18.6 shows the 

Drawing toolbar and the tools available on it. 

Word provides you with an add-on program called WordArt that 

enables you to create special text effects in your document. You 

can create text that wraps around a circle, as well as a number of 

other special text "looks." In Word, click the WordArt button on 

the Drawing toolbar to start the WordArt program. WordArt can 

also be used in other Office programs, such as PowerPoint, to 

create visually exciting text items. 
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Another useful Drawing tool is the Insert Diagram or 

Organization Chart button. Click this button to add predesigned 

organizational charts and other special diagrams to a document. 

Creating a New Object 

To draw a particular object, click the appropriate button on 

the toolbar. Then, drag the mouse to create the object in your 

document. To draw a square or circle, click the Rectangle tool or 

the Oval tool and hold down the Shift key as you draw the object 

with the mouse. If you find that you aren't very good at actually 

drawing graphical objects, click the AutoShapes drop-down arrow 

(near the left side of the drawing toolbar) and select a particular 

object shape from the list provided. 

Modifying Drawn Objects 

You can also control the various attributes for a particular object 

that you've drawn. You must first select the object using the 

selection pointer (click the Select Objects tool, and then click the 

object). You can manipulate the object's line style, fill color, and 

line color. Just choose the appropriate tool on the toolbar, and 

make your selection from the list of possibilities. 

You can also size and move objects that you draw. Select an 

object, and use the sizing handles to increase or decrease the size 

of the particular object. If you want to move the object to a new 

position, place the mouse pointer in the middle of the selected 

object and drag it to a new position. 

If you draw several related objects, you can select all the objects at 

once and drag them together to a new location. Select the first 

object and then hold down the Shift key and select subsequent 

objects, as needed. When you drag any of the objects to a new 

location, all the selected objects move together. 



At times you will want to delete a particular object from your 

document. Simply select the object and then press Delete to 

remove it. 

You will find that the Drawing toolbar provides you with all the 

tools (except natural artistic ability) you need to create fairly 

sophisticated custom images. A little practice with the various 

tools goes a long way in helping you create objects that add 

interest to your documents. 

 

 

Creating Personalized Mass Mailings 

In this lesson, you learn how to create form letters, envelopes, and 

mailing labels for mass mailings using the Word merge feature. 

Understanding the Mail Merge Feature 

Word makes it easy for you to take a list of names and addresses 

and merge them with a form letter, an envelope template, or 

mailing labels. This enables you to quickly create items for mass 

mailings that appear to be customized for each person on the 

mailing list. 

Although the Mail Merge Wizard walks you through the merge 

process, the entire procedure can be somewhat confusing. Two 

different documents are used during the merge process: a main 

document and a data source. The main document is your form 

letter or mailing label template, and the data source is a Word 

document that provides the list of names and addresses that are 

inserted into the main document during the merge. The data source 

can be created prior to the mail merge or during the process. 



The information in the data source is inserted into the form letter or 

mailing label using placeholder codes called merge fields. Each 

merge field in the main document relates to a piece of information 

in the data source document, such as first name or street address, 

and the merge field gets its name from that particular field in the 

data source. 

 

Merge Fields Codes serve as placeholders in your 

main document; for example, { FirstName} is an 

example of a merge field code that serves as a 

placeholder for the first-name information that is 

pulled from the data source. 

 

 

Data Source The file of information, such as a list of 

names and addresses, to be merged into the main 

document (such as form letters, envelopes, or mailing 

labels). Data sources in Word typically take the form 

of a table, with each row in the table containing the 

name and address of a different individual. 

 

The best way to understand how the various elements of the merge 

process—the main document, the data source, and field codes—

relate is to actually perform a merge. Working through a merge 

that creates form letters for the entire list of people in a data source 

is a good place to start because creating other merge documents, 

such as labels and envelopes, is a similar process. 

Because the merge process really consists of four different 

actions—creating the main document, creating the data source, 

inserting the merge fields into the main document (based on the 

data in the data source), and finally running the merge—this lesson 

breaks down each of these actions in their own section. We begin 

with starting the Mail Merge Wizard and creating the main 

document. 



Specifying the Main Document 

The first step in the merge process is to specify a main document 

for the merge. The main document can be the currently open 

document in the Word workspace, or you can open a pre-existing 

document during the merge process. To begin the merge process 

and designate a main document for the merge, follow these steps: 

1. Open a new, blank document in the Word window; click 

the New Blank Document icon on the Standard toolbar. 

2. Select Tools, point at the Letters and Mailing arrow, and then 

select Mail Merge Wizard. The Mail Merge task pane opens, 

as shown in Figure 19.1. 

Figure 19.1. The Mail Merge task pane walks you through 

the steps of merging a main document with a data source. 
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1. Under Select Document Type on the Mail Merge task pane, 

choose the type of main document you want to create using 

one of the following option buttons: Letters, E-Mail 

Messages, Envelopes, Labels, or a Directory. A directory, in 

this case, is a list of names and addresses that the wizard 

creates (like a phone book). It does not create a separate item 

for each person in the data source as the other options do. 

2. After selecting the appropriate option button (for this 

example, Letters has been selected), click the Next: Starting 

Document link at the bottom of the task pane. 

3. The next wizard step provided in the task pane provides three 

different option buttons; select one of the following: 

o Use the Current Document— This option enables you 

to build your main document using the new, blank 

document that was opened in step 1 (and this will be the 



approach that we use in the steps that follow in this 

section). 

o Start from a Template— When this option button is 

selected, a Select Template link appears in the Mail 

Merge task pane. Click Select Template, and the Select 

Template dialog box appears. This dialog box enables 

you to base your main document on any of Word's 

document templates. After selecting a particular 

template on one of the dialog box tabs, click OK to 

return to the Mail Merge task pane. 

o Start from Existing Document— If you select this 

option button, a Start from Existing File box appears in 

the task pane. Click the Open button at the bottom of 

the box. The Open dialog box appears. Use it to select 

the existing Word document that will serve as the main 

merge document. Click OK to close the Open dialog 

box and return to the task pane. 

4. After selecting one of the options (as discussed in step 5), 

click the Next: Select Recipients link at the bottom of the 

task pane. This allows you to either create or specify the 

document that contains the names and addresses (the data 

source) that you will use for the merge. We discuss the data 

source document in the next section. 

A few things should be said about the options available in step 4. 

When you select one of these options, you are only setting the 

stage for how the main document will look when it is completed 

(meaning when the merge fields and any text that the document 

will include have been inserted). 

If you use a blank document, you will have to add any special 

formatting or document layout features that you want to include in 

the document (as well as all the text that the document will 

contain). If you use an existing document, it can already contain 

the body text for the form letter and various formatting attributes. 



Using the document template option enables you to use one of 

Word's templates to determine the overall look of the document. 

Templates also often insert placeholder text in a document, 

allowing you to quickly replace it with text of your own. Of 

course, there's no guarantee that the style of templates Word 

provides by default will suit your needs. 

No matter how you create the main document (using the options 

we discussed in this section), field or merge codes will need to be 

inserted. The actual field codes used will be determined by the data 

source document, which we discuss in the next section. 

Creating or Obtaining the Data Source 

The next step in the process is to open or create a data source 

document. This document not only provides the names and 

addresses that will be merged into your form letter, but it also 

dictates the merge fields that are placed in the main document (as 

placeholders for the actual data that will be placed in the form 

letters during the merge). 

Creating a data source during the Mail Merge process is very 

straightforward because the Mail Merge Wizard provides you with 

a form that you use to enter people's names, addresses, and other 

information. When you enter the information for a particular 

person, you are creating a record. Each record pertains to one 

person. 

However, you also can use existing data sources for the merge. For 

example, you can use Access database tables (see Part VI, 

"Access," for information on creating databases in Access), your 

Outlook Contacts list, or any Word data source document that you 

created for a previous merge. 

To provide you with a complete, from-scratch look at the merge 

process, we will create a new data source document in this section 
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of the lesson. The following steps pick up from the preceding 

section, where we specified the main document for the merge. 

 

Record Information in the data source that contains 

information about a particular person (or place or 

thing). 

 

 

Merge Field A code that tells Word to automatically 

insert information into your main document during 

the merge. For example, the Last Name field inserts 

your letter recipient's last name. 

1. In the Mail Merge task pane (which currently shows Step 3 

of 6, as shown in Figure 19.2), choose one of the following 

options to specify the data source for the merge: 

o Use an Existing List— This option is selected by 

default. If you have a Word document that contains a 

table or an Access table that contains the name and 

address information you want to use for the merge, 

select the Browse button in the task pane. This opens 

the Select Data Source dialog box. Locate your data 

source file, select it, and then click Open to return to the 

Word window and the Mail Merge task pane. The Mail 

Merge Recipients dialog box appears in the Word 

window, providing a data source list based on the 

source file (it will look the same as the Mail Merge 

Recipients dialog box shown later in Figure 19.4). 

Figure 19.4. Use the Mail Merge Recipients dialog 

box to sort or select the recipients of the form letter. 
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o Select from Outlook Contacts— This option enables 

you to select the names and addresses for the merge 

from your Outlook Contacts. When this option is 

selected, a Choose Contacts Folder link appears in the 

task pane. Click the link and specify the location of 

your Contacts folder in the Select Contact List Folder 

dialog box that opens (in almost all cases it finds your 

Contacts folder for you). Click OK to return to Word 

and the task pane. The Mail Merge Recipients dialog 

box appears containing a list of your contacts (it is the 

same as the dialog box shown later in Figure 19.4). 

o Type a New List— This option enables you to create a 

new data source (you will use this option to explore 

how you create a new data source). After selecting this 

option, click the Create button in the task pane to open 

the New Address List dialog box (you explore this 

dialog box in step 2). 
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Figure 19.2. You can use an existing document or your 

Outlook Contacts list as the data source, or you can create a 

new data source from scratch. 

 

1. After selecting one of the options listed in step 1 and clicking 

the Create link, either the Mail Merge Recipients dialog box 

appears (when you select either the existing list or Outlook 

Contacts list options; we discuss the Mail Merge Recipients 

dialog box in step 5) or, in the case of the Type a New List 

option (which we select here as we explore this feature), the 

New Address List dialog box appears (see Figure 19.3). 

Figure 19.3. Use the New Address List dialog box to create 

the new data source for the merge. 
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1. Enter the name, address, and other information that you want 

to place in the record for the first recipient. When you have 

finished entering the data, click the New Entry button on the 

New Address List dialog box to enter the next record. 

2. Enter additional records as needed. When you have finished 

entering your records, click the Close button on the New 

Address List dialog box. The Save Address List dialog box 

opens. 

3. Enter a name for the file and specify a location (if 

necessary—by default, the address list is saved in a special 

My Data Sources folder that was created when you installed 

Office). Click Save to save the data source file. 

4. The Mail Merge Recipients list appears (see Figure 19.4). If 

you used your Outlook Contacts list or an existing data 

source, this dialog box appears after you completed step 1 in 

this section. 
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5. If you want to deselect any of the recipients in the Mail 

Merge Recipients dialog box, clear the check box to the left 

of their records. If you want to sort the list by a particular 

field (such as last name), click that column's heading. 

6. After selecting recipients or sorting the recipient list, click 

OK to close the Mail Merge Recipients dialog box. 

After creating your recipient list as discussed in this section, you 

are ready to complete the main document and enter the merge 

fields. These topics are discussed in the next section. 

Completing the Main Document and Inserting the Merge 

Fields 

Now that you have specified the recipients for the merge, you can 

add text, such as the body of the letter, to the main document. The 

merge fields that pull information from the data source can also be 

inserted. 

Inserting merge fields is a very straightforward process. You can 

insert individual merge fields for information, such as first name 

and last name, or you can allow Word to automatically insert 

several fields into the letter. For example, you can click the 

Address Block icon that the Mail Merge task pane provides. This 

inserts the merge fields for the recipient's name and the appropriate 

address merge fields. 

Follow these steps: 

1. After specifying or creating a data source (as detailed in the 

last section), click the Next: Write Your Letter link at the 

bottom of the task pane. 

2. The Write Your Letter (step 4 of 6) part of the merge process 

appears in the Mail Merge task pane (see Figure 19.5). 
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Figure 19.5. You can insert merge fields into the form letter 

using the icons in the task pane. 

 

1. A good practice is to go ahead and click in the blank main 

document and type your letter text, such as the body of the 

letter. You can also add the closing of the letter or any other 

information. 

2. You can insert the merge fields after typing the text for the 

letter. Place the insertion point in the main document where 

you want to place the first merge field. For example, to place 

recipients' addresses in a form letter, place the insertion point 

four lines above the greeting. Click the Address Block icon in 

the task pane. The Insert Address Block dialog box appears. 

3. The Insert Address Block dialog box provides you with 

different formats for inserting the recipient's name and their 



address information. Choose one of the formats listed (see 

Figure 19.6). 

Figure 19.6. You can insert merge fields into the form letter 

using the icons in the task pane 

 

1. Option buttons related to the inclusion of the country/region 

field in the address block are also included. Select the 

appropriate option button, and click OK to close the dialog 

box. Word inserts the Address Block code into the letter. 

Now that you've inserted an Address field, move the insertion 

point to the position where you want to place the next set of merge 

fields—for example, the Greeting line. 
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To insert a Greeting line, click the Greeting Line icon on the task 

pane. The Greeting Line dialog box appears. Use the drop-down 

lists to select the format for your letter's greeting line, including the 

punctuation used at the end of the line, such as a comma or a 

colon, and to insert the appropriate merge fields, such as Last 

Name, that would be included on the greeting line. Then, click OK. 

You can insert any other merge fields, as needed, into the 

document. If you want to insert individual merge fields into the 

letter, click the More Items icon on the task pane. The Insert Merge 

Field dialog box appears. Select a merge field, and then click 

Insert. When you have finished inserting any needed merge fields, 

click Close. 

Finally, you might want to insert a date at the top of your form 

letter (the main document). Press Ctrl+Home to go to the top of the 

document, and then select Insert, Date and Time. Select your date 

format in the Date and Time dialog box, and then click OK to 

insert the date. 

Figure 19.7 shows a main document that has been completed. Note 

that it contains merge fields for the address block and greeting line. 

Figure 19.7. Your finished main document will include merge 

fields, a date, and the body text for the letter 
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After you've finished your form letter (including the insertion of 

the appropriate merge fields), you are ready to complete the merge. 

The next section discusses the completion of the merge and the 

viewing of your finished form letters. 

Merging the Documents 

The next step in the merge process is to have Word create the 

merged documents so that you can preview the letters that are 

created. This enables you to be sure that the merge worked 

correctly (based on the merge fields you placed in the main 

document). It also enables you to edit any of the form letters 

created before you print them. Although the Mail Merge task pane 

allows you to preview each letter separately, the merge process 

actually creates a single document that places each form letter on a 

separate page. 

Follow these steps: 



1. Click the Next: Preview Your Letters link at the bottom of 

the task pane (refer to Figure 19.6; this is step 4 of 6 and 

picks up where the previous section left off). 

2. The first form letter appears in the Word window (see Figure 

19.8). Check to be sure that the merge fields have placed the 

appropriate information into the form letter. To view the next 

recipient's letter, click the Next button (>>) at the top of the 

task pane 

Figure 19.8. You can view each form letter created by the merge 

 

1. Continue to view the form letters that were created during the 

merge (using the Next button; if you want to go back to a 

previous letter, click the Previous button, <<). If you come 

across a letter to a recipient that you do not want to keep as 

part of the merge, click the Exclude This Recipient button. 

The form letter is deleted and the form letter for the next 

recipient appears in the Word window. 

2. When you have finished viewing the form letters created by 

the merge and are ready to complete the merge process, click 

the Next: Complete the Merge link at the bottom of the task 

pane. 
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3. To send the form letters to your printer, click the Print icon 

on the task pane. Word sends the letters to your printer. 

4. If you want to save the form letters so that you can print them 

in the future (or save them for later reference), click the Save 

button on the Standard toolbar. Provide a name and location 

for the document in the Save As dialog box. Then, click Save 

to save the document. 

After you print the form letters or save the merged document, the 

merge process is complete. At this point, you can close the task 

pane, if you want to. Click its Close (X) button. 

 Creating Envelopes and Mailing Labels 

The procedure for using the merge feature discussed in this lesson 

assumes that you are using a form letter as your main document 

and creating copies of the letter for each person listed in the data 

source. You can also use the merge feature to create other 

document types, such as envelopes and labels. 

The procedure for creating envelopes, mailing labels, or letters is 

almost the same. In each case, you use the Mail Merge Wizard to 

specify the type of document that you are creating, and then the 

wizard walks you through the entire merge process. The steps that 

follow discuss how to create envelopes using the Mail Merge 

Wizard, but you can just as easily create mailing labels using this 

process. 

To create envelopes using the Mail Merge Wizard, follow these 

steps: 

1. Open a new blank document (click the New Blank 

Document icon on the Standard toolbar). Select Tools, point 

at Letters and Mailing, and then select Mail Merge Wizard. 

The Mail Merge task pane opens. 

2. Under Select Document Type, select Envelopes. 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_11071533.html


3. Click Next: Starting Document at the bottom of the task 

pane. 

4. On the next task pane screen, select the Change Document 

Layout option button (if necessary). To select the envelope 

type to use for the merge, click the Envelope Options icon. 

The Envelope Options dialog box will appear (see Figure 

19.9). 

Figure 19.9. Choose the type of envelope you need in the 

Envelope Options dialog box. 

 

1. Select the envelope type you want to use for the merge using 

the Envelope Size drop-down list. If you want to edit any of 

the fonts for the envelope, use the appropriate Font button on 

the dialog box. When you have finished setting your 

envelope options, click OK. 
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2. To proceed to the next step in the merge, click Next: Select 

Recipients at the bottom of the task pane. 

3. You will need to open or create a data source document. 

After you open or create a new data source (as discussed 

earlier in this lesson), the Mail Merge Recipients dialog box 

appears. Click OK to close this dialog box. 

4. To proceed to the next step in the merge process and place 

the merge fields on the envelope, click Next: Arrange Your 

Envelope. 

5. Insert the merge fields on the envelope using the Address 

Block or More Items icons provided in the Mail Merge task 

pane. To center the recipient address on the envelope, press 

Enter as required and then click the Center icon on the 

Formatting toolbar. 

6. After placing the merge fields on the envelope, click Next: 

Preview Your Envelopes. Use the Next (>>) or Previous (<<) 

buttons as needed to view all the envelopes. Remove any 

envelopes that you do not want to create by clicking the 

Exclude This Recipient button on the task pane. 

7. To complete the merge, click Next: Complete the Merge at 

the bottom of the task pane. 

At this point, you can click the Print icon on the task pane to send 

the envelopes to your printer. You also can save the envelope 

document created (each recipient's envelope is placed on a separate 

page in the merged document) and then print individual pages as 

needed (click the Save button on the Standard toolbar). 

A macro is a shortcut to a task you do repeatedly. Think about the 

Centre align operation. You first highlight the word you want 

centred, then click the centre icon in the toolbar. This is a macro. 

It's the short way of performing the centre task.  

But you don't have to do it that way. There is a longer way. You 

can centre your text by clicking on Format from the menu bar. 



When the menu drops down, click Paragraph. You'll get a 

dialogue box popping up. Click the down arrow in the Alignment 

box, and then click on centre. Click OK on the dialogue box and 

your text is centred. That's the long way round.  

Clicking the centre icon on the toolbar is much easier - it's a very 

useful Macro built in to Microsoft Word. 

Macro in ms word-- 

A Macro is a way to create a shortcut for a task that you do a 

lot. 

You can create your own macros. The macro we're going to create 

in the next section is a very simple one, but macros don't have to 

be simple. You can open up the Visual Basic editor and create a 

very complex macro indeed. Some malicious people even create 

Word macros that can do very nasty things to your computer! 

So, after that little scare story, let's create our very own macros. 

This one is very simple, and definitely won't set off the alarm bells 

in your Anti-Virus software.  

You can create a macro by using the macro recorder to record a 

sequence of actions, or you can create a macro from scratch by 

entering Visual Basic for Applications code in the Visual Basic 

Editor. 

You can also use both methods. You can record some steps and 

then enhance them with additional code. 

By recording steps 

1. On the Tools menu, point to Macro, and then click Record 

New Macro. 

2. In the Macro name box, type a name for the macro. 
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3. In the Store macro in box, click the template or document in 

which you want to store the macro. 

4. In the Description box, type a description for the macro. 

5. If you don't want to assign the macro to a toolbar, a menu, or 

shortcut keys, click OK to begin recording the macro.  

To assign the macro to a toolbar or menu, click Toolbars, and then 

click the Commands tab. In the Commands box, click the macro 

you are recording, and drag it to the toolbar or menu you want to 

assign it to. Click Close to begin recording the macro. 

To assign the macro to shortcut keys, click Keyboard. In the 

Commands box, click the macro you are recording. In the Press 

new shortcut key box, type the key sequence, and then click 

Assign. Click Close to begin recording the macro. 

6. Perform the actions you want to include in your macro.  

When you record a macro, you can use the mouse to click 

commands and options, but not to select text. You must use the 

keyboard to record these actions. For example, you can use F8 to 

select text and press END to move the cursor to the end of the line.  

7. To stop recording your macro, click Stop Recording . 
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MS-EXCEL 2003 

 

 

 

Starting Excel 

Excel is a spreadsheet program that can help you create worksheets 

and invoices and do simple and sophisticated number crunching; it 

is designed to help you calculate the results of formulas and help 

you organize and analyze numerical data. 

To start Excel from the Windows desktop, follow these steps: 

1. Click the Start button, and the Start menu appears. 

2. Point at All Programs (in Windows XP; in Windows 2000 

select Programs), and the Programs menu appears. 

3. Select the Microsoft Office program group and then 

Microsoft Office Excel 2003 to start the program. 

 



 

 

Understanding the Excel Window 

When you click the Microsoft Excel icon, the Excel application 

window appears, displaying a blank workbook labeled Book1 (see 

Figure 1.1). On the right side of the Excel window is the Getting 

Started task pane. This task pane enables you to connect to 

Microsoft online. It also allows you to open existing Excel 

workbooks or create new workbooks (which is discussed later in 

the lesson). 

Figure 1.1. Excel provides a new workbook and the menus and 

toolbars necessary for doing some serious number crunching 

 
 

When you work in Excel, you use workbook files to hold your 

numerical data, formulas, and other objects, such as Excel charts. 

Each Excel workbook can consist of several sheets; each sheet is 

called a worksheet 
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An Excel file is called a workbook. Each workbook consists of 

several worksheets made up of rows and columns of information 

 

You enter your numbers and formulas on one of the workbook's 

worksheets. Each worksheet consists of 256 columns. The columns 

begin with column A and proceed through the alphabet. The 27th 

column is AA, followed by AB, AC, and this convention for 

naming subsequent columns continues through the entire alphabet 

until you end up with the last column (column 256), which is 

designated IV. 

Each worksheet also consists of 65,536 rows. The intersection of a 

column and a row on the worksheet is called a cell. Each cell has 

an address that consists of the column and row that intersect to 

make the cell. For example, the very first cell on a worksheet is in 

column A and row 1, so the cell's address is A1. 

 

Worksheet One sheet in an Excel workbook. Each worksheet 

consists of 256 columns and 65,536 rows (plenty of space to create 

even the most enormous spreadsheets). 

 

 

Cell Where a row and column intersect, each cell has an address 

that consists of the column letter and row number (A1, B3, C4, and 

so on). You enter data and formulas in the cells to create your 

worksheets. 

 

shows cell A1 highlighted in worksheet 1 (designated as Sheet1 on 

its tab) of Workbook 1 (designated in the title bar as Book1; this 



will change to a particular filename after you name the workbook 

using the Save function). 

The Excel window shown here includes many of the various 

elements available in other Office applications, such as Word or 

PowerPoint. These elements include a menu bar (from which you 

select commands), a status bar (which displays the status of the 

current activity), and toolbars (which contain buttons and drop-

down lists that provide quick access to various commands and 

features). 

In addition, the window contains several elements that are unique 

to Excel 

 

Elements of the Excel Window 

Element Description 

Formula bar When you enter information into a cell, it appears in 

the Formula bar. You can use the Formula bar to edit 

the data later. The cell's location also appears in the 

Formula bar. 

Column 

headings 

The letters across the top of the worksheet, which 

identify the columns in the worksheet. 

Row 

headings 

The numbers down the side of the worksheet, which 

identify the rows in the worksheet. 

Cell selector The dark outline that indicates the active cell. (It 

highlights the cell you are currently working in.) 

Worksheet 

tabs 

These tabs help you move from worksheet to 

worksheet within the workbook 

 



Starting a New Workbook 

As you've already seen, when you start Excel, it opens a new blank 

workbook. It is ready to accept data entry, which is discussed in 

Lesson 2, "Entering Data into the Worksheet." 

The empty workbook that appears when you start Excel is pretty 

much a blank canvas, but Excel also enables you to create new 

workbooks based on a template. A template is a predesigned 

workbook that you can modify to suit your needs. Excel contains 

templates for creating invoices, expense reports, and other 

common business accounting forms. 

To create a new workbook, follow these steps: 

1. Open the File menu and select New. The New Workbook 

task pane appears on the right side of the Excel window (if 

you did not close it as outlined earlier, it should already be 

open). 

2. The New Workbook task pane enables you to create new 

blank workbooks or create workbooks based on an existing 

workbook or a template (see Figure 1.2). 

Figure 1.2. The New Workbook task pane provides quick 

access to commands for creating new Excel workbooks 
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To create a blank workbook, click the Blank Workbook icon. A 

new blank workbook opens in the Excel window. 

 

You can also quickly start a new blank workbook by 

clicking the New button on the Standard toolbar. 

 

Blank templates are fine when you have a design in mind for the 

overall look of the workbook. However, for some help with 

workbook layout and formatting, you can base your new workbook 

on an Excel template. To use an Excel template, follow these steps: 

1. Click the On My Computer link in the Templates pane of the 

New Workbook task pane. The Templates dialog box 

appears. 



2. Click the Spreadsheet Solutions tab on the Templates dialog 

box. The various workbook template icons appear (see Figure 

1.3). 

Figure 1.3. The Spreadsheet Solutions templates 

 

 
 

1. Select a template by clicking its icon, and then click OK or 

press Enter. A new workbook opens onscreen with a default 

name based on the template you chose. For example, if you 

chose the Timecard template, the new workbook is named 

Timecard1, as shown at the top of Figure 1.4. 

Figure 1.4. A new workbook based on a template provides a basic 

layout for a particular business form 
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Saving and Naming a Workbook 

Whether you build your workbook from a blank template or use 

one of the Excel templates, after you enter some data into the 

workbook, you should save the file (you learn about data entry in 

Lesson 2). Also, because changes that you make to the workbook 

are not automatically saved, you should occasionally save the 

edited version of your work. 

The first time you save a workbook, you must name it and specify 

a location where it should be saved. Follow these steps to save 

your workbook: 

1. Open the File menu and select Save, or click the Save 

button on the Standard toolbar 

 

1. Type the name you want to give the workbook in the File 

Name text box. You can use up to 218 characters, including 

any combination of letters, numbers, and spaces. 
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2. Normally, Excel saves your workbooks in the My Documents 

folder. To save the file to a different folder or drive (such as a 

network drive), select a new location using the Save In list. 

3.  

The Folder I Want to Save In Doesn't Exist! You can create 

a new folder from the Save As dialog box: click the Create 

New Folder button on the toolbar of the Save As dialog box, 

type a name for the new folder, and then press Enter. 

4.  
 

5. Click Save to save your workbook and close the Save As 

dialog box. 

To save changes that you make to a workbook that you have 

previously saved, just click the Save button on the Standard 

toolbar. You can also press the shortcut key combination of Ctrl+S 

to save changes to your workbook. 

 

Saving a Workbook Under a New Name or Location 

There might be an occasion when you want to save a copy of a 

particular workbook under a different name or in a different 

location. Excel makes it easy for you to make duplicates of a 

workbook. Follow these steps: 

1. Select the File menu and select Save As. The Save As dialog 

box opens, just as if you were saving the workbook for the 

first time. 

2. To save the workbook under a new name, type the new 

filename over the existing name in the File Name text box. 



3. To save the new file on a different drive or in a different 

folder, select the drive letter or the folder from the Save In 

list. 

4. To save the new file in a different format (such as WK4, 

which is a Lotus 1-2-3 format), click the Save As Type drop-

down arrow and select the desired format. 

5. Click the Save button or press Enter. 

Opening an Existing Workbook 

If you have a workbook you've previously saved that you would 

like to work on, you must open the file first, before you can make 

any changes. Follow these steps to open an existing workbook: 

1. Open the File menu and select Open, or click the Open 

button on the Standard toolbar. 

2. If the file is not located in the current folder, open the Look 

In drop-down list box and select the correct drive and folder. 

3. Select the file you want to open in the files and folders list. 

4. To see a preview of the workbook before you open it, click 

the Views button and select Preview. Excel displays the 

contents of the workbook in a window to the right of the 

dialog box. 

5. Click Open to open the currently selected workbook. 

Closing Workbooks 

When you have finished with a particular workbook and want to 

continue working in Excel, you can easily close the current 

workbook. Click the Close (X) button in the upper-right corner of 

the workbook. (There are two Close buttons; the one on top closes 

Excel, and the one below it closes the current workbook window.) 

You can also close the current workbook by selecting File, Close. 

If you have changed the workbook since the last time you saved it, 

you will be prompted to save any changes. 



Exiting Excel 

When you have finished working with Excel, you need to exit the 

application. This closes all workbooks that are currently open. To 

exit Excel, select the File menu and select Exit. Or you can click 

the Close (X) button at the upper-right corner of the Excel window. 

If you have changed any of the workbooks that you were working 

with, you are prompted to save changes to these workbook files 

before exiting Excel. 

 

Entering Data into the Worksheet---- 

Understanding Excel Data Types 

When you work in Excel, you enter different types of information, 

such as text, numbers, dates, times, formulas, and functions (which 

is a special built-in formula provided by Excel). Excel data 

basically comes in two varieties: labels and values. 

A label is a text entry; it is called a label because it typically 

provides descriptive information such as the name of a person, 

place, or thing. A label has no numerical significance in Excel; it's 

just there to describe accompanying values. 

Label Any text entry made on an Excel worksheet. 

 

A value is data that has numerical significance. This includes 

numbers, dates, and times that you enter on your worksheet. 

Values can be acted on by formulas and functions. Formulas are 

discussed in Lesson 3, "Performing Simple Calculations," and 

Excel functions in Lesson 5, "Performing Calculations with 

Functions." 
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Values Entries, such as numbers and dates, that have numerical 

significance and can be acted upon by formulas or functions. 

Entering Text 

Text is any combination of letters, numbers, and spaces. By 

default, text is automatically left-aligned in a cell, whereas 

numerical data is right-aligned. 

Entering Numbers As Text To enter a number that you want 

treated as text (such as a ZIP code), precede the entry with a 

single quotation mark ('), as in '46220. The single quotation 

mark is an alignment prefix that tells Excel to treat the 

following characters as text and left-align them in the cell. 

You do not have to do this to "text" numerical entries, but it 

ensures that they will not be mistakenly acted upon by 

formulas or functions. 

 

To enter text into a cell, follow these steps: 

1. Use your mouse or the keyboard arrows to select the cell in 

which you want to enter text. 

2. Type the text. As you type, your text appears in the cell and 

in the Formula bar 

3. Figure 2.1. Data that you enter into a cell also appears in 

the Formula bar as you type it. 

 



 

1. Press Enter. Your text appears in the cell, left-aligned. The 

cell selector moves down one cell. You can also press Tab or 

an arrow key to enter the text and move to the next cell to the 

right (or in the direction of the arrow). 

Tips on Entering Column and Row Labels 

Column and row labels identify your data. Column labels appear 

across the top of the worksheet beneath the worksheet title (if any). 

Row labels are entered on the left side of the worksheet. 

Column labels describe what the numbers in a column represent. 

Typically, column labels specify time intervals such as years, 

months, days, quarters, and so on. Row labels describe what the 

numbers in each row represent. Typically, row labels specify data 

categories, such as product names, employee names, or income and 

expense items in a budget. 



When entering your column labels, enter the first label and press 

the Tab key instead of pressing Enter. This moves you to the next 

cell on the right so that you can enter another column label. When 

entering row labels, use the down-arrow key or Enter instead of the 

Tab key. Figure 2.2 shows the various labels for a quarterly sales 

summary. 

Figure 2.2. Column and row headings serve as labels for the data 

you enter on the worksheet. 

 

If you need to enter similar data (such as a series of months or 

years) as column or row labels, you can enter them quickly as a 

series; this technique is discussed later in this lesson. 

Adding Comments to Cells 

You can add comments to particular cells, although the comments 

are not really considered cell content (such as labels and values). 

These comments allow you to associate information with a cell—

information that does not appear (by default) with the worksheet 

when sent to the printer. 
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Comments are similar to placing a Post-it note on a cell, reminding 

you that an outstanding issue is related to that cell. For example, if 

you need to check the value that you've placed in a particular cell 

to make sure that it's accurate, you can place a comment in the cell 

(see Figure 2.3). Cells containing comments are marked with a red 

triangle in the upper-right corner of the cell. To view a comment, 

place the mouse pointer on the comment triangle. 

Figure 2.3. Comments can be added to cells as a kind of 

electronic Post-it note 

 

To insert a comment into a cell, follow these steps: 

1. Click the cell in which you want to place the comment. 

2. Select Insert, Comment. A comment box appears next to the 

cell. 

3. Type your information into the comment box. 

4. Click anywhere else in the worksheet to close the comment 

box. 
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You can also easily remove comments from cells. Select the cell, 

and then select Edit and point at Clear. On the cascading menu, 

select Comments to remove the comment. 

Entering Numbers 

Data that serves as the values in your workbooks can include the 

numeric characters 0–9. Because formulas are also considered 

values (you learn about simple calculations in Lesson 3), other 

valid value characters include symbols such as +, –, /, and *. You 

can also use characters such as a comma (,), a percent sign (%), or 

a dollar sign ($) in your values. You will find, however, that you 

can save yourself a few data-entry keystrokes and add these 

characters using different Excel formatting options (you learn 

about Excel formatting in Lesson 9, "Changing How Numbers and 

Text Look"). 

For example, you could enter the dollar amount $700.00 including 

the dollar sign and the decimal point. However, it's probably faster 

to enter the 700 into the cell and then format all the cells that 

contain dollar amounts after you have entered all the data. 

To enter a value, follow these steps: 

1. Click in the cell where you want to enter the value. 

2. Type the value. To enter a negative number, precede it with a 

minus sign or surround it with parentheses. 

3. Press Enter or the Tab key; the value appears in the cell right-

aligned. Figure 2.4 shows various values entered into a 

simple worksheet 

4. Figure 2.4. Values are right-aligned in a cell. 
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Entering Dates and Times 

Dates that you enter into an Excel workbook have numerical 

significance. Excel converts the date into a number that reflects the 

number of days that have elapsed since January 1, 1900. Even 

though you won't see this number (Excel displays your entry as a 

normal date), the number is used whenever you use this date in a 

calculation. Times are also considered values. Excel sees them as 

the number of seconds that have passed since 12 a.m. 

Follow these steps to enter a date or time: 

1. Click in the cell where you want to enter a date or a time. 

2. To enter a date, use the format MM/DD/YY or the format 

MM-DD-YY, as in 5/9/03 or 5-9-03. 

To enter a time, be sure to specify a.m. or p.m., as in 7:21 p 

or 8:22 a. 



Copying Data to Other Cells 

Another way to enter labels or values onto a sheet is to use the Fill 

feature. You can copy (fill) an entry into surrounding cells. For 

example, suppose you have a list of salespeople on a worksheet, 

and they will each get a $100 bonus. You can enter the 100 once 

and then use the Fill feature to insert multiple copies of 100 into 

nearby cells. To use the Fill feature for copying, follow these steps: 

1. Click the fill handle of the cell (the small block in the lower-

right corner of the cell) that holds the data that you want to 

copy (see Figure 2.5). 

Figure 2.5. Drag the fill handle to copy the contents of a 

cell into neighboring cells. 
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1. Drag the fill handle down or to the right to copy the data to 

adjacent cells. A data tag appears to let you know exactly 

what data is being copied into the cells. 

2. Release the mouse button. The data is "filled" into the 

selected cells. 

When you release the mouse, a shortcut box for Fill options 

appears at the end of the cells that you filled. Copy Cells is the 

default option for the Fill feature, so you can ignore the shortcut 

box for the moment. It does come into play when you enter a series 

in the next section. 

 

Entering a Series of Numbers, Dates, and Other Data 

Entering a value series (such as January, February, and March or 1, 

2, 3, 4, and so on) is accomplished using the Fill feature discussed 

in the preceding section. When you use the Fill feature, Excel 

looks at the cell holding the data and tries to determine whether 

you want to just copy that information into the adjacent cells or use 

it as the starting point for a particular series of data. For example, 

with Monday entered in the first cell of the series, Excel 

automatically inserts Tuesday, Wednesday, and so on into the 

adjacent cells when you use the Fill feature. 

Sometimes Excel isn't quite sure whether you want to copy the 

data when you use Fill or create a series. This is where the Fill 

options shortcut box comes in. It enables you to select how the Fill 

feature should treat the data that you have "filled" into the adjacent 

cells. Figure 2.6 shows the creation of a data series using Fill. 

 

Figure 2.6. Fill can also be used to create a series of data in 

adjacent cells. 
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When you create a series using Fill, the series progresses by one 

increment. For example, a series starting with 1 would proceed to 

2, 3, 4, and so on. If you want to create a series that uses some 

increment other than 1, you must create a custom series. 

Entering a Custom Series 

If you want to create a series such as 10, 20, 30, where the series 

uses a custom increment between the values, you need to create a 

custom series. Excel provides two ways to create a custom series. 

To create a custom series using Fill, follow these steps: 

1. Enter the first value in the series into a cell. 

2. Enter the second value in the series into the next cell. For 

example, you might enter 10 into the first cell and then 20 

into the second cell. This lets Excel know that the increment 

for the series is 10. 



3. Select both cells by clicking the first cell and dragging over 

the second cell. 

4. Drag the fill handle of the second cell to the other cells that 

will be part of the series. Excel analyzes the two cells, sees 

the incremental pattern, and re-creates it in subsequent cells. 

You can also create a custom series using the Series dialog box. 

This enables you to specify the increment or step value for the 

series and even specify a stop value for the series. 

1. Enter the first value in the series into a cell. 

2. Select the cells that you want included in the series. 

3. Select the Edit menu, point at Fill, and then select Series. The 

Series dialog box opens  

4. Figure 2.7. The Series dialog box enables you to create a 

custom series. 

 

1. Enter the Step Value for the series. You can also enter a Stop 

Value for the series if you did not select the cells used for the 

series in step 2. For example, if you want to add a series to a 

column of cells and have clicked in the first cell that will 

receive a value, using a Stop Value (such as 100 for a series 

that will go from 1 to 100) will "stop" entering values in the 

cells when it reaches 100—the Stop Value. 

2. Click OK to create the series. 



Taking Advantage of AutoComplete 

Another useful feature that Excel provides to help take some of the 

drudgery out of entering information into a workbook is the 

AutoComplete feature. Excel keeps a list of all the labels that you 

enter on a worksheet by column. For example, suppose you have a 

worksheet tracking sales in Europe and you are entering country 

names, such as Germany, Italy, and so on, multiple times into a 

particular column in the worksheet. After you enter Germany the 

first time, it becomes part of the AutoComplete list for that 

column. The next time you enter the letter G into a cell in that 

column, Excel completes the entry as "Germany." 

You can also select an entry from the AutoComplete list. This 

allows you to see the entire list of available entries. Follow these 

steps: 

1. Enter your text and value data as needed onto the worksheet. 

2. If you want to select a text entry from the AutoComplete list, 

to fill an empty cell, right-click that cell. A shortcut menu 

appears. 

3. Select Pick from List from the shortcut menu. A list of text 

entries (in alphabetical order) appears below the current cell. 

4. Click a word in the list to insert it into the current, empty cell. 

 

 

Performing Simple Calculations— 

Understanding Excel Formulas 

One way to add calculations to an Excel workbook is to create 

your own formulas. Formulas are typically used to perform 

calculations such as addition, subtraction, multiplication, and 

division. More complex calculations are better left to Excel 



functions, which is a built-in set of formulas that provide financial, 

mathematical, and statistical calculations. You learn more about 

functions in Lesson 5, "Performing Calculations with Functions." 

Formulas that you create typically include cell addresses that 

reference cells on which you want to perform a calculation. 

Formulas also consist of mathematical operators, such as + 

(addition) or * (multiplication). For example, if you wanted to 

multiply two cells, such as C3 and D3, and then divide the product 

by 3, you would design a formula that looks like this: 

=(C3*D3)/3 

Notice that the formula begins with the equal sign (=). This lets 

Excel know that the information that you are placing in the cell is 

meant to do a calculation. The parentheses are used to let Excel 

know that you want C3 multiplied by D3 before the result is 

divided by 3. Creating appropriate formulas requires an 

understanding of the order of mathematical operations, or what is 

often called the rules of precedence. The natural order of math 

operations is covered in the next section. 

Formula Operators 

As previously mentioned, you can create formulas that add, 

subtract, and multiply cells in the worksheet. Table 3.1 lists some 

of the operators that you can use and how you would use them in a 

simple formula 

Table 3.1. Excel's Mathematical Operators 

Operator Performs Sample 

Formula 

Result 

^ Exponentiation =A1^3 Enters the result of raising 

the value in cell A1 to the 
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Table 3.1. Excel's Mathematical Operators 

Operator Performs Sample 

Formula 

Result 

third power 

+ Addition =A1+A2 Enters the total of the 

values in cells A1 and A2 

– Subtraction =A1–A2 Subtracts the value in cell 

A2 from the value in cell 

A1 

* Multiplication =A2*A3 Multiplies the value in cell 

A2 by cell A3 

/ Division =A1/B1 Divides the value in cell 

A1 by the value in cell B1 

shows some formulas that have been created for an Excel 

worksheet. So that you can see how I wrote the formulas, I've 

configured Excel so that it shows the formula that has been placed 

in a cell rather than the results of the formula (which is what you 

would normally see). 

Figure 3.1. You can create formulas to do simple calculations in 

your worksheets. 



 

Order of Operations 

The order of operations, or operator precedence, simply means that 

some operations take precedence over other operations in a 

formula. For example, in the formula =C2+D2*E2, the 

multiplication of D2 times E2 takes precedence, so D2 is 

multiplied by E2 and then the value in cell C2 is added to the 

result. 

You can force the precedence of an operation by using 

parentheses. For example, if you want C2 and D2 added before 

they are multiplied by E2, the formula would have to be written 

=(C2+D2)*E2. 

The natural order of math operators follows: 

1. Exponent (^) and calculations within parentheses 

2. Multiplication (*) and division (/) 

3. Addition (+) and subtraction (–) 



In the case of operations such as multiplication and division, which 

operate at the same level in the natural order, a formula containing 

the multiplication operator followed by the division operator will 

execute these operators in the order they appear in the formula 

from left to right. If you don't take this order into consideration, 

you could run into problems when entering your formulas. For 

example, if you want to determine the average of the values in 

cells A1, B1, and C1, and you enter =A1+B1+C1/3, you'll get the 

wrong answer. The value in C1 will be divided by 3, and that result 

will be added to A1+B1. To determine the total of A1 through C1 

first, you must enclose that group of values in parentheses: 

=(A1+B1+C1)/3. 

 

Entering Formulas 

You can enter formulas in one of two ways: by typing the entire 

formula, including the cell addresses, or by typing the formula 

operators and selecting the cell references. Take a look at both 

ways. 

To type a formula, perform the following steps: 

1. Select the cell where you will place the formula. 

2. Type an equal sign (=) into the cell to begin the formula. 

3. Enter the appropriate cell references and operators for the 

formula. Figure 3.2 shows a simple multiplication formula. 

The formula also appears in the Formula bar as you type it. 

The cells that you specify in the formula are highlighted with 

a colored border. 

Figure 3.2. The formula appears in the cell and in the 

Formula bar as you type it. 
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1. Press Enter when you have finished the formula, and Excel 

calculates the result. 

To enter a formula by selecting cell addresses, follow these steps: 

1. Click in the cell where you will place the formula. 

2. Type the equal sign (=) to begin the formula. 

3. Click the cell whose address you want to appear first in the 

formula. You can also click a cell in a different worksheet or 

workbook. The cell address appears in the cell and in the 

Formula bar. 

4. Type a mathematical operator after the value to indicate the 

next operation you want to perform. The operator appears in 

the cell and in the Formula bar. 

5. Continue clicking cells and typing operators until the formula 

is complete. 

6. Press Enter to accept the formula and have Excel place its 

results into the cell. 



Using the Status Bar AutoCalculate Feature 

Using a feature that Excel calls, you can view the sum of a column 

of cells simply by selecting the cells and looking at the status bar. 

The values in the selected cells are added. You can also right-click 

the AutoCalculate area of the status bar and choose different 

formulas, such as average, minimum, maximum, and count. 

This feature is useful if you want to quickly check the total for a 

group of cells or compute the average. It also allows you to "try 

out" an Excel function (discussed in Lesson 5) before actually 

entering it into a cell. You can also view the average, minimum, 

maximum, and count of a range of cells. To display something 

other than the sum, highlight the group of cells you want the 

operation performed on, right-click the status bar, and select the 

option you want from the shortcut menu that appears (see Figure 

3.3). 

Figure 3.3. You can view the results of different built-in 

formulas in the status bar. 
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Displaying Formulas 

Normally, Excel does not display the formula in a cell. Instead, it 

displays the result of the calculation. You can view the formula by 

selecting the cell and looking in the Formula bar. However, if 

you're trying to review all the formulas in a large worksheet, it 

would be easier if you could see them all at once (and even print 

them). If you want to view formulas in a worksheet, follow these 

steps: 

1. Open the Tools menu and choose Options. 

2. Click the View tab. 

3. In the Window options area of the View tab (near the bottom 

of the tab), click to select the Formulas check box. 

4. Click OK. 

Editing Formulas 

Editing a formula is the same as editing any entry in Excel. The 

following steps show how you do it: 

1. Select the cell that contains the formula you want to edit. 

2. Click in the Formula bar to place the insertion point in the 

formula, or press F2 to enter Edit mode (the insertion point is 

placed at the end of the entry in that cell). 

3. Press the left-arrow key or the right-arrow key to move the 

insertion point within the formula. Then, use the Backspace 

key to delete characters to the left, or use the Delete key to 

delete characters to the right. Type any additional characters. 

4. When you finish editing the data, click the Enter button on 

the Formula bar or press Enter to accept your changes 

 

Performing Calculations with Functions— 



What Are Functions? 

Functions are ready-made formulas that perform a series of 

operations on a specified range of values. For example, to 

determine the sum of a series of numbers in cells A1 through H1, 

you can enter the function =SUM(A1:H1). Excel functions can do 

all kinds of calculations for all kinds of purposes, including 

financial and statistical calculations. 

Every function consists of the following three elements: 

• The = sign, which indicates that what follows is a function 

(formula). 

• The function name, such as SUM, that indicates which 

operation will be performed. 

• A list of cell addresses, such as (A1:H1), which are to be 

acted upon by the function. Some functions can include more 

than one set of cell addresses, which are separated by 

commas (such as A1,B1,H1). 

You can enter functions into the worksheet by typing the function 

and cell references (as you did with your own formulas), or you 

can use the Insert Function feature, which walks you through the 

process of creating a function in a worksheet (you will work with 

the Insert Function feature in a moment). Table 5.1 lists some of 

the Excel functions that you will probably use most often in your 

worksheets 

 

 

Commonly Used Excel Functions 

Function Example Description 

AVERAGE =AVERAGE(B4:B9) Calculates the mean 

or average of a 
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Function Example Description 

group of cell values. 

COUNT =COUNT(A3:A7) Counts the number 

of cells that hold 

values in the 

selected range or 

group of cells. This 

can also be used to 

tell you how many 

cells are in a 

particular column, 

which tells you how 

many rows are in 

your spreadsheet. 

IF =IF(A3>=1000,"BONUS","NO 

BONUS") 

Allows you to place 

a conditional 

function in a cell. In 

this example, if A3 

is greater than or 

equal to 1000, the 

true value, BONUS, 

is used. If A3 is less 

than 1000, the false 

value, NO BONUS, 

is placed in the cell. 

MAX =MAX(B4:B10) Returns the 

maximum value in a 

range of cells. 

MIN =MIN(B4:B10) Returns the 

minimum value in a 

range of cells. 

PMT =PMT(.0825/12,360,180000) Calculates the 



Function Example Description 

monthly payment on 

a 30-year loan (360 

monthly payments) 

at 8.25% a year 

(.0825/12 a month) 

for $180,000. 

SUM =SUM(A1:A10) Calculates the total 

in a range of cells. 

 

Using AutoSum 

Adding a group of cells is probably one of the most often-used 

calculations in an Excel worksheet. Because of this fact, Excel 

makes it very easy for you to place the SUM function into a cell. 

Excel provides the AutoSum button on the Standard toolbar. 

AutoSum looks at a column or row of cell values and tries to select 

the cells that should be included in the SUM function. 

To use AutoSum, follow these steps: 

1. Select the cell where you want to place the SUM function. 

Typically, you will choose a cell that is at the bottom of a 

column of values or at the end of a row of data. This makes it 

easy for AutoSum to figure out the range of cells that it 

should include in the SUM function. 

2. Click the AutoSum button on the Standard toolbar. 

AutoSum inserts =SUM and the cell addresses that it thinks 

should be included in the function 

 

AutoSum inserts the SUM function and selects the cells that will 

be totaled by the function. 

 



 
 

1. If the range of cell addresses that AutoSum selected is 

incorrect, use the mouse to drag and select the appropriate 

group of cells. 

2. Press the Enter key. AutoSum calculates the total for the 

selected range of cells. 

Using the Insert Function Feature 

After you become familiar with a function or a group of functions, 

you place a particular function in an Excel worksheet by typing the 

function name and the cells to be referenced by the function (the 

same as you have done for formulas that you create as outlined in 

Lesson 3). However, when you are first starting out with functions, 

you will find it much easier to create them using the Insert 

Function feature. The Insert Function feature leads you through the 

process of inserting a function and specifying the appropriate cell 

addresses in the function. 
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For example, suppose you want to compute the average, 

maximum, and minimum of a group of cells that contain the 

weekly commissions for your sales force. Figure 5.2 shows how 

these three functions would look on a worksheet (the display has 

been changed in Excel to show you the functions rather than their 

results). You could use the Insert Function feature to create any or 

all of these functions. 

Figure 5.2. Functions such as Average, MIN, and MAX can be 

placed into a worksheet using the Insert Function feature. 

 

 
 

To use the Insert Function feature, follow these steps: 

1. Click in the cell where you want to place the function. 
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2. Click the arrow button next to the AutoSum button and 

select More Functions. The Insert Function dialog box 

appears (see Figure 5.3). 

Figure 5.3. The Insert Function dialog box helps you select 

the function you want to use 

 
 

1. To search for a particular function, type a brief description of 

what you want to do in the Search for a Function box (for 

example, you could type monthly payment and Excel would 

show you financial functions that help you calculate monthly 

payments), and then click Go to conduct the search. You also 

can select a function category, such as Financial or 

Statistical, using the Select a Category drop-down box. In 

either case, a list of functions is provided in the Select a 

Function dialog box. 

2. From the Functions list, select the function you want to 

insert. Then click OK. The Function Arguments dialog box 

appears. This dialog box allows you to specify the range of 
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cells (some functions require multiple ranges of cells) that the 

function acts upon (see Figure 5.4). 

Figure 5.4. The Function Arguments dialog box is where 

you specify the cells that will be acted upon by the function 

 

1. Next, you must enter the range of cells that will be acted 

upon by the function. Click the Collapse button on the far 

right of the Number1 text box in the Function Arguments 

dialog box. This returns you to the worksheet. 

2. Use the mouse to select the cells that you want to place in the 

function (see Figure 5.5). Then click the Expand button on 

the right of the Function Arguments dialog box. 

Figure 5.5. The Function Arguments dialog box collapses 

and allows you to select the cells that will be acted upon by 

the function. 
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1. Click OK. Excel inserts the function and cell addresses for 

the function into the selected cell and displays the result. 

If you find that you would like to edit the list of cells acted upon 

by a particular function, select the cell that holds the function and 

click the Insert Function button on the Formula bar. The Function 

Arguments dialog box for the function appears. Select a new range 

of cells for the function, as discussed in steps 4 and 5. 

Excel 2003 also makes it easy for you to bypass the Insert Function 

dialog box and insert commonly used functions such as Average, 

Count, Max, and Min. Click the arrow to the right of the AutoSum 

button on the Excel Standard toolbar and select a function from the 

list provided. To complete the function select the range of cells that 

you want the function to act on, and then press the Enter key. 

 

 

 

 



Freezing Column and Row Labels 

When you work with very large worksheets, it can be very 

annoying as you scroll to the right or down through the worksheet 

when you can no longer see your row headings or column 

headings, respectively. For example, you might be entering 

customer data where the customer's name is in the first column of 

the worksheet, and when you scroll to the extreme right to enter 

data, you can no longer see the customer names. 

You can freeze your column and row labels so that you can view 

them no matter how far you scroll down or to the right in your 

worksheet. For example, Figure 7.2 shows frozen column labels 

(columns A and B, which include the first names and last names) 

that allow you to see the customer names no matter how far you 

move to the right of the worksheet. 

Figure 7.2. You can freeze row and column headings so that they 

remain onscreen as you scroll. 

 
 

To freeze row or column headings (or both), follow these steps: 
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1. Click the cell to the right of the row labels and/or below any 

column labels you want to freeze. This highlights the cell. 

2. Select the Window menu, and then select Freeze Panes. 

You might want to experiment on a large worksheet. Freeze the 

column and row headings, and then use the keyboard or the mouse 

to move around in the worksheet. As you do, the row and/or 

column headings remain locked in their positions. This enables you 

to view data in other parts of the worksheet without losing track of 

what that data represents. 

When you have finished working with the frozen column and row 

headings, you can easily unfreeze them. Select the Window menu 

again and select Unfreeze Panes. 

 

 

 

 

Using AutoFormat 

If you don't want to take the time to test different border types and 

shading styles, you can let Excel help you with the task of adding 

some emphasis and interest to the cells of your worksheet. You can 

take advantage of AutoFormat, which provides various 

predesigned table formats that you can apply to a worksheet. 

To use predesigned formats, perform the following steps: 

1. Select the cell(s) that contain the data you want to format. 

This could be the entire worksheet. 

2. Select the Format menu, and then select AutoFormat. The 

AutoFormat dialog box appears  



Select a format from the AutoFormat dialog box. 

 

 

 

 

1. Scroll through the list to view the various AutoFormat styles 

provided. When you find a format that you want to use, click 

it to select it. 

2. To prevent AutoFormat from overwriting certain existing 

formatting (such as numbers, alignment, or fonts), click the 

Options button and deselect the appropriate check boxes. 

3. Click OK and your worksheet is formatted. 

Applying Conditional Formatting 

Another useful formatting feature that Excel provides is 

conditional formatting. Conditional formatting allows you to 



specify that certain results in the worksheet be formatted so that 

they stand out from the other entries in the worksheet. For 

example, if you wanted to track all the monthly sales figures that 

are below a certain amount, you can use conditional formatting to 

format them in red. Conditional formatting formats only cells that 

meet a certain condition. 

To apply conditional formatting, follow these steps: 

1. Select the cells to which you want to apply the conditional 

formatting. 

2. Select the Format menu and select Conditional Formatting. 

The Conditional Formatting dialog box appears 

3. Figure 10.4. Apply formats conditionally to highlight 

certain values. 

 

 

1. Be sure that Cell Value Is is selected in the Condition 1 drop-

down box on the left of the dialog box. 

2. In the next drop-down box to the right, you select the 

condition. The default is Between. Other conditions include 

Equal To, Greater Than, Less Than, and other possibilities. 

Use the drop-down box to select the appropriate condition. 

3. After selecting the condition, you must specify a cell or cells 

in the worksheet that Excel can use as a reference for the 

conditional formatting. For example, if you select Less Than 



as the condition, you must specify a cell in the worksheet that 

contains a value that can be used for comparison with the 

cells that you are applying the conditional formatting to. 

Click the Shrink button on the Conditional Formatting dialog 

box. You are returned to the worksheet. Select the reference 

cell for the condition. 

4. Click the Expand button on the Conditional Formatting 

dialog box to expand the dialog box. 

5. Now you can set the formatting that will be applied to cells 

that meet your condition. Click the Format button in the 

Conditional Formatting dialog box and select the formatting 

options for your condition in the Format Cells dialog box. 

Then click OK. Figure 10.5 shows a conditional format that 

applies bold and italic to values that are greater than the value 

contained in cell F8. 

Figure 10.5. Set the various options for your conditional 

formatting. 

 

 

1. After setting the conditions to be met for conditional 

formatting (you can click Add to set more than one 

condition), click OK. 

You are returned to the worksheet. Cells that meet the condition 

you set up for conditional formatting will be formatted with the 

options you specified. Figure 10.6 shows cells that the settings 

used in Figure 10.5 conditionally formatted. 
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Figure 10.6. Conditional formatting formats only the cells that 

meet your conditions 

 

 

Inserting and Removing Cells, Rows, and Columns--- 

 

 

 

 

Understanding Charting Terminology— 

 

Charts enable you to create a graphical representation of data in a 

worksheet. You can use charts to make data more understandable 

to people who view your printed worksheets. Before you start 

creating charts, you should familiarize yourself with the following 

terminology: 

• Data Series— The bars, pie wedges, lines, or other elements 

that represent plotted values in a chart. For example, a chart 



might show a set of similar bars that reflects a series of 

values for the same item. The bars in the same data series 

would all have the same pattern. If you have more than one 

pattern of bars, each pattern would represent a separate data 

series. For example, charting the sales for Territory 1 versus 

Territory 2 would require two data series—one for each 

territory. Often, data series correspond to rows of data in 

your worksheet (although they can correspond to columns of 

data if that is how you have arranged the information in your 

worksheet). 

• Categories— Categories reflect the number of elements in a 

series. You might have two data series that compare the sales 

of two territories and four categories that compare these sales 

over four quarters. Some charts have only one category, and 

others have several. Categories normally correspond to the 

columns in your worksheet, with the category labels coming 

from the column headings. 

• Axis— One side of a chart. A two-dimensional chart has an 

x-axis (horizontal) and a y-axis (vertical). The x-axis contains 

the data series and categories in the chart. If you have more 

than one category, the x-axis often contains labels that define 

what each category represents. The y-axis reflects the values 

of the bars, lines, or plot points. In a three-dimensional chart, 

the z-axis represents the vertical plane, and the x-axis 

(distance) and y-axis (width) represent the two sides on the 

floor of the chart. 

• Legend— Defines the separate series of a chart. For example, 

the legend for a pie chart shows what each piece of the pie 

represents. 

• Gridlines— Typically, gridlines appear along the y-axis of 

the chart. The y-axis is where your values are displayed, 

although they can emanate from the x-axis as well (the x-axis 

is where label information normally appears on the chart). 

Gridlines help you determine a point's exact value. 



 

Working with Different Chart Types 

With Excel, you can create many types of charts. Some common 

chart types are shown in Figure 15.1. The chart type you choose 

depends on the kind of data you're trying to chart and on how you 

want to present that data. The following are the major chart types 

and their purposes: 

• Pie— Use this chart type to show the relationship among 

parts of a whole. 

• Bar— Use this chart type to compare values at a given point 

in time. 

• Column— Similar to the bar chart; use this chart type to 

emphasize the difference between items. 

• Line— Use this chart type to emphasize trends and the 

change of values over time. 

• Scatter— Similar to a line chart; use this chart type to 

emphasize the difference between two sets of values. 

• Area— Similar to the line chart; use this chart type to 

emphasize the amount of change in values over time. 

Figure 15.1. Excel chart types enable you to analyze and present 

your data. 
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Most of these basic chart types also come in three-dimensional 

varieties. In addition to looking more professional than the 

standard flat charts, 3D charts can often help your audience 

distinguish between different sets of data. 

Creating and Saving a Chart 

You can place your new chart on the same worksheet that contains 

the chart data (an embedded chart) or on a separate worksheet (a 

chart sheet). If you create an embedded chart, it is typically printed 

side by side with your worksheet data. Embedded charts are useful 

for showing the actual data and its graphical representation side by 

side. If you create a chart on a separate worksheet, however, you 

can print it independently. Both types of charts are linked to the 

worksheet data that they represent, so when you change the data, 

the chart is automatically updated. 

The Chart Wizard button on the Standard toolbar enables you to 

quickly create a chart. To use the Chart Wizard, follow these steps: 



1. Select the data you want to chart. If you typed column or row 

labels (such as Qtr 1, Qtr 2, and so on) that you want 

included in the chart, be sure you select those, too. 

2. Click the Chart Wizard button on the Standard toolbar. 

3. The Chart Wizard - Step 1 of 4 dialog box appears (see 

Figure 15.2). Select a Chart Type and a Chart Sub-Type (a 

variation on the selected chart type). Click Next. 

Figure 15.2. Choose the chart type using the Chart Wizard. 

 

 

1. Next, Excel asks whether the selected range is correct. You 

can correct the range by typing a new range or by clicking 

the Shrink button (located at the right end of the Data Range 

text box) and selecting the range you want to use. 
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2. By default, Excel assumes that your different data series are 

stored in rows. You can change this to columns if necessary 

by clicking the Series in Columns option. When you're ready 

for the next step, click Next. 

3. Click the various tabs to change options for your chart (see 

Figure 15.3). For example, you can delete the legend by 

clicking the Legend tab and deselecting Show Legend. You 

can add a chart title on the Titles tab. Add data labels (labels 

that display the actual value being represented by each bar, 

line, and so on) by clicking the Data Labels tab. When you 

finish making changes, click Next. 

4.  
5. Figure 15.3. Select from various chart appearance options. 

 

 
 

1. Finally, Excel asks whether you want to embed the chart (as 

an object) in the current worksheet (or any other existing 

worksheet in the workbook) or if you want to create a new 
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worksheet for it. Make your selection and click the Finish 

button. Your completed chart appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

MS-POWER POINT2003 

 

 

Starting PowerPoint 

PowerPoint is a powerful application that enables you to create 

presentations that can be viewed on a computer. Using 

PowerPoint, you can print handouts or create film slides for a 

presentation. PowerPoint also enables you to add animation and 

sound to your presentations, which makes it the perfect tool for 

business presentations or classroom lectures. 

To start PowerPoint, follow these steps: 



1. Click the Start button. 

2. Move your mouse pointer to Programs (All Programs on 

Windows XP). A menu of programs appears. Point at the 

Microsoft Office icon. 

3. Move your mouse pointer to the Microsoft Office 

PowerPoint icon and click it. The PowerPoint application 

window opens 

 

 

The first thing you see when you open PowerPoint is that the 

application window is divided into different areas. The default 

view for PowerPoint is the Normal view (you learn about the 

different PowerPoint views in Lesson 3, "Working with Slides in 

Different Views"). On the left of the screen is a pane that can be 

used to switch between an Outline and Slides view of the current 

presentation. In the center of the PowerPoint application window is 
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the Slide pane; this is where you work individually on each slide in 

the presentation. 

Below the Slide pane is the Notes pane, which enables you to add 

notes to the presentation for each slide. On the far right of the 

application window is the New Presentation task pane. The task 

pane provides different commands and features depending on what 

you are currently doing in PowerPoint. 

Exiting PowerPoint 

When you finish using PowerPoint, you can exit the application. 

This closes any open presentations (PowerPoint might prompt you 

to save changes to those presentations). 

To exit PowerPoint, perform one of the following: 

• Click the PowerPoint window's Close (X) button. 

• Double-click the Control Menu icon in the left corner of the 

title bar, or click it once to open the Control menu and then 

select Close. 

• Open the File menu and select Exit. 

• Press Alt+F4. 

Starting a New Presentation 

PowerPoint offers several ways to create a new presentation. 

Before you begin, decide which method is right for you: 

• The AutoContent Wizard offers the highest degree of help. It 

walks you through each step of creating the new presentation. 

When you're finished, you have a standardized group of 

slides, all with a similar look and feel, for a particular 

situation. Each slide created includes dummy text that you 

can replace with your own text. 



• A design template provides a professionally designed color, 

background, and font scheme that applies to the slides you 

create yourself. It does not provide sample slides. 

• You can also start a new presentation based on an existing 

presentation. This "copies" all the slides in the existing 

presentation and allows you to save the new presentation 

under a new filename. 

• You can start from scratch and create a totally blank 

presentation. That means that you build the presentation from 

the ground up and create each slide in the presentation. 

(Beginners might want to use the wizard or templates until 

they get a feel for the overall design approach used to create 

a cohesive slide presentation.) 

 

Creating a New Presentation with the AutoContent Wizard 

With the AutoContent Wizard, you select the type of presentation 

you want to create (such as corporate, sales, or various projects), 

and PowerPoint creates an outline for the presentation. 

The following steps describe how you use the AutoContent 

Wizard: 

1. Select the File menu and select New. The New Presentation 

task pane appears on the right of the PowerPoint window, as 

shown in Figure 2.1 (if the Presentation task pane was 

already open in the window, you can skip to step 2). 
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1. Click the From AutoContent Wizard link on the task pane. 

2. The AutoContent Wizard starts. The opening wizard screen 

summarizes the process you should follow to create a new 

presentation. Click Next to continue. 

3. The wizard provides you with category buttons for different 

categories of presentations: General, Corporate, Projects, and 

Sales/Marketing. Select a category by selecting the 

appropriate button (see Figure 2.2). A list of specific 

presentations will appear to the right of the category buttons. 

To see all the AutoContent presentations available, click the 

All button 
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1. After selecting a particular category of presentations, select a 

presentation type in the list provided. You can choose to 

create a generic presentation, or presentations recommending 

a strategy, communicating bad news, or for a brainstorming 

session (among others). After selecting the type of 

presentation (I selected generic), click Next to continue. 

2. On the next screen, you select how you will give the 

presentation. Select one of the following options: 

o Onscreen Presentation— Choose this if you plan to use 

a computer and your PowerPoint file to present the 

show. 

o Web Presentation— Choose this if you are planning to 

distribute the presentation as a self-running or user-

interactive show. 

o Black-and-White Overheads— Choose this if you plan 

to make black-and-white transparencies for your show. 

o Color Overheads— Choose this if you plan to make 

color transparencies for your show. 



o 35mm Slides— Choose this if you plan to send your 

PowerPoint presentation to a service bureau to have 

35mm slides made. (You probably don't have such 

expensive and specialized equipment in your own 

company.) 

3. After selecting how you will give the presentation, click Next 

to continue. 

4. On the next screen, type the presentation title into the text 

box provided (see Figure 2.3). If you want to add a footer 

(such as your name or other) that will appear at the bottom of 

each slide of the presentation, click in the Footer box and 

type the appropriate text. If you do not want a date and/or 

slide number on each slide, deselect the Date Last Updated 

and/or Slide Number check boxes. 

 

 

1. After supplying the presentation title and any optional 

information, click Next to continue. 

2. PowerPoint takes you to the last wizard screen, where you 

should simply click Finish. 
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The title slide of your new presentation appears in the Slide pane. 

The entire presentation, including the dummy text placed on each 

slide, appears in the Outline pane on the left of the PowerPoint 

window (see Figure 2.4). 

 

 

You can start working on your presentation right away by 

replacing the dummy text on the slides with your own text. Just 

select the existing text in a text box and type right over it. You 

learn about editing text in slide text boxes in Lesson 7, "Adding 

and Modifying Slide Text." 

Creating a New Presentation with a Design Template 

A template is the middle ground between maximum hand-holding 

(the AutoContent Wizard) and no help at all (Blank Presentation). 

Two kinds of templates are available: presentation templates and 

design templates. 
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When you use the AutoContent Wizard, you use a presentation 

template. It contains not only formatting, but also sample slides 

that contain placeholder text. The other kind of template is a design 

template. It contains the overall formatting for the slides of the 

presentation but does not actually create any slides. If you want to 

use a presentation template that includes placeholder text, use the 

AutoContent Wizard, as explained in the preceding section. 

To start a new presentation using a design template, follow these 

steps: 

1. Select the File menu and select New. The New Presentation 

task pane appears on the right of the PowerPoint window. 

Select Your Task Pane If the task pane is already open for another 

PowerPoint feature, click the drop-down arrow on its title bar and 

select New Presentation from the list that appears 

1. On the New Presentation task pane, click the From Design 

Template link. PowerPoint switches to the Slide Design side 

pane, which displays a list of design templates, as shown in 

Figure 2.5. A blank title slide for the presentation appears in 

the Slide pane. 

Figure 2.5. Design templates are listed in the task pane. 
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1. Click a template from the Available For Use section of the 

task pane. PowerPoint then formats the title slide in the Slide 

pane using the selected template. 

You can select different templates to determine the best look for 

your presentation. When you have found the design template that 

you want to use, you can immediately start working on the slides 

for the presentation 

Creating a New Presentation from an Existing Presentation 

Another alternative for creating a new presentation is to use an 

existing presentation. This creates a copy of the existing 



presentation (and all its slides) and allows you to quickly save the 

presentation under a new filename. 

1. Select the File menu and select New. The New Presentation 

task pane appears on the right of the PowerPoint window. 

2. Select From Existing Presentation in the New Presentation 

task pane. The New from Existing Presentation dialog box 

open 

 

Open the existing presentation that the new presentation will 

be based on 

 

 

 

1. Use the Look in drop-down list to locate the drive and the 

folder that holds the existing presentation. When you locate 

the existing presentation, select it and then click Create New. 



2. A "copy" of the existing presentation will open in the 

PowerPoint window. 

When you have the copy of the existing presentation open, you can 

edit it as needed. You can then save the presentation under a new 

filename as discussed later in this lesson. 

Creating a Blank Presentation 

Your fourth option for creating a new presentation is to create a 

blank presentation. This means that you have to create all the slides 

from scratch. A design for the slides can then be selected using the 

Slide Design task pane. You open this task pane by selecting 

Format, Slide Design. In the Slide Design task pane, be sure that 

the Design Templates icon is selected. 

 

 

 

Saving a Presentation 

After you create a new presentation, it makes sense to save it. To 

save a presentation for the first time, follow these steps: 

1. Select File, Save, or just click the Save button on the 

Standard toolbar. The Save As dialog box appears  

 

 



 

1. In the File Name text box, type the name you want to assign 

to the presentation. Your filenames can be as long as 255 

characters and can include spaces. 

2. The Save In box shows in which folder the file will be saved. 

The default is My Documents. To select a different drive 

location for the file, click the Save In drop-down arrow and 

select one from the list that appears. To save to a specific 

folder in the drive location you've selected, double-click the 

folder in which you want to store the file. 

3. Click Save. 

Now that you have named the file and saved it to a disk, you can 

save any changes you make simply by pressing Ctrl+S or clicking 

the Save button on the Standard toolbar. Your data is saved under 

the filename you assigned to the presentation in the Save As dialog 

box. 

To create a copy of a presentation under a different filename or 

location, select File, Save As. The Save As dialog box reappears; 



follow steps 2 to 4 as discussed in this section to give the file a 

new name or location. 

 

Opening a Presentation 

A presentation, like Rome, is not built in a day, so you will 

probably fine-tune a presentation over time. To open a saved 

presentation file that you want to work on, follow these steps: 

 

Select File, Open, or click the Open button on the Standard toolbar. 

The Open dialog box appears 

 

 

 

 



1. If the file isn't in the currently displayed folder, select the 

Look In drop-down arrow to choose from a list of other 

drives and/or folders. 

2. Browse to the location containing the file and double-click it 

to open it in PowerPoint. 

Finding a Presentation File 

If you're having trouble locating your file, PowerPoint can help 

you look. Follow these steps to find a file: 

1. Select File, Open (if the Open dialog box is not already 

open). 

2. Click the Tools drop-down button in the Open dialog box and 

select Search. The File Search dialog box appears ( 

Use the File Search dialog box to find a presentation on your 

computer 

 



 
 

1. In the Search Text box, type text that is contained in the 

presentation's filename. Use the Search In box to specify 

where you want the search to be conducted. In the Results 

Should Be box, specify the file types you want to be included 

in the search. 

2. When you are ready to conduct the search, click the Search 

button. 

3. Files that meet the search criteria are listed in the Results box 

(if you see your file in the Results box and the search is 

continuing, click the Stop button). 

4. To open a file in the Results box, double-click the filename. 

5. You are returned to the Open dialog box with the file listed in 

the File Name box. Click OK to open the file. A PowerPoint 

presentation then opens in the PowerPoint window. 



Understanding PowerPoint's Different Views 

PowerPoint can display your presentation in different views. Each 

of these views is designed for you to perform certain tasks as you 

create and edit a presentation. For example, Normal view has the 

Outline/Slides, Slide, and Notes panes; it provides an ideal 

environment for creating your presentation slides and for quickly 

viewing the organization of the slides or the information in the 

presentation (using the Outline or the Slides tabs). Another view, 

the Slide Sorter view, enables you to quickly rearrange the slides in 

the presentation (and is similar to the Slides view that shares the 

pane with the Outline tab when you are in the Normal view). 

To change views, open the View menu and choose the desired 

view: Normal, Slide Sorter, Slide Show, or Notes Page. 

• Normal— The default, three-pane view (which is discussed 

in Lesson 1, "Working in PowerPoint"). 

• Slide Sorter— This view shows all the slides as thumbnails 

so that you can easily rearrange them by dragging slides to 

new positions in the presentation  
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• Slide Show— A specialized view that enables you to preview 

and present your show onscreen. It enables you to test the 

presentation as you add slides, and it is used later when your 

presentation is complete. 

• Notes Page— This view provides a large pane for creating 

notes for your speech. You can also type these notes in 

Normal view, but Notes Page view gives you more room and 

allows you to concentrate on your note text. 

An even faster way to switch to certain views is to use the view 

buttons that are provided along the lower-left corner of the 

PowerPoint window. These buttons, from left to right, are Normal 

View, Slide Sorter View, and Slide Show (from current slide) 

button. A button not provided for the Notes view 



Moving from Slide to Slide 

PowerPoint provides several ways to move from slide to slide in 

the presentation. The particular view you are in somewhat controls 

the procedure for moving to a specific slide. 

In the Normal view, you can move from slide to slide using these 

techniques: 

• Click the Outline tab on the far left of the window. To go to a 

particular slide in the outline, click the slide icon next to the 

slide number (see Figure 3.2). The slide opens in the Slide 

pane. 

• Press the Page Up or Page Down keys to move to the 

previous or next slide, respectively. 

• Click the Previous Slide or Next Slide button just below the 

vertical scrollbar (refer to Figure 3.2), or drag the scroll box 

inside the vertical scrollbar until the desired slide number is 

displayed. 

• Click the Slides tab on the far left of the PowerPoint window. 

This enables you to move from slide to slide in the Normal 

view by selecting a particular slide's thumbnail. When you 

click the thumbnail, the slide appears in the Slide pane. 

You can also move from slide to slide in other views, such as the 

Slide Sorter view or the Slide Show view. In the Slide Sorter view 

(refer to Figure 3.1), just click a slide's thumbnail to move to that 

slide. You then can use any of the tools that PowerPoint provides 

to format the selected slide (or delete it). If you want to actually 

open a slide when you are working in the Slide Sorter view, so that 

you can edit the text it contains, double-click the slide. You are 

returned to the Normal view. 

When you are actually showing a presentation in the Slide 

Show view, you can use the Page Up or Page Down keys to 

move from slide to slide (unless you have set up timers to 
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change slides). You can also click a slide with the mouse to 

move to the next slide. You learn more about the Slide Show 

view in Lesson 12, "Presenting an Onscreen Slide Introduction 

to Inserting Slide Text 

If you created a presentation in Lesson 2 using the AutoContent 

Wizard, you already have a presentation that contains several 

slides, but they won't contain the text you want to use. Slides 

created by the wizard contain placeholder text that you must 

replace. If you created a blank presentation or based a new 

presentation on a design template, you have only a title slide in that 

presentation, which, of course, needs to be personalized for your 

particular presentation. This means that additional slides will need 

to be added to the presentation. Lesson 5, "Inserting, Deleting, and 

Copying Slides," covers the creation of new slides for a 

presentation. 

The sections that follow in this lesson look at the basics of 

inserting text into the text boxes provided on slides. You will look 

at adding new text boxes and formatting text in text boxes in 

Lesson 7, "Adding and Modifying Slide Text." Upcoming lessons 

also discuss how to add pictures and other objects to your 

PowerPoint slides. 

Editing Text in the Slide Pane 

The text on your slides resides within boxes (all objects appear on 

a slide in their own boxes for easy manipulation). As shown in 

Figure 3.3, to edit text on a slide, click the text box to select it and 

then click where you want the insertion point moved, or select the 

text you want to replace 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch104.html#ch104
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch02.html#ch02
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch97.html#ch97
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch99.html#ch99
mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch95lev1sec4.html#ch95fig03#ch95fig03


 

 

 

When you work with the Slide pane, you might want to close the 

Outline/Slides pane. Just click the pane's Close button (X) to 

provide the Slide pane with the entire PowerPoint window (refer to 

Figure 3.3). In Lesson 7, "Adding and Modifying Slide Text," 

you'll learn more about adding text to a slide, including creating 

your own text boxes on a slide. 

Editing Text in the Outline Pane 

The Outline pane provides another way to edit text in a slide. To 

switch to the Outline view on the Outline/Slides pane, click the 

Outline tab. You simply click to move the insertion point where 

you want it (or select the range of text you want to replace) in the 

outline, and then type your text (see Figure 3.4). If you've placed 

the insertion point in the slide text (without selecting a range), 
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press the Delete key to delete characters to the right of the insertion 

point or press the Backspace key to delete characters to the left. If 

you've selected a range of text, either of these keys deletes the text. 

If you want to move the highlighted text, simply drag it to where 

you want it moved. 

 

Moving Text in the Outline Pane 

As you work in the Normal view, you can also view your 

presentation slides as an outline using the Outline pane. This 

provides you with a quick way to move text items around on a 

slide or move them from slide to slide. Just select the text and drag 

it to a new position. 

As already mentioned, you can also drag text from one slide to 

another. All you have to do is select a line of text in the Outline 

pane and drag it to another slide. You can also move a slide in the 

Outline pane. Drag the slide's icon in the Outline pane to a new 

position (under the heading for another slide). 



If you aren't that confident with your dragging skills, PowerPoint 

provides you with help in the form of the Outlining toolbar. It 

provides buttons that make it easy to move text up or down on a 

slide (with respect to other text on the slide) or to move a slide up 

or down in the presentation. 

To turn on the Outlining toolbar, right-click one of the PowerPoint 

toolbars and select Outlining. Figure 3.5 shows the Outlining 

toolbar on the left side of the Outline pane (the Outline pane has 

also been expanded to take up more of the PowerPoint window). 

• To move a paragraph or text line up in a slide, select it and 

click the Move Up button. 

• To move a paragraph or text down in a slide, select it and 

click the Move Down button 

 

 
 

You can also use the Move Up and Move Down buttons to move 

entire slides up or down in the presentation. Click the slide's icon 

and then use the appropriate button (it might take several clicks to 

move a slide up or down with respect to another slide). 
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If you want to see how the text is actually formatted on the slides 

that you are viewing in the Outline pane, click the Show 

Formatting button on the Outlining toolbar. Viewing the text as it 

is formatted can help you determine where the text should appear 

on a slide as you move the text (or whether you will have to 

reformat the text later). 

Rearranging Text in the Outline Pane 

As you can see from Figure 3.5, your presentation is organized in a 

multilevel outline format. The slides are at the top level of the 

outline, and each slide's contents are subordinate under that slide. 

Some slides have multiple levels of subordination (for example, a 

bulleted list within a bulleted list). 

You can easily change an object's level in Outline view with the 

Tab key or the Outlining toolbar: 

• To demote a paragraph in the outline, click the text, and then 

press the Tab key or click the Demote button on the 

Outlining toolbar. 

• To promote a paragraph in the outline, click the text, and then 

press Shift+Tab or click the Promote button on the Outlining 

toolbar 

Giving Your Slides a Professional Look 

PowerPoint comes with dozens of professionally created designs 

and color schemes that you can apply to your presentations. These 

designs include background patterns, color choices, font choices, 

and more. When you apply a design template to your presentation, 

it applies its formatting to a special slide called the Slide Master. 

The Slide Master is not really a slide, but it looks like one. It is a 

master design grid that you make changes to; these changes affect 

every slide in the presentation. When you apply a template, you are 
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actually applying the template to the Slide Master, which in turn 

applies it to each slide in the presentation. 

Master Slide A slide that contains the master layout and 

color scheme for the slides in a presentation. 

 

You don't have to work with the Slide Master itself when you 

apply template or color scheme changes to your presentations. Just 

be aware that you can open the Slide Master (select View, point at 

Master, and then select Slide Master) and change the style and 

fonts used by the text boxes in a presentation (see Figure 4.1). You 

can also select a custom background color for the slides in the 

presentation. Any changes that you make to the Slide Master affect 

all the slides in the presentation. 

 
 

You will probably find that PowerPoint provides enough template 

and color scheme options that you won't need to format the Slide 

Master itself very often. Edit its properties only if you have a very 
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strict formatting need for the presentation that isn't covered in the 

templates and color schemes provided. For example, one good 

reason to edit the Slide Master would be a situation in which you 

want a graphic to appear on every slide (such as a company logo); 

you can place the image on the Slide Master instead of pasting it 

onto each slide individually. 

 

Close the Slide Master If you open the Slide Master, you can 

close it by clicking Close Master View on the Master View 

toolbar 

 

 

Applying a Different Design Template 

You can apply a different template to your presentation at any 

time, no matter how you originally created the presentation. To 

change the design template, follow these steps: 

1. Select Format, Slide Design to open the Slide Design task 

pane. Then, if necessary, click the Design Templates icon at 

the top of the task pane. This provides a listing of 

PowerPoint's many design templates (see Figure 4.2). 

Figure 4.2. Choose a different template from the Design 

Templates task pane. 
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Click the template that you want to use in the list. The template is 

immediately applied to the slide in the Slide pane 

 

When you have decided on a particular template (you can click on 

any number of templates to see how they affect your slides), save 

the presentation (click the Save button on the toolbar). 

 

When you work with design templates, you can apply them to all 

the slides in the presentation (as discussed in the steps provided in 

this section), or you can apply the template to selected slides in the 

presentation. Follow these steps to apply a template to a selected 

group of slides in a presentation: 

1. Switch to the Slide Sorter view (select View, Slide Sorter). 

2. Open the Slide Design task pane as outlined in the previous 

steps. 



3. Now you must select the slide (or slides) to which you want 

to apply the template. Click the first slide you want to select, 

and then hold down the Ctrl key as you click other slides you 

want to select. To select a series of slides, click the first one 

and then Shift+click on the last slide to select them all. 

4. Point at the design template you want to use in the Slide 

Design task pane; a drop-down arrow appears. 

5. Click the template's drop-down arrow and select Apply to 

Selected Slides (see Figure 4.3). 

 

Figure 4.3. Design templates can be assigned to selected slides 

in a presentation 
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Using Color Schemes 

Design templates enable you to change the overall design and color 

scheme applied to the slides in the presentation (or selected slides 

in the presentation, as discussed in the previous section). If you 

like the overall design of the slides in the presentation but would 

like to explore some other color options, you can select a different 

color scheme for the particular template that you are using. 

The number of color schemes available for a particular design 

template depends on the template itself. Some templates provide 

only three or four color schemes, whereas other templates provide 

more. As with design templates, you can assign a new color 

scheme to all the slides in the presentation or to selected slides. 

To change the color scheme for the presentation or selected slides, 

follow these steps: 

1. In the Normal or Slide Sorter view (use the Slide Sorter view 

if you want to change the color scheme for selected slides), 

open the task pane by selecting View, Task Pane (if the task 

pane is already open, skip to the next step). 

2. Select the task pane's drop-down arrow and then select Slide 

Design-Color Schemes. This switches to the Color Schemes 

section of the Slide Design task pane. The color schemes 

available for the design template that you are using appear in 

the Apply a Color Scheme section  

You can choose from a list of color schemes for the 

presentation or selected slides 

 

 



 
 

 

 

1. (Optional) If you are in the Slide Sorter view and want to 

assign a new color scheme only to selected slides, select 

those slides (click the first slide and then hold down Ctrl and 

click additional slides). 

2. To assign the new color scheme to all the slides in the 

presentation, click a scheme in the Slide Design task pane. If 

you are assigning the color scheme only to selected slides, 

point at the color scheme and click its drop-down arrow. 

Select Apply to Selected Slides. 

 

 



Changing the Background Fill 

You can also fine-tune the color scheme that you add to a slide or 

slides by changing the background fill. This works best in cases 

where the design template and color scheme that you selected don't 

provide a background color for the slide or slides. You must be 

careful, however, because you don't want to pick a background 

color that obscures the text and graphics that you place on the slide 

or slides. 

To change the background fill on a slide or slides, follow these 

steps: 

1. Switch to the Slide Sorter view (select View, Slide Sorter). 

2. (Optional) If you are going to change the background fill for 

selected slides, select those slides in the Slide Sorter window. 

3. Select the Format menu and then select Background. The 

Background dialog box appear 

 

Use the Background dialog box to add a fill color to a slide or 

slides. 

 

 

 
 

 

 



1. Click the drop-down arrow at the bottom of the dialog box 

and choose a fill color from the color palette that appears. 

2. To assign the fill color to all the slides in the presentation, 

click Apply to All. To assign the fill color to selected slides 

(if you selected slides in step 2), click Apply. 

 

 

Inserting Slides into a Presentation 

You can insert slides into your presentation. You can insert blank 

slides or you can insert slides from other presentations. 

Let's look at inserting blank slides. Then we can look at inserting 

existing slides from another presentation. 

Inserting a New, Blank Slide 

You can insert a slide into a presentation at any time and at any 

position in the presentation. To insert a new slide, follow these 

steps: 

1. On the Outline or Slides pane, select the slide that appears 

just before the place where you want to insert the new slide 

(you can also insert a new slide in the Slide Sorter view, if 

you want). 

 

2. Choose the Insert menu and then New Slide, or click the New 

Slide button on the PowerPoint toolbar. A new blank slide 

appears in the PowerPoint window, along with the Slide 

Layout task pane. 

Your new slide appears in the PowerPoint window 



 

 

 

1. In the Slide Layout task pane, select the slide layout that you 

want to use for the new slide. Several text slide layouts and 

layouts for slides that contain graphics are provided. 

2. Follow the directions indicated on the slide in the Slide pane 

to add text or other objects. For text boxes, you click an area 

to select it and then type in your text. For other object 

placeholders, you double-click the placeholder. 

Inserting Slides from Another Presentation 

If you want to insert some or all of the slides from another 

presentation into the current presentation, perform these steps: 

1. Open the presentation into which you want to insert the 

slides. 



2. Select the slide located before the position where you want to 

insert the slides. 

3. Select the Insert menu and select Slides from Files 

 

Use the Slide Finder dialog box to insert slides from another 

presentation 

 

 

 

 

1. Click the Browse button to display the Browse dialog box. In 

the Browse dialog box, locate the presentation that contains 

the slides that you want to insert into the current presentation 

(use the Look In drop-down arrow to switch drives, if 

necessary). 



2. When you locate the presentation, double-click it. 

3. The slides in the presentation appear in the Slide Finder's 

Select Slides box. To select the slides that you want to insert 

into the current presentation, click the first slide and then 

hold down Ctrl and click any subsequent slides. 

4. When you have selected all the slides you want to insert, 

click Insert (if you want to insert all the slides, click Insert 

All). 

5. PowerPoint inserts the slides into the presentation at the point 

you originally selected. Click OK to close the Slide Finder 

dialog box. 

 

 

 

Deleting Slides 

You can delete a slide from any view. To delete a slide, perform 

the following steps: 

1. Select the slide you want to delete. You can delete multiple 

slides by selecting more than one slide (on the Outline or 

Slides pane or in the Slide Sorter view). 

2. Choose the Edit menu, and then choose Delete Slide. The 

slide is removed from the presentation 

 

3. Use the Delete Key You can quickly delete slides by 

selecting the slide or slides and then pressing the Delete key 

on the keyboard. 

 



Cutting, Copying, and Pasting Slides 

In Lesson 6, "Rearranging Slides in a Presentation," you learn how 

to rearrange slides using the Slide Sorter and the Outline/Slides 

pane. Although dragging slides to new positions in the Slide Sorter 

is probably the easiest way to move slides, you can use the Cut, 

Copy, and Paste commands to move or copy slides in the 

presentation. Follow these steps: 

1. Change to Slide Sorter view, or display Normal view and 

work with the Outline or Slides panes. 

2. Select the slide(s) you want to copy or cut. 

3. Open the Edit menu and select Cut or Copy to either move or 

copy the slide(s), respectively, or you can use the Cut or 

Copy toolbar buttons. 

4. In Slide Sorter view, select the slide after which you want to 

place the cut or copied slide(s), or on the Outline pane, move 

the insertion point to the end of the text in the slide after 

which you want to insert the cut or copied slide(s). 

5. Select the Edit menu and choose Paste, or click the Paste 

toolbar button. PowerPoint inserts the cut or copied slides. 

Rearranging Slides in Slide Sorter View 

Slide Sorter view shows thumbnails of the slides in your 

presentation. This enables you to view many if not all slides in the 

presentation at one time. Slide Sorter view provides the ideal 

environment for arranging slides in the appropriate order for your 

presentation. To rearrange slides in Slide Sorter view, perform the 

following steps: 

1. If necessary, switch to Slide Sorter view by selecting View 

and then choosing Slide Sorter. 

2. Place the mouse pointer on the slide you want to move. 
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3. Hold down the left mouse button and drag the slide to a new 

position in the presentation. The mouse pointer becomes a 

small slide box. 

4. To position the slide, place the mouse before or after another 

slide in the presentation. A vertical line appears before or 

after the slide  

Drag a slide in the presentation to a new position. 

 

 

 

 

 



1. Release the mouse button. PowerPoint places the slide into 

its new position and shifts the surrounding slides to make 

room for the inserted slide. 

You can also copy a slide in Slide Sorter view as easily as you can 

move a slide. Simply hold down the Ctrl key while you drag the 

slide. When you release the mouse, PowerPoint inserts a copy of 

the selected slide into the presentation. 

Although the Slides pane on the left side of the Normal view 

window does not provide as much workspace as the Slide Sorter, 

you can use the techniques discussed in this section to move or 

copy a slide. The Slides pane probably works best when you have 

only a few slides in the presentation. When you have a large 

number of slides, you might want to switch from the Normal view 

to the Slide Sorter view. 

 

 

Rearranging Slides in the Outline Pane 

In the Outline pane of the Normal view, you see the presentation as 

an outline that numbers each slide and shows its title and slide text. 

This provides you with a pretty good picture of the content and 

overall organization of your presentation. To rearrange the slides in 

your presentation using the Outline pane, follow these steps: 

1. Switch to the Normal view by selecting View, Normal, or by 

clicking the Normal button on the bottom left of the 

PowerPoint window. 

2. Click the slide number you want to move. This highlights the 

contents of the entire slide. 
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3. Place the mouse on the slide icon for that particular slide and 

drag the slide up or down within the presentation; then 

release the mouse 

 

 

Hiding Slides 

Before you give a presentation, you should try to anticipate any 

questions that your audience might have and be prepared to answer 

those questions. You might even want to create slides to support 

your answers to these questions and then keep the slides hidden 

until you need them. To hide one or more slides, perform the 

following steps: 

1. In the Slide Sorter view or the Slides pane of the Normal 

view, select the slides you want to hide. 

2. Select the Slide Show menu and then select Hide Slide. In the 

Slide Sorter view and in the Slides pane, the hidden slide's 

number appears in a box with a line through it  

Hidden slides are denoted by a line through the slide 

number (slides 2 and 3 in this figure 

 



 

 

1. To unhide the slides, display or select the hidden slides, 

choose the Slide Show menu, and then select Hide Slide (the 

Hide Slide command toggles the slides from hidden to 

unhidden). 

Remember that the slides are only hidden when you actually show 

the presentation. You can still edit or otherwise manipulate the 

slides in PowerPoint (in the other views, such as Normal view) 

even if you have marked them as "hidden." 

 

 



Copying Text Formats 

If your presentation contains text with a format you want to use, 

you can copy that text's format and apply it to other text on the 

slide (or other slides). To copy text formats, perform the following 

steps: 

1. Highlight the text with the format you want to use. 

2. Click the Format Painter button on the toolbar. PowerPoint 

copies the format. 

3. Drag the mouse pointer (which now looks like the Format 

Painter icon) across the text to which you want to apply the 

format. 

Changing the Text Alignment and Line Spacing 

When you first type text, PowerPoint automatically places it 

against the left edge of the text box. To change the paragraph 

alignment, perform the following steps: 

1. Click anywhere inside the paragraph you want to realign (a 

paragraph is any text line or wrapped text lines followed by a 

line break—created when you press the Enter key). 

2. Select the Format menu and then select Alignment 

You can align each text line or paragraph in a text box. 

 



 

 

Select Align Left, Center, Align Right, or Justify to align the 

paragraph as required 

 

If you want to align all the text in a text box in the same way 

(rather than aligning the text line by line), select the entire text box 

(click the box border) and then use the Alignment menu selection 

or the alignment buttons on the Formatting toolbar. 

You can also change the spacing between text lines (remember, 

PowerPoint considers these to be paragraphs) in a text box. The 

default setting for line spacing is single space. To change the line 

spacing in a paragraph, perform these steps: 

1. Click inside the paragraph you want to change, or select all 

the paragraphs you want to change by selecting the entire text 

box. 

2. Select Format, Line Spacing. The Line Spacing dialog box 

appear 

 



Select Format, Line Spacing to open the Line Spacing dialog 

box. 

 

 

 

 

1. Click the arrow buttons to the right of any of the following 

text boxes to change the spacing for the following: 

o Line Spacing— This setting controls the space between 

the lines in a paragraph. 

o Before Paragraph— This setting controls the space 

between this paragraph and the paragraph that comes 

before it. 

o After Paragraph— This setting controls the space 

between this paragraph and the paragraph that comes 

after it. 

2. After you make your selections, click OK. 

Adding a WordArt Object 

PowerPoint comes with an add-on program called WordArt (which 

is also available in other Office applications, such as Word and 

Excel) that can help you create graphical text effects. You can 



create text wrapped in a circle and text that has 3D effects and 

other special alignment options. To insert a WordArt object onto a 

slide, perform the following steps: 

1. In the Slide view, display the slide on which you want to 

place the WordArt object. 

2. Click the Insert menu, point at Picture, and then select 

WordArt (or select the WordArt button on the Drawing 

toolbar). The WordArt Gallery dialog box appears, showing 

many samples of WordArt types. 

3. Click the sample that best represents the WordArt type you 

want and click OK. The Edit WordArt Text dialog box 

appears  

 

 

 

1. Choose a font and size from the respective drop-down lists. 

2. Type the text you want to use into the Text box. 



3. Click OK. PowerPoint creates the WordArt text on your slide 

 

 

 

 

Making a Bulleted List 

When you enter new slides into a presentation, the default layout 

provides a title box and a text box that is set up as a simple 

bulleted list. Therefore, just creating a new slide creates a bulleted 

list. 

You can turn off the bullets in front of any paragraphs by 

selecting the paragraphs and clicking the Bullets button on the 

Formatting toolbar to toggle the bullets off. If you want to remove 

the bullets from all the paragraphs (remember a text line followed 

by the Enter key is a paragraph), select the entire text box and click 

the Bullets button. 

When you insert your own text boxes using the Text Box button on 

the Drawing toolbar, the text does not have bullets by default. You 

can add your own bullets by following these steps: 

1. Click the text line (paragraph) that you want to format for 

bullets. If you want to add bullets to all the text lines in a text 

box, select the text box. 

2. Select the Format menu, and then select Bullets and 

Numbering. The Bullets and Numbering dialog box appears. 

 

 



 

 

1. Select the bullet style you want to use from the list 

PowerPoint provides. 

2. Click OK. PowerPoint formats the selected text into a 

bulleted list. (If you press Enter at the end of a bulleted 

paragraph, the next paragraph starts with a bullet.) 

 

Working with Numbered Lists 

Numbered lists are like bulleted lists, except they have 

sequential numbers instead of symbols. You can convert any 

paragraphs to a numbered list by selecting them and clicking the 

Numbering button on the Formatting toolbar. Select the paragraphs 

again and click the Numbering button again to toggle the 

numbering off. 



You can also create numbered lists with the Bullets and 

Numbering dialog box, the same as you did with bullets. Follow 

these steps: 

1. Select the paragraphs that you want to convert to a numbered 

list. 

2. Choose Format, and then select Bullets and Numbering. 

3. Click the Numbered tab on the dialog box. The numbered list 

styles appears. 

 

 

 

1. Click the number style you want for your list. 

2. (Optional) Change the Size and/or Color of the numbers. 

3. (Optional) If you want the list to start at a number other than 

1, enter it into the Start At text box. 

4. Click OK. 



Using the Clip Art Task Pane 

The Clip Art task pane provides you access to all the clip art 

provided with Microsoft Office. It also includes a search engine 

that you can use to search for clip art, photographs, movies, and 

sounds that are stored on your computer. You can also search for 

clip art and other items using Microsoft's online clip library. (You 

must be connected to the Internet when using PowerPoint to access 

the Microsoft online library.) 

Figure 9.1 shows the Clip Art task pane. You can use this task 

pane to search for and insert images onto your slides, or you can 

take advantage of slides that use a layout that contains a 

placeholder for images and clip art. 

The Clip Art task pane manages pictures, motion clips, and 

sounds—all in one convenient place 
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You learn about using the Clip Art task pane and slide layouts 

that provide image placeholders in this lesson. In Lesson 10, 

"Adding Sounds and Movies to a Slide," you take a look at 

using the Clip Art task pane to add movies and slides to your 

PowerPoint slides 

 

You can open the Clip Art task pane in any of these ways: 

• Click the Insert Clip Art button on the Drawing toolbar. 

• Select the Insert menu, point at Picture, and then choose Clip 

Art. 
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• Open the task pane, click the task pane drop-down arrow, and 

then select Insert Clip Art to switch to the Clip Art task pane. 

When you use the Clip Art task pane, you search for images by 

keywords. In the following sections, you take a look at inserting 

clip art from the task pane and learn how you can insert clip art 

using some of the slide layouts (that provide a clip art placeholder 

on the slide). 

 

Inserting an Image from the Task Pane 

As previously mentioned, the Clip Art task pane allows you to 

search for clip art files using keywords. If you wanted to search for 

clip art of cats, you would search for the word "cats." To insert a 

piece of the clip art using the task pane, follow these steps: 

1. Select the slide on which you want to place the image so that 

it appears in the Slide pane. 

2. Select Insert, point at Picture, and then select Clip Art. The 

Clip Art task pane appears. 

3. Type keywords into the Search Text box in the task pane that 

will be used to find your clip art images. 

4. Click the Search button. Images that match your search 

criteria appear in the task pane as thumbnails. 

5. In the Results list, locate the image that you want to place on 

the slide. Then click the image, and the clip art is placed on 

the slide  

You can use the sizing handles on the image to size the clip art 

box. Or you can drag the clip art box to a new location on the slide 

 



Inserting an Image from an Image Box 

Another way that you can add clip art images to a slide in your 

presentation is to create the slide using a slide format that supplies 

a clip art placeholder box on the slide. These slide layout types are 

called content layouts because they make it easy to insert objects 

such as clip art, charts, and other items onto a slide. You can then 

use the object placeholder on the slide to access the clip art library 

and insert a particular image onto the slide. 

Follow these steps: 

1. Create a new slide or select the slide you want to assign a 

layout to that contains a clip art placeholder box. 

2. Open the task pane (View, Task Pane) and then click the task 

pane drop-down menu and select Slide Layout (the Slide 

Layout task pane automatically opens if you've just created a 

new slide). 

3. Scroll down through the layouts provided until you locate 

either the Content layout or the Text and Content layout. 

Both of these layout categories provide slide layouts that 

contain object placeholders or object placeholders and text 

boxes, respectively. 

4. Select the layout that best suits the purpose of your slide  

Inserting a Clip from a File 

If you have an image stored on your computer that you would like 

to place on a slide, you can insert the picture directly from the file. 

This means that you don't have to use the Clip Art task pane to 

search for and then insert the image. 

To place a graphical image on a slide directly from a file, follow 

these steps: 

1. Select the slide on which the image will be placed. 



2. Select the Insert menu, point at Picture, and then select From 

File. 

3. Select the picture you want to use. You can view all the 

picture files in a particular location as thumbnails. Select the 

Views button, and then select Thumbnails on the menu that 

appears. 

4. Click Insert to place the image on the slide 

Managing Images in the Clip Organizer 

Occasionally, you might want to add or delete clip art images from 

folders on your computer. Managing images is accomplished using 

the Clip Organizer. When you install Microsoft Office 2003 (using 

the default installation), a fairly large library of clip art is placed on 

your hard drive in different category folders. You can manage 

these clip art images and other images on your computer, such as 

scanned images or pictures from a digital camera. To open the Clip 

Organizer, follow these steps: 

1. With the Clip Art task pane open in the PowerPoint window, 

click the Clip Organizer link near the bottom of the task pane 

to open the Clip Organizer. 

2. (optional) The first time you open the Organizer, you will be 

given the opportunity to catalog all the media files (clip art, 

photos, videos) on your computer. Click the Now button to 

catalog all media. 

3. To view the clip art categories Microsoft Office has 

provided, click the plus sign (+) to the left of the Office 

Collections folder in the Collection list (this folder is located 

on the left side of the Clip Organizer window). Category 

folders such as Academic, Agriculture, and so on will appear 

in the Collection list. 

4. Click one of the category folders to view the clip art that it 

holds (for example, click Food). The clip art in that category 

folder appears in the Clip Organizer window (see Figure 9.6). 
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Not only does the Clip Organizer allow you to browse the various 

clip art and other images on your computer, it allows you to copy, 

delete, or move images. For example, if you find an image you no 

longer want to store on your computer, select the image in the Clip 

Organizer window and press Delete. A dialog box appears, letting 

you know that this image will be removed from all collections on 

the computer. Click OK to delete the image. 

You can also use the Clip Organizer to copy or move clip art 

images from a location on your hard drive to one of the clip art 

collections. Locate the images you want to move or copy to a 

particular collection and then select them. 

To move the images to a collection, select the Edit menu, and then 

Move to Collection. The Move to Collection dialog box appears 

(see Figure 9.7). Select a location in the dialog box and click OK 

to move the selected image or images 

Including Sounds in a Presentation 

Sounds can be used to add emphasis to information on slides or to 

add some auditory interest to your presentation. You can place 

sound files on your slides in two different ways: 

• You can insert a sound clip as an icon on a slide. When you 

click the icon, the sound plays. 

• You can assign a sound to another object on a slide so that 

when you click the object, the sound plays. For example, you 

could assign a sound to an image. When you click the image, 

the sound plays (sounds added to PowerPoint animations 

play when the animation plays). 
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Inserting a Sound onto a Slide 

To insert a sound clip as an object onto a slide, you can either use 

the Clip Art task pane or insert the sound as a file. The Clip Art 

task pane can provide you only with sound files that have been 

included in the Office clip art library or sound files that you have 

added to your collection using the Clip Organizer (which is 

discussed in the previous lesson). Any sound file that you have 

recorded or otherwise acquired can be inserted as a file. 

To insert a sound clip from the Clip Art task pane, follow these 

steps: 

1. Select the slide on which you will place the sound, so that it 

appears in the Slide pane. 

2. Select Insert, point at Movies and Sounds, and then select 

Sound from Clip Organizer. The Clip Art task pane appears 

with a list of sound files. You can use the Search For box to 

search for a particular type of sound file by keyword. 

3. To preview a particular sound file, point at the file and click 

the menu arrow that appears. Select Preview/Properties from 

the menu. The Preview/Properties dialog box for that sound 

file appears  

Preview a sound clip before placing it onto a slide. 

 



 

 

1. The sound will play automatically when the 

Preview/Properties dialog box opens. You can click the Stop, 

Pause, or Play buttons in the dialog box to perform that 

particular function. When you have finished previewing a 

sound file, click Close to close the Preview/Properties dialog 

box. 

2. When you are ready to insert a sound file onto the slide, click 

the sound file on the task pane. 

3. A dialog box opens, asking you whether you want the sound 

to play automatically when you run the slide show. Click Yes 

to have the sound played automatically. Click No to set up 

the sound so that you will have to click it during the slide 

show to play the sound. 



Regardless of whether you choose to have PowerPoint play the 

sound automatically, it appears as a sound icon on the slide. 

If you have recorded a sound file or have acquired a sound file that 

you want to use on a slide without using the Clip Art task pane, 

you can insert it as a file. To insert a sound clip from a file, follow 

these steps: 

1. Choose the Insert menu, point at Movies and Sounds, and 

then choose Sound from File. 

2. In the Insert Sound dialog box, navigate to the drive and 

folder containing the sound you want to use  

Choose the sound clip you want to include on your slide 

 

 

 

1. Select the sound clip and then click OK. 



2. A dialog box opens, asking you whether you want the sound 

to play automatically when you run the slide show or play 

when you click on the sound icon on the slide. Click 

Automatically to have the sound played automatically or 

When Clicked to set up the sound so that you will have to 

click it during the slide show to play the sound. 

The sound file appears on the slide as a sound icon. If you want to 

play the sound file on the slide, right-click the sound icon and 

select Play Sound from the shortcut menu. 

Associating a Sound with Another Object on the Slide 

If you want to avoid having a sound icon on your slide, you can 

associate the sound with some other object already on the slide, 

such as a graphic. To do so, follow these steps: 

1. Right-click the object (such as a clip art image) to which you 

want to assign the sound. 

2. Choose Action Settings from the shortcut menu. The Actions 

Settings dialog box appears. 

3. If you want the sound to play when the object is pointed at, 

click the Mouse Over tab. Otherwise, click the Mouse Click 

tab. The Mouse Click option requires that the sound icon be 

clicked on for the sound to play. 

4. Click the Play Sound check box. A drop-down list of sounds 

becomes available 

 

. Choose a sound to be associated with the object. 

 



 

 

1. Open the Play Sound drop-down list and choose the sound 

you want. 

If the sound you want is not on the list, choose Other Sound 

and locate the sound using the Add Sound dialog box that 

appears. Select the sound from there and click OK. 

2. When you have chosen the sound you want, click OK to 

close the Action Settings dialog box. 

Now, when you are giving the presentation, you can play the sound 

by either clicking or pointing at the object (depending on how you 

configured the sound to play). To test this, jump to the Slide Show 

view (select the View menu and then click Slide Show) and try it 

out. Press Esc to return to the Normal view when you are finished 

testing the sound file. 



 

Placing a Movie onto a Slide 

The procedure for placing a movie onto a slide is very much the 

same as that for a sound. You can place a movie using the Clip Art 

task pane or from a file. You will find that the task pane Clip 

Organizer provides several movies that can be used to add interest 

to your slides. To insert a movie onto a slide, follow these steps: 

1. Choose the Insert menu, point at Movies and Sounds, and 

then select Movies from Clip Organizer. Use the Search box 

if you want to locate movies using a keyword search. 

2. Scroll through the movies listed on the Clip Art task pane. 

3. Point at a movie clip you want to preview. Click the menu 

arrow that appears and select Preview/Properties. The 

Preview Properties dialog box for the movie appears. 

4. PowerPoint previews the movie on the left side of the dialog 

box (see Figure 10.4). If you want to place a caption onto the 

movie clip, click in the Caption box below the Preview pane 

and type a caption. 

5. Click Close to close the Preview/Properties dialog box. To 

insert the movie into your slide, click the movie in the task 

pane. 

6. A dialog box will open allowing you to choose how the 

movie will be started during the slide show. Click 

Automatically to start the movie automatically when the slide 

is shown during the slide show or When Clicked, which will 

require that you click the movie to play it during the slide 

show. 

After the movie icon is in place on your slide, you can size the 

movie box using the usual sizing handles or move it to another 

position on the slide. If you want to test view the movie on the 

slide, jump to the Slide Show view (select the View menu and then 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch102lev1sec3.html#ch102fig04#ch102fig04


click Slide Show) and try it out. Press Esc to return to the Normal 

view when you are finished testing the movie. 

You can also place actual videos on a slide as a file. This enables 

you to place video captures that you have created or video files 

from other sources. 

Follow these steps: 

1. Choose the Insert menu, point at Movies and Sounds, and 

then choose Movie from File. 

2. In the Insert Sound dialog box that appears, navigate to the 

drive and folder containing the movie file you want to use. 

3. Select the file and click OK to place it on the slide. 

4. A dialog box appears that enables you to have the movie play 

when the slide appears in the slide show. Click 

Automatically. To require that you click the movie's icon to 

make it play during the slide show, click When Clicked. 

After you make your selection in step 4, PowerPoint places the 

movie onto the slide. To preview the video file on the slide, right-

click the video icon and then select Play Movie. 

Viewing an Onscreen Slide Show 

Before you show your presentation to an audience, you should run 

through it several times on your own computer, checking that all 

the slides are in the right order and that the timings and transitions 

between the slides work correctly. This also enables you to fine-

tune any monologue you might have to give as you show the slides 

so that what you are saying at any point in the presentation is 

synchronized with the slide that is being shown at that moment. 

You can preview a slide show at any time; follow these steps: 

1. Open the presentation you want to view. 



2. Choose the Slide Show menu and choose View Show. The 

first slide in the presentation appears full screen (see Figure 

12.1). A series of icons appear at the bottom left of the 

presentation screen. There is a previous slide arrow, a pen 

icon, a menu icon, and a next slide arrow. We will discuss the 

pen and menu icons later in the lesson. 

When you run your slide show, the entire screen is used to 

display the sides. 

 

 

 

1. To display the next or the previous slide, do one of the 

following: 

o To display the next slide, click the left mouse button, 

press the Page Down key, or press the right-arrow or 
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down-arrow key. You can also click the right-pointing 

arrow that appears at the bottom left of the slide. 

o To display the previous slide, click the right mouse 

button, press the Page Up key, or press the left-arrow or 

up-arrow key. You can also click the left-pointing 

arrow that appears at the bottom left of the slide. 

2. When you have finished running the slide show, press the 

Esc key. 

Setting Slide Animation Schemes 

After running the slide show a few times, you might find that the 

presentation doesn't really provide the visual impact that you had 

hoped. Even though you have designed your slides well and 

created slides that include images and movies, you are still looking 

for something with a more "artsy" feel. A great way to add visual 

impact to the presentation is to assign an animation scheme to a 

slide or slides in the presentation. 

An animation scheme controls how the text in the text boxes on the 

slide appear or materialize on the slide during the presentation. For 

example, you can select a slide animation scheme called Bounce, 

where the text on the slide "bounces" onto the slide when it 

appears onscreen during the slide show 

PowerPoint provides three categories of animation schemes that 

you can assign to a slide: Subtle, Moderate, and Exciting. Each of 

these categories provides a number of animation schemes. The 

great thing about the animation schemes is that you can assign 

them to a slide or slides and then try them out in the Normal view. 

If you don't like the animation scheme, you can select another. 

To assign an animation scheme to a slide in the presentation, 

follow these steps: 



1. Select the slide to which you will assign the animation 

scheme so that it appears in the Slide pane in the Normal 

view. 

2. Select the Slide Show menu and select Animation Schemes. 

The Animation Schemes list appears in the Slide Design task 

pane on the right side of the PowerPoint window (see Figure 

12.2). 

The task pane houses the animation schemes that you can 

assign to the slides in your presentation 

 

 

1. Scroll through the list of animation schemes. When you find 

a scheme that you want to try, select the scheme in the list 

box. 

2. To try the scheme, click the Play button in the task pane. 

3. If you don't like the scheme, select another. 

4. If you find a scheme that you would like to apply to all the 

slides in the presentation, click the Apply to All Slides button 
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Setting Up a Self-Running Show 

In a self-running show, the slide show runs itself. Each slide 

advances after a specified period of time. This allows you to 

concentrate on the narrative aspects of the presentation as you use 

the slide show for a speech or classroom presentation. For a self-

running show, you must set timings. You can set the same timing 

for all slides (for example, a 20-second delay between each slide), 

or you can set a separate timing for each slide individually. 

When you set up a self-running show, you can also select different 

slide transitions. A slide transition is a special effect that is 

executed when the slide appears during the slide show. For 

example, you can have a slide dissolve onto the screen, or you can 

have the slide appear on the screen using a checkerboard effect. 

To configure the show to use timings and transitions, follow these 

steps: 

1. Open the presentation you want to view. 

2. Select the slide to which you would like to apply a timing or 

transition so that it appears in the Slides pane in the Normal 

view. 

3. Select Slide Show and click Slide Transition. The Slide 

Transition task pane opens containing controls for the type of 

transition you want to use, the speed with which that 

transition executes, and the length of time the slide should 

remain onscreen 

The Slide Transition task pane houses the controls necessary 

for tailoring the way a slide transitions onto the screen 

during a presentation. 



 

 

1. To select a transition for the slide, select one of the 

transitions supplied in the Apply to Selected Slides box. 

2. To test the transition, click the Play button. 

3. If you want to change the speed of the transition, click the 

Speed drop-down list and select Slow, Medium, or Fast (Fast 

is the default). 

4. (Optional) If you want to select a sound to accompany the 

slide transition (such as Applause, Drum Roll, or Laser), 

click the Sound drop-down list and select one of the supplied 

sounds. 

5. To set the timing for the slide in the Advance Slide section of 

the task pane, click the Automatically After check box. Use 

the click box below the check box to enter the number of 

seconds for the slide's automatic timing. 



6. If you want to apply the selected transition and the timing to 

all the slides in the presentation, click the Apply to All Slides 

button. 

When you run the slide show, the slides advance according to the 

timings that you have set. The slides also use any transitions that 

you have selected for them. Take the time to run the slide show 

several times so that you can gauge whether the transitions and 

timings work well. Remember that the slide must be onscreen long 

enough for your audience to read and understand the text on the 

slide. 

Using the Slide Show Menu Tools 

PowerPoint also provides some other features that you will find 

very useful when you are running your slide show. For example, 

you can turn the mouse pointer into a pen (such as a ballpoint pen 

or a highlighter) that enables you to draw on a particular slide, 

enabling you to quickly emphasize a particular point visually. 

Other features include the ability to add speaking notes on the fly 

as you view the presentation. You can also blank out the current 

slide to a black or white screen, allowing you to pause for a 

moment and answer audience questions or comments. 

These tools are accessed by clicking on the icons that appear on the 

bottom left of your presentation slides as you show the 

presentation. There is an icon for the pen feature and a second icon 

that brings up a menu that allows you to access screen settings and 

a Go To feature that allows you to quickly go to a particular slide 

in the presentation. We discuss the use of the pen, speaker notes, 

and the Go to feature in the sections that follow. 



Drawing with a Pen 

An extremely useful tool is the pen, which enables you to draw on 

a particular slide. This is great for highlighting information on a 

slide to emphasize a particular point. 

To use the pen during the slide show, follow these steps: 

1. With the slide show running, click on the Pen icon that 

appears on the bottom left of the current slide. 

2. On the menu that appears, select one of the pen types such as 

the Ball Point Pen. The mouse pointer becomes a ball point 

pen. (You can also choose to use a felt tip pen or a 

highlighter.) 

3. Click the left mouse button and draw on the slide as neede 

The pen provides you with an easy way to highlight a 

particular item on a slide 

 



 

 

1. After you've finished working with the pen, you can return to 

the arrow pointer. Click the Pen icon. Select Arrow on the 

menu that appears. You can now use the mouse to advance to 

the next slide. 

You can also choose the pen color that you use to draw on the 

slides. After clicking on the Pen icon, point at Ink Color, and then 

select the pen color you want to use from the color palette that 

appears. 

Taking Speaker Notes 

Another useful tool that you can take advantage of while showing 

your slide presentation is the Speaker Notes feature. It enables you 

to quickly take notes related to the discussion or to audience 

comments made during your presentation. 

To use the Speaker Notes feature, follow these steps: 

1. With the slide show running, point at the Menu icon on the 

bottom left of the current slide (it is the third icon from the 

left). 

2. On the menu that appears, point at Screen and then select 

Speaker Notes. The Speaker Notes dialog box opens  

The Speaker Notes box allows you to record notes related to 

the current slide. 



 

 

 

1. Type your notes into the Speaker Notes dialog box. 

2. When you have finished adding notes, click the Close button 

to close the dialog box. 

Finding a Particular Slide During the Show 

As you reach the end of a presentation, you might be asked to 

reshow a particular slide or subset of slides that you included in 

your slide show. The easiest way to go to a particular slide when 

you are in the Slide Show view is to use the Go to Slide command 

on the Slide Show menu. 

To go to a particular slide in the presentation, follow these steps: 

1. With the slide show running, click the Menu button on the 

bottom left of the current slide. 

2. On the menu that appears, point at Go to Slide. A submenu 

will appear showing all the slides (titles) in the presentation  

To move to a particular slide, click the slide's title on the 

submenu. PowerPoint takes you to the selected slide. 



 

Adding Action Buttons to User-Interactive Shows 

You can create slide show presentations that will be played on a 

computer where your audience actually interacts with the slide 

show (for example, a computer at a trade show that tells potential 

customers about your company). This means that you need to give 

the audience some means of controlling the show. You can simply 

provide access to a keyboard and/or mouse and let the user control 

the show in the same way you learned earlier in this lesson, or you 

can provide action buttons onscreen that make it easy to jump to 

specific slides. 

Action buttons are like controls on an audio CD player; they 

enable you to jump to any slide quickly, to go backward, to go 

forward, or even to stop the presentation. 

To add an action button to a slide, follow these steps: 

1. Display the slide in Normal view. 

2. Select Slide Show, point at Action Buttons, and pick a button 

from the palette that appears. For example, if you want to 

create a button that advances to the next slide, you might 

choose the button with the arrow pointing to the right. 

3. Your mouse pointer turns into a crosshair. Drag to draw a 

box on the slide where you want the button to appear. (You 

can resize it later if you want.) PowerPoint draws the button 

on the slide and opens the Action Settings dialog box (see 

Figure 12.7). 

 Set the action for your button in the Action Settings dialog 

box. 

 

 

mk:@MSITStore:C:/Users/vinod%20singh/Desktop/flazx-Microsoft-Office-2003-All-in-One-0789729369/0789729369.chm::/0789729369_ch104lev1sec5.html#ch104fig07#ch104fig07


 

1. Select either the Mouse Click tab or Mouse Over tab to set 

the action for the button (Mouse Click options require a 

click; Mouse Over requires only that the mouse pointer be 

placed on the button). 

2. Choose the type of action you want to happen when the user 

clicks the button. Click the Hyperlink To drop-down list and 

select an action such as Next Slide. 

3. (Optional) If you want a sound to play when the user clicks 

the button, select the Play Sound check box and choose a 

sound from the drop-down list. 

4. Click OK. Your button appears on the slide. 

5. View the presentation (as you learned at the beginning of this 

lesson) to try out the button. 

If you do use buttons on your slides so that users can run the slide 

show, be sure you use the same style of button on each of your 



slides for a particular action. This kind of consistency gives the 

viewer of the presentation a feeling of comfort and control. 

Setting Slide Show Options 

Depending on the type of show you're presenting, you might find it 

useful to make some adjustments to the way the show runs, such as 

making it run in a window (the default is full screen) or showing 

only certain slides. You'll find these controls and more in the Set 

Up Show dialog box, which you can open by clicking the Slide 

Show menu and selecting Set Up Show 

Use the Set Up Show dialog box to give PowerPoint some basic 

instructions about how to present your slide show. 

 

 

 



 

In this dialog box, you can choose from several options, including 

the following: 

• Choose the medium for showing the presentation. Your 

choices are Presented by a Speaker (Full Screen), Browsed 

by an Individual (Window), and Browsed at a Kiosk (Full 

Screen). 

• Choose whether to loop the slide show continuously or to 

show it only once. You might want to loop it continuously so 

that it operates unaided at a kiosk at a trade show, for 

example. 

• Show all the slides or a range of them (enter the range into 

the From and To boxes). 

• Choose whether to advance slides manually or to use timings 

you set up. 

• Choose a pen color. Use the Pen Color drop-down box to 

select a color. 

Using the Set Up Show dialog box to set the various options for 

the show allows you to put the finishing touches on the 

presentation before you actually present it to your audience. For 

example, it negates the need to select a pen color on the fly, 

allowing you to concentrate on the slide content rather than trying 

to change the pen color with the audience watching. 

This dialog box also allows you to set the viewing parameters for 

the environment that the presentation will be shown in. For 

example, if you are running the slideshow on a PC that will be 

used by individuals at a tradeshow booth, it makes sense to format 

the presentation to be viewed by an individual in a window. That 

way the individual can leave the presentation for a moment and 

take a look at any sample software or other items you have on the 

PC that support the presentation. 



Using PowerPoint Notes and Handouts 

Although PowerPoint presentations are designed to be shown on a 

computer screen, you might want to print some items related to the 

presentation. For example, as you design your presentation, you 

can enter notes related to each slide that you create in the Notes 

pane. These notes can then be printed out and used during the 

presentation. 

Using speaker notes helps you keep on track during the 

presentation and provides you with the information that you want 

to present related to each slide in the presentation. When you print 

your notes, each slide is printed on a separate page with the notes 

printed below the slide. 

If you want to make it easier for your audience to follow the 

presentation and perhaps take notes of their own, you can print 

out handouts. Handouts provide a hard copy of each slide. The 

number of slides printed on each page of the handout can range 

from 1 to 9 slides. If you choose to print three slides per page 

(this is set up in the Print dialog box, which is discussed later in 

this lesson), PowerPoint automatically places note lines on the 

printout pages to the right of each slide (which makes it even 

easier for your audience to take notes related to the slides in the 

presentation 
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MACROMEDIA FLASH 

 

Macromedia product: 

 

Macromedia was an American graphics, multimedia and web 

development software company (1992–2005) 

headquartered in San Francisco, California that produced such 

products as Flash and Dreamweaver. Its 

rival, Adobe Systems, acquired Macromedia on December 3, 2005 

Adobe Dreamweaver is a proprietary web development tool 

developed by Adobe Systems. 

Dreamweaver was created byMacromedia in 1997,[1] and was 

maintained by them until Macromedia was 

acquired by Adobe Systems in 2005 

Adobe Fireworks (formerly Macromedia Fireworks) was a bitmap 

and vector graphics editor. It was 

originally developed using parts of Macromedia xRes, which 

Adobe acquired in 2005 

Adobe Flash (formerly called Macromedia Flash and Shockwave 

Flash) is a multimedia and software 

platform used for creatingvector graphics, animation, games and 

rich Internet applications (RIAs) 

that can be viewed, played and executed in Adobe Flash Player. 

Flash is frequently used to 

add streamed video or audio players, advertisement and interactive 

multimedia content to web pages, 

although usage of Flash on websites is declining 



Adobe Flash Player (labeled Shockwave Flash in Internet 

Explorer and Firefox)[4] is freeware software for viewing 

multimedia, executing rich Internet 

applications, and streaming video and audio, content created on the 

Adobe Flash platform. Flash Player 

can run from a web browser as a browser plug-in or on supported 

mobile devices. 

Adobe Shockwave (formerly Macromedia Shockwave) is a 

multimedia platform used to 

add animation and interactivity to web pages. It allows Adobe 

Director applications to be published on 

the Internet and viewed in a web browser on any computer which 

has the Shockwave plug-in installed. 

Adobe Photoshop : 

Create incredible images using the world's best photo editing 

software. 

Basic Drawing Techniques: 

Drawing in Flash 8 

Design passes through many phases when designing web page or 

an animation. After the phase 

of "What do I want to create and how is it going to look", 

normally, the phase of graphic design comes 

up. Realize what your imagination has produced on the paper (in 

this case on the paper of Flash). 

It isn't desirable to mislead us, Flash isn't a program of graphic 

design, but its power in this field is 

almost as great as these programs. We are going to see how use 

every drawing tool effectively. 

Tools Bar. Basic Tools. 

The Tools Bar contains all necesary Tools for the drawing. Let's 

see which of 

them are the most important and how they are used: 



Selection (arrow) Tool : It is the most used tool among all. Its 

main use is to 

select objects, it allows selecting the borders of the objects, the 

fillings (with only one 

click), the borders (with double click), zones on our choice... 

Moreover, its adequate use 

can save time of our work. 

Line Tool: It allows creating straight lines in a quick way. The 

lines are created 

as in any program of drawing. Click and drag to show up a straight 

line until the desired 

end point. Once created, the line can be modified just by placing 

the cursor near the 

line: above of the extremes for dragging them, and in any other 

part near the straight 

line to curve it. 

Text Tool: It creates a text in the place where we click. Its 

properties will be 

shown in the next theme. 

Oval Tool: The Oval Tool enables drawing circles or ellipses in a 

fast and 

simple way. 

To practice the handling this Tool, we recommend to do the 

Exercise of Creating 

Oval 

To practice the handling this Tool, we recommend to do the 

Exercise of Filling 

Color Oval 

Rectangle Tool: Its handling is identical to the Oval Tool, they 

only differ in the 

objects they create. 

Pencil Tool: It allows drawing lines, after being drawn you will be 

able to edit its 

shape as you like. The color applied by this Tool can be modified 

from the Color Mixer 



Panel or from the subpanelColors that is in the Tool Bar. 

Brush Tool: Its functionality is equivalent to the pencil, but its 

stroke is much 

more thicker. It is usually useed for fills. We can modify its 

thickness and stroke shape. 

Paint Bucket Tool: It lets you apply fillings to the created objects. 

Many other 

programs of drawing don't allow to apply fillings if a border 

doesn’t limit the zone, it 

does. The color applied by this Tool can be modified from the 

Colors Mixer Panel or 

from the subpanel Colors that are in the Tool Bar. 

Eraser Tool: It works like the Brush Tool. Nevertheless its 

function is to erase 

everything what "it draws". 

Tools Bar. Advanced Tools. 

Lasso Tool: Its function is complementary to the Arrow Tool, 

since it can select any object 

in a free way (the Arrow Tool can only select objects or 

rectangular or square zones). In counterpart, 

the Lasso Toolcan't select fillings nor objects (if we don’t make 

the selection by hand). 

By selecting this Tool, the following images appear on the Options 

Panel : This is 

the Magic Wand Tool, which is so popular in other programs. It 

lets you make selections according 

to the objects color. The third option you have is the following: It 

allows you to select polygon 

shapes. 

Pen Tool: creates polygons (and moreover straight lines, 

rectangles...) in a simple way. 

Many people find this tool to be complicated, although it's one of 

the most powerful tools that Flash 

provides. Its use consists in clicking on the places that we want to 

define as vertices of the polygons. 



In order to create curves, indicate the anchor points, which limit 

curvature, and then drag the tangent 

on them. 

Subselection Tool: This Tool complements the Pen Tool, as far as 

it lets us move or adjust 

the vertices that make up the objects created by the above 

mentioned tool. 

Ink Bottle Tool: It is used to change quickly the color of a stroke. 

It is applied to objects with 

borders, changes the color of the boundary with one click in the 

Colors Mixer Panel. 

Eyedroppers Tool: Its mission is to "Capture" colors to use them 

afterwards. To see how it 

works, we advice you to see the following animation: 

Animation techniques: 

 

Making the Animation 

 

In this chapter we do not try to teach you how you can realize a 

Flash animation (you will see it 

later), the objective is to understand how Flash creates animations 

and how it makes our work easier. 

At first glance, it seems logical to draw the globe at each moment, 

so that growing number of 

moments makes the movement more real: the more drawn instants, 

the more realistic movement. 

Nevertheless, with Flash it is sufficient to create only 3 frames: 

firstly we will draw the globe at the 

initial instance (above all), secondly, we willl draw the globe at the 

moment when it touches the 



ground and then the globe will come back to its initial position 

(actually you can create this frame by 

making a copy of the first one). So far as we see now, most part of 

the work (drawing objects) is 

already done. 

Now, the duration of each movement is determined by setting the 

time between the moments 

when the globe is at the top and at the bottom, and finally Flash is 

pointed out to create an animation 

of movement between those two frames. 

 

CREATE A MOTION TWEEN : 
 

First way : 

 

Start drawing the ball. Click on the oval tool. 

And now draw a circle in it. Top position (before bouncing) 

Then Click on selection tool. 

And select the object to convert into a symbol so the animation 

work effectively.double click on the 

circle. 

Now select the modify. 

Then select command convert to symbol or f8 

Type a name ball and ok 

Once the ball has been converted, we will create a keyframe in the 

20 position. Click on it. 

And press f6 to insert a key frame. 

As we are in the last position, we should place the ball in its proper 

, that’s to say , on the floor. 

Now pressing the shift key , select the first frame. 

All the frame between have been selected. Now right click in one 

of them. 

And click on create motion tween to create animation. 



This arrow tells us that exist an animation.from the first frame to 

the latest. 

Flash animation:-- 

When what we want is not to change the position of an object on 

the stage, but rather its shape in 

a progressive way (or both of them simultaneously), Flash provides 

us the technique of the Shape 

Tweening, that consists, simply, in transforming the outline of the 

object created until it becomes just 

like the outline of another different object. 

Making a shape tweening is very similar to creating a motion 

tweening. Flash creates 

intermediary frames in which the shape of the previous frame is 

slightly varied. We need only two 

keyframes. And as we did in the previous unit, we'll place in the 

first frame the object with its original 

appearence, and in the last frame its desired one. 

 

This time, it is important to emphasize that in order to make the 

Shape Tweening to work 

properly, the involved objects will have to be vector objects 

(not Flash symbols). 

 

We must also take into account two points : 

1. Separate in different layers the fixed objects and those that will 

be animated. 

2. Place in different layers objects which are going to be 

transformed with different shapes, 

since Flash will transform all vector objects from the first frame in 

those of the last frame 

of the tweening. 

If we made the shape tweening correctly the timeline will look like 

this: 

We can consider the frame rate and the number of frames for the 

shape tweening and any 



animation done with Flash in the same way as for the motion 

tweenings. 

If there's some failure in the necessary parameters to execute the 

tweening correctly, for 

example, if one of the objects in the layer is a symbol, something 

like this will be shown in the 

timeline: 

To create a shape tweening you should act as you did with the 

motion one. Once you have the 

start and final frames select all the frames in between and open the 

Properties Panel. 

There you should select the Shape option in the Tween list. And 

you'll be done. 

Easy, isn't it? 

 

TEXT TRANSPARENCY EFFECT :--- 

Flash Text Effect - Fade 

A Basic Flash tutorial on how to apply a fade to Flash text 

Step1: 

First we will add some text and set the properties of the text.  

To do this click on the Text Tool in the Tools bar.  

Then left click on your mouse in the work area where you want to 

put the text. 

Step2: 

To set the properties Right Click in the Text field, a small popup 

menu will appear. Now Select Properties. 

The Properties window will appear below the work area. For our 

Fade effect set the font to Arial and the size to 30, and select any 

color except white. 



Step3: 

Now we will be creating the Flash Text fade in effect. To do this 

go to the timeline and right click on frame 20. A small popup menu 

will appear. From this popup menu select insert keyframe. After 

you have done this right calico on the keyframe again and select 

create motion tween. Now go to the first key frame, again right 

mouse click on it, and select create motion tween. 

Step4: 

Now we have arrived at the final step to create the basic fade in 

text effect. To finalize it all we need to do is to set the alpha 

channel of the first text to 0. To do this go to the workarea and 

click on top of the text you already entered in Step1. Below the 

work area the frame properties window will appear. In this window 

you can set several properties such as the color and alpha channel 

(fade) of the selected frame. To set the color of the text effect to 

transparent, go to the color drop down menu and select alpha. If 

needed set the alpha amount to 0 by dragging the slider 

downwards. 

Step5: 

To preview what we have created. Enter Ctrl Key and the Enter 

Key on your keyboard. 

Step6: 

Now we have created the text fade in we will move on to create the 

final text fade effect. To do this go to the timeline and right mouse 

calico on frame 30. Select insert Keyframe. Go to the work area 

and left calico on the text. Now the properties window below the 

work area will appear. Go to the color drop down menu and select 

Alpha and set the alpha number to 0. 

Step7: 

To preview what we have created. Enter Ctrl Key and the Enter 

Key on your keyboard. Your animation should look like something 

such as the Flash Fade Text animation below. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 


